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Tables
Dynamic, multidimensional tables can be created in the STEPWorkbench on the Tables tab of product, classification,
and product-override objects. Tables are used to present product information, such as product names, part numbers,
and prices, in a tabular format. Tables are most often used in conjunction with Print Publisher for print applications,
though tables can also be published to websites.

The configuration options available for tables in STEP are extensive. Tables can display attribute values, assets,
references, commercial data, free text, and more. Since tables support inheritance, a table can be built once and
used for an unlimited number of product presentations. Table layouts and settings can be shared across product,
classification, and product-override hierarchies. Table types can be made dimension dependent to display
different information for different contexts. Because tables are dynamic product presentations, they will
automatically adapt to data changes in the workbench. Additionally, transformations can be applied to tables to
perform simple actions like merging common cells, changing the font size / text style, and applying color to the font
or to the cell, or for advanced transformations such as the Pivot Table Transformation.

The screenshot below shows a very simple table as previewed in STEP. It incorporates STEP names, STEP IDs, and
pricing information. Tables are typically more complex than the sample presented, but even this simple table employs a
table transformation (Alternate Row Colors), font styling, and more than one table rule line.
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The following screenshot shows how this table looks on an InDesign page after being mounted using Print
Publisher.

…

Prerequisites
This documentation section assumes that users have a working knowledge of STEP.

Note: The following functionality is managed by a configuration property that is not available in the Self-Service
UI. Contact Stibo Systems Support for assistance.

To ensure that references appear as you expect within your tables, it is recommend that you set the following
configuration property to limit the maximum number of displayed references within a table. This optimizes system
performance by directing the system to process the set maximum number of rows and columns that a dynamic
row / column plugin is allowed to return without being truncated. This keeps the system from going through every
reference you are maintaining.

PIMTable.DynamicRowColumnPlugin.Max=10000
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Creating Table Types in System Setup
Before a table can be defined on product, classification, or product-override objects in the Tree, the table type must first
be configured in System Setup.

Setting up a table type involves defining the settings and formatting for table types, column types, and row types. Table
types, column types, and row types must all be defined under a group. Also included in the setup is the creation of the
colors and rules that will be used in the tables.

Note: You can set up table types, column types, and row types in any sequence you want. However, if you start
with no types defined at all, it is recommended that you define column types and row types before you assign
them to a table type.
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Creating Column Types
Column types are used to define how columns will appear in tables, such as what text style, width, background color,
alignment, and rules will appear in columns of a specific type. Before you can define a column type, you must first define
a column type group in System Setup. A column type group is used to store individual column types.

Note: The following instructions assume that you have not set an ID or name pattern on the Table Column
Type Group (ID = table column type group) or Table Column Type (ID = table column type) object types,
located under System Setup > Object Types and Structures > Basic Object Types > Table Column Type
Group. To have these IDs and/or names autogenerate, follow the instructions provided in the Autogenerate
Using Name Pattern and ID Pattern topic in the System Setup documentation.

Defining Column Type Groups
1. In System Setup, go to Table > Table Column Types, then right-click and select Create Column Type Group.

2. In the New Column Type Group dialog, enter an ID and Name for your column type group, then click Create.

3. The dialog closes and the column type group is created.

4. If you need to delete the column type group, right-click it and select Delete. If the column type group contains a
column type, the column type must be deleted first.

Defining Column Types
1. In System Setup, navigate to the desired column type group, then right-click and select Create Column Type.

2. In the New Column Type dialog, enter an ID and Name for your row type, then click Create.

3. The dialog closes and the column type is created.

4. If you need to delete the column type, right-click it and select Delete.
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Modifying the Column Type Name
After the column type is created, you can modify the name by entering a new name in the Name field on the Column
Type tab.

Defaults
Column type settings and formatting definitions, such as text alignment and column width, are applied under
Defaults. Refer to the Configuring Settings for Column Types and Columns topic for more information.

Heading/Footer
In the Heading/Footer field, specify whether the column type should be a Normal Row, Heading (1), Sub Heading (2),
or Footer. These column type designations enable table transformations to specify how to handle the column.

(The term 'Row' is used because columns can function similarly to rows in instances where a table is designed to
display vertically instead of horizontally. In a vertical table, a header 'row' will appear as a column on the far left
instead of a row across the top.)

© Stibo Systems - Public - 2025.3 - September 2025 15



For example, Heading and Sub Heading 'rows' can be excluded for certain transformations, such as alternate row
shading, where the Heading and Sub Heading rows should remain unformatted. Likewise, if a table is split across
columns or pages when mounted in InDesign, a row designated as a Heading will repeat on the next column or page.

Publication Types
If the column type should only appear in tables that are mounted on pages connected to specific publication types,
follow these steps:

1. In the Publication Type field, click the [...] button. The Select Publication Type dialog box appears. The dialog
displays all the publication types that are available.

2. Leave Show In All Publication Types selected if the column type should be allowed in all publication types. This is
the default setting.

3. Select Specify if the column type should only be allowed in certain publication types. To exclude the column type
from a specific publication type, select the publication type, then click the right-pointing arrow to move the
publication type into the Excluded column.
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4. To ensure that the column type is excluded from any publication type created in the future, select Future Publication
Types, then click the right-pointing arrow to move the publication type into the Excluded column.

5. Click OK when complete.

Legal for Table Types
All column types must be made legal (valid) for at least one table type before the table type can be used to create a
table in STEP. To make a column type valid for a table type, follow these steps:

1. On the Column Type tab, expand the Legal for Table Types flipper.

2. Click Add Table Type. The Select Table Type dialog displays.

3. Click the Browse or Search tab to browse to or search for the desired table type, then click Select.

4. The column type is now legal for the table type.

Removing a Table Type

To remove the legal setting for a table type, follow these steps:

1. On the Column Type tab, expand the Legal for Table Types flipper.

2. Right-click on the arrow to the left of the table type that you would like to remove, then select Remove Table Type.
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3. The table type is now removed.
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Creating Row Types
Row types are used to define how rows will appear in tables, such as what text style, height, background color,
alignment, and rules will appear in rows of a specific type. Before you can define a row type, you must first define a row
type group in System Setup. A row type group is used to store individual row types.

Note: The following instructions assume that you have not set an ID or name pattern on the Table Row Type
Group (ID = table row type group) or Table Row Type (ID = table row type) object types, located under System
Setup > Object Types and Structures > Basic Object Types > Table Row Type Group. To have these IDs
and/or names autogenerate, follow the instructions provided in the Autogenerate Using Name Pattern and ID
Pattern topic in the System Setup documentation.

Defining Row Type Groups
1. In System Setup, go to Table > Table Row Types, then right-click and select Create Row Type Group.

2. In the New Row Type Group dialog, enter an ID and Name for your row type group, then click Create.

3. The dialog closes and the row type group is created.

4. If you need to delete the row type group, select the row type group, then right-click and select Delete. If the row type
group contains a row type, the row type must be deleted first.

Defining Row Types
1. In System Setup, navigate to the desired row type group, then right-click and select Create Row Type.

2. In the New Row Type dialog, enter an ID and Name for your row type, then click Create.

3. The dialog closes and the row type is created.

4. The row type is ready for use, through in most cases row type settings and formatting definitions will need to be
applied. Refer to the Configuring Settings for Row Types and Rows topic for more information.

5. If you need to delete the row type, select the row type, then right-click and select Delete.
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Modifying the Row Type Name
After the row type is created, you can modify the name by entering a new name in the Name field on the Row Type tab.

Defaults
Row type settings and formatting definitions, such as text alignment and row height, are applied under Defaults.
Refer to the Configuring Settings for Row Types and Rows topic for more information.

Heading/Footer
In the Heading/Footer field, specify whether the row type should be a Normal Row, Heading (1), Sub Heading 
(2), or Footer. These row type designations enable table transformations to specify how to handle the row.

For example, Heading and Sub Heading rows can be excluded for certain transformations, such as alternate row
shading, where the Heading and Sub Heading rows should remain unformatted. Likewise, if a table is split across
columns or pages when mounted in InDesign, a row designated as a Heading will repeat at the top of the table in
both frames.
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Footer rows are handled similarly by table transformations. For example, the text style or background shading of
Footer rows is typically different than that of the rest of the table. Therefore, Footer rows can be excluded for
certain transformations that apply to the whole of the table but should not apply to the Footer row.

Publication Types
If the row type should only appear in tables that are mounted on pages connected to specific publication types, follow
these steps:

1. Click inside the Publication Types field and click the [...] button. The Select Publication Types dialog box displays.
The dialog displays all available publication types.

2. Leave Show In All Publication Types selected if the row type should be allowed in all publication types. This is the
default setting.

3. Select Specify if the row type should only be allowed in certain publication types. To exclude the row type from a
specific publication type, select the publication type, then click the right-pointing arrow to move the publication type
into the Excluded column.

4. To ensure that the row type is excluded from any publication type created in the future, select Future Publication
Types, then click the right-pointing arrow to move the publication type into the Excluded column.

5. Click OK when complete.

Legal for Table Types
All row types must be made legal (valid) for at least one table type before the table type can be used to create a table in
STEP. To make a row type valid for a table type, follow these steps:

1. On the Row Type tab, expand the Legal for Table Types flipper.

2. Click Add Table Type. The Select Table Type dialog displays.
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3. Click the Browse or Search tab to browse to or search for the desired table type, then click Select.

4. The row type is now legal for the table type.

Removing a Table Type

To remove the legal setting for a table type, follow these steps:

1. On the Row Type tab, expand the Legal for Table Types flipper.

2. Right-click on the arrow to the left of the table type that you would like to remove, then select Remove Table Type.

3. The table type is removed.
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Creating Table Types
When you have created at least one column type and one row type, you can define the table group type and table type
itself. The process is similar to creating row types or column types. After creating the table type and giving it at least one
legal row type and one legal column type, you can start using it to create tables in the Tree.

Instructions on how to create legal row and column types are covered in this topic. For information on how to use a table
type to build a table, refer to the Creating Tables topic.

Note: The following instructions assume that you have not set an ID or name pattern on the Table Type Group
(ID = table type group) or Table Type (ID = table type) object types, located under System Setup > Object
Types and Structures > Basic Object Types > Table Type Group. To have these IDs and/or names
autogenerate, follow the instructions provided in the Autogenerate Using Name Pattern and ID Pattern topic in
the System Setup documentation.

Defining Table Type Groups
1. In System Setup, go to Table > Table Types, then right-click and select Create Table Type Group.

2. In the New Table Type Group dialog, enter an ID and Name for your table type group, then click Create.

3. The dialog closes and the table type group is created.

4. If you need to delete the table type group, right-click it and select Delete. If the table type group contains a table
type, the table type must be deleted first.

Defining Table Types
1. In System Setup, navigate to the desired table type group, then right-click and select Create Table Type.

2. In the New Table Type dialog, enter an ID and Name for your table type, then click Create.

© Stibo Systems - Public - 2025.3 - September 2025 23



Note: The ID for table types has a limit of 33 characters and cannot end with a '$.' For row and column
types, the ID has the usual restriction of 40 characters.

3. The dialog closes and the table type is created.

4. The table type is ready for use, through in most cases table type settings and formatting definitions will need to be
applied. Refer to the Configuring Settings for Table Types and Tables topic for more information.

5. If you need to delete the table type, right-click it and select Delete.

Modifying the Table Type Name
After the table type is created, you can modify the name by entering a new name in the Name field on the Table Type
tab.

Defaults
Table type settings and formatting definitions, such as text alignment and background color, are applied under
Defaults. Refer to the Configuring Settings for Table Types and Tables topic for more information.

Dimension Dependencies
Table types can be made dimension dependent if there is free text content within the table that needs to be translated
and/or appear differently in different countries. Since free text only exists within tables (and is not tied to attribute
values), the only way to enable free text content to appear differently in different contexts is to make the table type
dimension dependent.

Note: Attributes used in a table can be dimension dependent even if the table type itself is not. Dimension-
dependent attributes will display different values for different contexts automatically when the table is viewed in
a different context.
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To make a table dimension dependent:

1. Double-click inside the Dimension Dependencies field, then click the ellipsis button ( ).

2. In the Select Dimension Dependencies dialog, check the applicable Dimension checkbox. The number of
available checkboxes is determined by the number of dimensions that have been created in System Setup.

3. Click Apply to complete. The table type is now dimension dependent.

Dimension-Dependent Table Type Example

The following two screenshots show a dimension-dependent table type in two different Contexts.

1. Example with English Free Text values displayed in an English-language Context:
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2. Example with French Free Text values displayed in a French-language Context:

Pagination Plugin
The Pagination Plugin field is where the Header Repeating Pagination Plugin is selected. To choose this plugin:

1. On the table type tab, click in the Pagination Plugin field and select Header Repeating Pagination Plugin. ('None'
will appear as the default selection.)
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2. Click on Change Settings. The Header Repeating Pagination Plugin displays.
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Instructions on how to configure the Header Repeating Pagination Plugin are not covered in this topic. For
information, refer to the Header Repeating Pagination Plugin topic.

Legal Row Types
Every table type must contain at least one legal (valid) row type before the table type can be used to create tables in the
product or classification hierarchies.

The following steps explain how to add a legal row type to a table type.

1. On the Table Type tab, expand the Legal Row Types flipper and click Add Row Type.

2. In the Select Row Type dialog, click the Browse tab to navigate to the desired row type(s), then click Select. Row
types may be multi-selected by holding down Shift or Ctrl when making selections.

3. The row types are now legal for the table type.

Removing a Row Type

To remove a row type so it is no longer legal, follow these steps:

1. On the Table Type tab, expand the Legal Row Types flipper.

2. Right-click on the arrow to the left of the row type that you would like to remove, then select Remove Row Type.
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3. The row type is now removed.

Legal Column Types
Every table type must contain at least one legal (valid) column type before the table type can be used to create tables in
the product and/or classification hierarchies.

The following steps explain how to add a legal column type to a table type.

1. On the Table Type tab, expand the Legal Column Types flipper and click Add Column Type.

2. In the Select Column Type dialog, click the Browse tab to navigate to the desired column type(s), then click Select.
Column types may be multi-selected by holding down Shift or Ctrl when making selections.

3. The column types are now legal for the table type.
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Removing a Column Type

To remove (unlegalize) a column type, do the following:

1. On the Table Type tab, expand the Legal Column Types flipper.

2. Right-click on the arrow to the left of the column type that you would like to remove, then select Remove Column
Type.

3. The column type is now removed.

Default Row and Column Types
If more than one row type or column type is added, a default type must be specified for each. Default column types
are required to use the Create Table From Clipboard option.

Tables created using Create Table From Clipboard are 'pasted' from an external application such as Excel. Since no
prompt appears that asks you to choose which row or column types to use, the system will build the table using the
specified default row and column types.

To define a default row type or column type, click the radio button next to the preferred row type and column type. The
default type can be overridden in the table if needed.
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Refer to the Creating Tables From the Clipboard topic for more information.

Default Transformations
Transformations that apply to every table created from a table type are selected from the Default Transformations
area. To apply a default transformation to the table type, follow these steps:

1. On the Table Type tab, expand the Default Transformations flipper and click Add Transformation.

2. In the Select Transformation dialog, navigate to the relevant transformation, then click OK.

3. Repeat these steps to add additional transformations.

Descriptions of these transformations and instructions on how to configure them are not included in this topic.
Refer to the Table Transformations topic for more information.

Resolvable for Product Types and Classification Types
All table types must be made resolvable for at least one product, classification, or product-override object type before
the table type can be used to create tables in the Tree. 'Resolvable' essentially means the same thing as 'valid.' Though
a table can be built at a higher level in the product or classification hierarchy to take advantage of inheritance, the table
cannot be previewed or mounted in InDesign on any object where it has not been made resolvable (valid). To make
object types valid for table types, follow these steps:
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1. On the Table Type tab, expand the Resolvable for Product Types and/or Resolvable for Classification Type
flipper.

2. Check the box(es) for the product type(s) and/or classification type(s) where the table should be resolvable.
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Configuring Table Formatting
When you create table types and tables, you can apply formatting rules that determine how the table looks in InDesign
and in the STEPWorkbench on the Preview tab.

To format a table, you have to configure the formatting definitions in both STEP and InDesign. In STEP, you assign
formatting rules, and in InDesign the rules are interpreted. For example, if you have specified a light green background
color and a thin border, the actual color and thickness of the border depends on how the master document is set up in
InDesign.

The topics within this documentation section explain how to set formatting on entire tables, rows, columns, and cells.

Formatting Rules
Table formatting is based on the principle of inheritance.

Formatting inheritance enables you to define table formatting once, then have that formatting apply to all tables of the
specific type. Formatting in tables can be inherited from the default settings applied to the table types, row types, and
column types in System Setup, as well as from higher levels of the product hierarchy.

For example, in System Setup, you have a table type where the row height is set to 10 mm on the row type. However,
on the actual table, you may need the row height to be 9 mm for a particular subset of products. In that instance, the
definition inherited from System Setup would need to be overridden locally.

Inherited tables in the product hierarchy also inherit all formatting applied to the source table defined on the higher level.
In turn, this formatting can be overridden on any table built on a lower level, which localizes the table. Refer to the Table
Inheritance and Suppression topic for more information on the basic principles of table inheritance.

Additionally, definitions are inherited from within the table itself. For example, cells will inherit the formatting applied to
rows and columns; rows and columns will inherit formatting applied to entire tables, etc., and all of these can be
overridden as well.

Selecting Where to Apply Formatting Rules

Formatting rules can be defined generally in System Setup on table types, row types, and column types; and locally in
tables that are built on a specific product, classification, or product-override object.

You can apply table formatting on the following elements:

Table types

Column types

Row types
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Table in product hierarchy

Table rows

Table cells

Note: It is recommended to apply all general formatting rules in System Setup to limit the amount of local
formatting needed on individual tables. This makes it easier for you to gain an overview of all table formatting.
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Configuring Table Formatting in System Setup and InDesign
Table formatting is used in STEP and InDesign to enable users to format or create their own styles like fonts, text
colors, text styles, text sizes, and different background colors. For rules, users can apply thickness and colors to
the rules. These settings are required for designing tables.

Formatting definitions for STEP Tables are configured in two places: the System Setup tab in the STEPWorkbench
and in publication templates created in InDesign using Print Publisher.

Table formatting definitions in STEP are composed of the setups for Colors, Rules, and Style Tags. The corresponding
setups in publication templates are swatches, line styles, and paragraph styles.

The following sections of this documentation explain both the STEPWorkbench and the corresponding Print
Publisher publication template configurations required to format tables.
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Defining Table Colors in STEP
Colors in STEP are used to define the colors applied to rule lines and for the background shading of cells, rows,
columns, and entire tables themselves. These colors are used in the STEP Table Preview view in the workbench to
provide a rough approximation of what the table will look like on the InDesign page.

For these colors to display correctly on the InDesign page, each color used in a table must have a corresponding color
Swatch defined in the publication template that will be used to mount these tables InDesign. For more information on
configuring colors in the publication template, refer to the Configuring Table Styles in Publication Templates topic.

The following steps describe how to create a new color in STEP.

1. In System Setup, navigate to Table > Colors.

2. On the Table Colors tab, click Add Color.

3. In the Add Color dialog, enter a name for the new color.
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4. On the Swatches tab, select the preferred color.

5. Alternately, you may create a color from one of the four additional tabs:

HSV (Hue, Saturation, Value)

HSL (Hue, Saturation, Lightness)

RGB (Red, Green, Blue)

CMYK (Cyan, Magenta, Yellow, Black)

6. Click OK.

Note: Even though the Add Color dialog provides fairly advanced options for creating colors, colors created in
STEP are only used to render the color of rule lines and table cells in the STEP Tables Preview. To mount
tables in InDesign with the same color, you must create a corresponding color swatch for your publication
template in InDesign. The name of the color created in STEP and the swatch created in InDesign must match
exactly, as both names are case sensitive.
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Defining Table Rules in STEP
Rules in STEP are used to define the width and color of rule lines used in STEP Tables. Rules are used in the table
Preview view in the workbench to provide a rough approximation of what the table will look like on the InDesign page.
Table rules created in STEP must also have corresponding Line Styles defined in the publication template through the
Print Publisher Table Settings dialog. The following steps explain how to define a table rule in STEP.

1. In System Setup, expand Table, then click Rules.

2. On the Table Rules tab, click Add Rule.

3. In the New Rule dialog, enter a Name and Width for the new rule. The width of rule lines are always measured in
points. Select a Color from the dropdown list.

Click Create.

Note: If needed, any of the aforementioned values (Name, Width, and Color) may be changed in STEP after
the rule has been created.
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Considerations and Limitations
Rule Name

The Name of the rule must exactly match the name of a corresponding line style created in the publication template in
InDesign. The name in both locations is case sensitive.

Rule Width

The value entered for Width is a number that defines the width of the rule line in points, which is typically a number from
1 to 3 (but can be larger if needed). STEP will not accept a number lower than 1 in the Width field, even if the output for
the line in InDesign will be less than 1 pt (for example, 0.25 pt or 0.5 pt).

The Width value entered in STEP is only valid for the table preview, as the preview functionality cannot represent a line
smaller than 1 pt. Due to this, a rule line intended to only be 0.25 pt or 0.5 pt must always display as 1 pt in STEP. The
true display of the rule line in InDesign will be set in the publication template.

Rule Color

The options available in the Color dropdown list are limited to those that have already been created under Table >
Colors in System Setup. The Defining Table Colors in STEP topic, explains the process for creating colors in STEP.

Dashed, Dotted, and Other Non-solid Rule Styles

The STEP Table Preview does not support display of dashed, dotted, or other non-solid line styles. Rule lines will still
appear as solid lines in the preview. Non-solid styles are only visible from actual pages created in InDesign.

With this in mind, you may choose to differentiate a dashed rule from a solid rule in STEP by assigning a non-standard
color to the rule line. For example, a bright fuchsia color could be a visual indicator—in the table preview only—that the
rule line is 'different'.
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Defining Style Tags for Tables
Style tags in STEP are commonly used to apply text styling to STEP Tables. Style tags define styles such as bold,
underline, italic, color, left aligned, right aligned, center aligned, and so on. Style tags can be applied at the table,
column, row, or cell level. Typically, each style tag in STEP will match, by name, a corresponding paragraph style in the
InDesign publication template.

Note: The following steps describe how to configure a sample setup for a style tag and tag group intended to
be used for tables; this is not all-encompassing documentation on the subject of tags and style tags. Full
instructions for how to create style tags in STEP are located in the Tags topic of the System Setup
documentation.

Create a Tag Group for Table Style Tags
1. In System Setup, navigate to Tags > Style Tags.

2. Right-click and select New Tag Group.

3. Give the new tag group an ID and Name that identifies the group as a container for tables-only styles, e.g., 'Table
Styles'. Click Create. (This is merely a 'recommended practices' suggestion—style tags used in tables may be
created in the same tag group as style tags that are used for basic text formatting in rich text editors in STEP.)

4. Right-click the newly created 'Table Styles' tag group, then select New Tag.

5. Give the new style tag a Name and Tag that indicates its intended output in InDesign. For example, the style could
be named Bold_C to indicate that it is a bold, centered text style. (This is merely a suggestion, as the value of Name
and Tag can be anything you would like as long as there is a matching paragraph style in InDesign.)

Note: To avoid confusion, it is recommended to give Name and Tag the same value.
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6. With the newly created style tag selected, click inside the Rendering field on the Style Tag tab, then click the ellipsis
button ( ).

7. In the Rendering dialog, make the selections that will approximate the intended look of the style on the InDesign
page, then click Apply.

In this example, the options to display the Bold_C style as 12 pt black Arial Bold have been selected. A
preview of the text is shown at the bottom of the dialog.

Note: The 'Paragraph Style' checkbox is only used for HTML output of style tags that are used to define
bullet lists. For more information, refer to the Creating Tag Groups and Tags topic of the System Setup
documentation.
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8. After the Rendering dialog closes, the view reverts back to the Style Tag tab.

9. On the Style Tag tab, select Yes for Show Style.

Note: Selecting No will make the tag unavailable for selection in all dropdown lists available in STEP. No is
only used for 'hidden' styles such as stibo.STIBOSPELL, which is used by the system to highlight spelling
errors in STEP's text editors.

10. Leave Keyboard Shortcut blank if you intend to use this style only in STEP Tables. Keyboard shortcuts are only
relevant for tags intended for use in STEP rich text editors, since there is no way to use a shortcut to apply a style tag
anywhere inside a table.

11. Select No for List Tag, since this style tag will not be used to configure the output of bullet lists in HTML.

12. Output Formatting is not required for style tags created specifically to apply styling to tables. These style tags are
matched by Name to a corresponding paragraph style in InDesign.

Limitations of Style Tag Display in the STEP Tables Preview
The STEP Tables Preview will only display text as left aligned, even if the style tag is intended to display centered, right-
aligned, or justified text in InDesign. However, this is merely a limitation of the preview; the text styles will display
correctly when the table is mounted in InDesign.

Note that any settings applied in the Rendering dialog (bold, color, italics, etc.) will display properly in the preview.

© Stibo Systems - Public - 2025.3 - September 2025 43



Configuring Table Styles in Publication Templates
To format STEP tables on InDesign pages, a parallel set of formatting configurations must be created in STEP and
InDesign for the following:

Colors (used both for rule lines and background shading)

Rule lines

Text styles

In STEP, these configurations are the Colors, Rules, and Style Tags created on the System Setup tab. The
corresponding configurations in InDesign are swatches, line styles, and paragraph styles. The InDesign
configurations are created in the InDesign publication template that will be used to mount (generate) tables in
InDesign.

This topic deals only with the table formatting definitions created in publication templates. Full details on how to
configure the corresponding definitions in STEP are outlined in the Configuring Table Formatting in System Setup and
InDesign topic.

Example of a Styled Table in STEP
The following screenshot shows a styled table in STEP as it appears in the STEP Table Preview. The background
colors, rule lines, and text styles have been applied using the settings created in System Setup. In order for the table to
appear with the same colors, text styles, and rule lines in InDesign, the corresponding settings must be created in the
publication template.

Note: If no styles are defined for the table in STEP, the table will be mounted in InDesign with basic InDesign
paragraph styling, and the table must then be styled manually using the standard InDesign table editor. Manual
styling of tables on InDesign pages is discouraged, as formatting not connected to STEP can be easily lost
when tables are updated.
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Configuring Table Colors in InDesign
Colors defined in STEP are configured in InDesign as Swatches, as follows:

1. In InDesign, navigate to Window > Color > Swatches (or press F5). The Swatches panel displays.

2. Click the Options menu in the upper right corner of the Swatches panel, then click New Color Swatch.

3. On the New Color Swatch dialog, deselect the Name with Color Value checkbox, then type a name in the Swatch
Name field.
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Note: The name of the swatch must be identical to the corresponding color created in STEP. Names of
colors and swatches are case sensitive.

4. Adjust the color values as needed, then click OK.

Loading Swatches From Another InDesign Document

To load swatches from another InDesign document:

1. In the Swatches panel, click the Options menu, and then click Load Swatches. An Open a File dialog box displays.

2. Navigate to the InDesign file that contains the swatches that you would like to import, then click Open. (This file does
not have to be another publication template; it can be any InDesign document.)

3. The Swatches from the selected InDesign file will automatically import.

Configuring Table Line Styles in InDesign
Rules defined in STEP are configured as table Line Styles in InDesign via the STEP > Table Settings menu. Line
styles govern the lines ('borders' or 'rulers') that appear between cells and/or surround the table.

To create line styles in the InDesign publication template:

1. Navigate to STEP > Table Settings. The Table Settings dialog displays.

2. Click Add in the lower left-hand corner. The New Line Style dialog displays.
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3. Populate the fields in the New Line Style dialog as follows:

Style Name: Name of the line style. Must exactly match the name of the corresponding rule created in STEP. Is
case sensitive.

Line Weight: Width in points. The measurement unit will always default to points regardless of what
measurement unit is being used for the rest of the page (for example, mm, inches, or picas).

Line Colour: Color of the line style. An InDesign swatch for the color must first be created in the publication
template before the color will appear in this dropdown list.

Line Tint: Opacity level of the line style. Default is 100%. Value must be typed.

Line Type: Specify whether the line style should be solid (most common) or a different style such as dashed or
dotted. The same line styles available in the InDesign Stroke panel are available in the Line Type dropdown.
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Gap Colour: Only applicable for non-solid rule lines. Defines the color that goes in between the dashes, dots,
hashes, etc. The same colors (swatches) that appear in the dropdown list for Line Colour appear in the Gap
Colour dropdown. Leave blank for solid rule lines.

Gap Tint: Opacity level of the gap color. Default is 100%.

Insets (Left, Above, Right, Below): How much inset space ('padding') should be placed between the edge of a
cell that is bordered by the rule line and the text or image content within the cell. If left blank—or if a value of 0 is
inserted—the insets will default to InDesign's default table cell inset, which is 4 points (or, 0.0556 inches or 1.411
mm).

Note: If you would like no inset padding at all, enter a hairline space value of .0001. The system will
recognize this value as being so close to 0 that there will be no visible inset padding.

4. Click OK when finished. Any values entered during the initial creation of the line style may be edited later if needed.

Loading Table Line Styles From Another InDesign Document

To load table line styles from another InDesign document:
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1. Navigate to STEP > Table Settings, then click the Import button in the lower left corner of the Table Settings dialog
box.

2. An Open a File dialog box displays. Locate the InDesign publication template containing the line styles that you
would like to import, then click Open.

3. The line styles from the selected InDesign file will automatically import.

4. Click OK to complete.

Configuring Paragraph Styles for Tables in InDesign
Style tags created in STEP and applied to tables are configured as paragraph stylesin InDesign.

For example: If the tables you are mounting from STEP contain the styles 'HeaderRowStyle' and 'BodyRowStyle', then
there must be corresponding paragraph styles also named 'HeaderRowStyle' and 'BodyRowStyle'. STEP style tags and
InDesign paragraph styles are both case sensitive and must match exactly.

To create a paragraph style in InDesign:

1. In InDesign, navigate to Window > Styles > Paragraph Styles (or press F11). The Paragraph Styles panel displays.
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2. Click the Options menu in the upper right corner of the Paragraph Styles panel, then click New Paragraph Style.

3. On the New Paragraph Style dialog, enter a Style Name that exactly matches the corresponding style tag in STEP.

4. Continue configuring the paragraph style as needed, then click OK to complete. 
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Merge of Row / Column Style Names

In the case where a row with a style applied crosses a column with a style applied, a third paragraph style is created
when the table is mounted in InDesign. The name of this third paragraph style (sometimes called an 'intersection style')
is a combination of the name of the paragraph style used for the row and the paragraph style used for the column,
connected by an em dash.

For example, a table may contain a row style called 'bold' and a column style called 'RedBold'. In the cells where these
rows and columns cross over each other, the two styles will overlap. When the table is mounted in InDesign, the system
will automatically create a new paragraph style called 'bold—BoldRed'.

However, with the system not knowing which of the two paragraph styles to pick up, the newly created 'intersection'
style will appear as a generic (basic) paragraph style.

Note: To avoid the creation of 'intersection' styles in InDesign, it is recommended to apply text styling at the cell
level in tables where an overlap will occur between row and column styles. 'Intersection' styles are essentially
duplicates of existing styles and can cause clutter in a long list of paragraph styles.

For more information on applying formatting to table cells, refer to the Configuring Settings for Cells topic.
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Configuring Table Settings
Table settings are formatting options that are applied to tables either as global default settings on table object
types in System Setup or as local settings on table definitions in the Tree. These settings not only include style
tags, colors, and rules, but other formatting options such as table width, column width, row height, cell rotation,
text alignment, table orientation, and image scaling options.

When applied globally in System Setup, the settings apply to table object types—table types, column types, and row
types. When applied locally, these settings apply to table definitions—tables, rows, columns, and cells.

Global default settings inherit to the associated table types, column types, and/or row types wherever they are used in
STEP. Using global settings lowers the amount of maintenance needed on tables that need similar formatting.

Local settings are applied if an exception is needed to the global settings, since local settings will override global
settings. Another reason to use local settings is if you do not want to be locked into global default settings in the first
place. Local settings can still be created once and used many, through inheritance. They can be applied to table
definitions at a higher node in the product hierarchy and inherited by child nodes in the Tree below.

Note: Style tags, colors, and rules must be created in System Setup before they can be applied to table types
and table definitions. For more information, refer to the Configuring Table Formatting in System Setup and
InDesign topic.

Available Table Settings
The following table lists the available table settings and the table elements from which they can be accessed.

Setting Availability

Table & Table Type Row & Row Type Column & Column Type Cell

Width Yes No Yes No

Height No Yes No No

Text Style Yes Yes Yes Yes

Background Color Yes Yes Yes Yes

Rule Above Yes Yes No Yes

Rule Below Yes Yes No Yes
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Setting Availability

Rule Left Yes No Yes Yes

Rule Right Yes No Yes Yes

Vertical Alignment Yes Yes Yes Yes

Cell Rotation Yes Yes Yes Yes

Process Flag Yes Yes Yes Yes

Cell Story Direction Yes Yes Yes Yes

Cell Image Scale Yes Yes Yes Yes

Table Orientation Yes No No No

Keep With Next No Yes No No

For more information on how to apply these settings to the relevant table elements, refer to the following subtopics
within this documentation section:

Configuring Settings for Table Types and Tables

Configuring Settings for Column Types and Columns

Configuring Settings for Row Types and Rows

Configuring Settings for Cells

Descriptions of Table Settings
Descriptions of all available table settings are as follows:

Width

When set on a table or table type, this setting defines the width of the entire table. When set on a column or
column type, this setting defines the width of the column. Available units are inches, millimeters, picas, and points.

Also included in the dropdown is Proportional, which is used with columns. This setting provides the option to specify
proportionality to other columns in the table.
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Example: When Table X is mounted, then column type B will be twice as wide as column type A. The proportion is 2 to
1.

Table X

Column Type A Proportional is set to 1

Column Type B Proportional is set to 2

Proportional is set to 1 for Column Type A and Proportional is set to 2 for Column Type B. Column type B will be twice
as wide as column type A, as illustrated in this screenshot from the Preview tab in STEP:

To prevent having to select a unit every time a width is set, a default unit can be set in System Settings under Users &
Groups. Refer to the Table Defaults topic for more information.

Height

Only available for rows. Defines the height of the specified row type or row. Available units are inches, millimeters,
picas, and points.

To prevent having to select a unit every time a height is set, a default unit can be set in System Settings. Refer to the
Table Defaults topic for more information.

Text Style

Defines the text style for the table, column, row, or cell. Contents of the dropdown list are populated by style tags
created in System Setup.
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Background Color

Sets the background color of the table, column, row, or cell. Contents of the dropdown list are populated by table colors
created in System Setup.

Rule Above

Controls which line style is used as the top border of the table, row, or cell. Contents of the dropdown list are populated
by table rules created in System Setup.

Rule Below

Controls which the line style is used as the bottom border of the table, row, or cell. Contents of the dropdown list are
populated by table rules created in System Setup.

Rule Left

Controls which line style is used as the left border of the table, column, or cell. Contents of the dropdown list are
populated by table rules created in System Setup.

Rule Right

Controls which the line style is used as the right border of the table, column, or cell. Contents of the dropdown list are
populated by table rules created in System Setup.

Vertical Alignment

Controls the vertical alignment of cell contents (text and images) as follows:

Alignment Description Example

Top Aligns contents to top

Center Centers contents vertically

Bottom Aligns contents to bottom

Justify Aligns content evenly from top to bottom
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Cell Rotation

Controls the orientation of cell contents (text or images). Cell contents can be rotated 0, 90, 180, or 270 degrees,
as follows:

Cell Rotation Example

0

90

180

270

Process Flag

Nothing is typically available in this dropdown list. This area is sometimes used to store custom table settings.

Cell Story Direction

Determines whether the contents of the cells in the table (text and images) are displayed horizontally or vertically.

Cell Story Direction Direction

Horizontal (default) Sets the text direction to horizontal:

Vertical Sets the text direction to vertical:
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Cell Image Scale

Controls the size of images linked into the cell. Images may be scaled from 25% to 500%.

By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set on the
column or row containing the image, the image will mount at 100% (actual size). If a scale value is entered, the image
will mount at the specified size, even if a width or height has been set on the column or row.

Table Orientation

Determines how STEP calculates cell values based on the placement of the data providers (e.g., products) and data
selectors (e.g., attributes) in the table. This setting enables more predictability in cell values after transformations are
applied.

Note: This option is only available when defining settings for table types or tables.

The available Table Orientation options are:

Automatic: This is the default setting. The Automatic orientation calculation treats a table as horizontal if it
encounters a data provider in a row, and vertical if it encounters a data provider in a column.

Horizontal: When set to Horizontal, STEP calculates the cell value based on the assumption that the data provider
is in the row and the data selector is in the column.

Vertical: When set to Vertical, STEP calculates the cell value based on the assumption that the data provider is in
the column and the data selector is in the row.

Data Providers and Data Selectors

The following table explains which content definitions are considered Data Selectors and which content
definitions are considered Data Providers. For full details on these content definitions, refer to the Content
Definitions topic.

Data Providers Data Selectors

Composite Attribute Values

Current Object

Asset

Asset Reference
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Data Providers Data Selectors

First SubProduct,
Classification
First SubProduct, Family

Node Reference

Parent

Product/Classification/Asset

Referenced Node

SubClassifications,
Classification
SubProducts, Classification

SubProducts, Family

Attribute

Attribute Group Attributes (will dynamically resolve to
attributes)

Commercial Data

Commercial data aspect

Composite Attribute – All Attributes

Composite Attribute – Single Attribute

Date Spread Commercial data

Legal Attributes (will dynamically resolve to attributes)

Meta Data Attribute

Parent Name

Keep With Next

Only available for rows. Check this box if rows, or rows of the row type, should remain with the next row in the table if
the mounted table splits across a column or page. (A table will split across a column or page if it is too large to fully
mount in a single column or page.) The row will be mounted onto the following column or page in order to keep it with
the next row.

Considerations and Limitations
The following settings are not visible in the STEP Tables Preview:

Vertical Alignment

Cell Rotation

Cell Story Direction

To preview these settings in the table, you must either use the Proof View in the workbench or Web UI; or mount the
table in InDesign.

For more information, refer to the Print Proof View topic and the Mounting Pages in Print Publisher topic, both in the
Publisher (Adobe InDesign Integration) documentation.
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Configuring Settings for Table Types and Tables
Settings for table types are applied in System Setup. These formatting definitions are global, meaning that they will
inherit to the table type wherever it is used in STEP. Since case-by-case exceptions to global formatting are sometimes
needed, these settings can be overridden locally on the table definition by changing the table settings.

Note: Style tags, colors, and rules must be created in System Setup before they can be applied to table types
and tables. For more information, refer to the Configuring Table Formatting in System Setup and InDesign
topic.

Configuring Default Table Type Settings
To configure settings for table types in System Setup, follow these steps.

1. On the Table Type tab, click the ellipsis button ( ) in the Defaults field.

2. The Change Defaults dialog displays.
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3. Settings applied from this dialog apply to the entire table. For full details on these settings, refer to the Configuring
Table Settings topic.

Note: The Rule Above, Rule Below, Rule Left, and Rule Right settings do not apply rules to all columns and
rows within the table. Rather, these settings control the line styles used for the outer borders of the table
(top, bottom, left, and right).

Configuring Local Table Settings
Local changes to formatting that applies to an entire table are made using the Change Table Settings dialog. This
dialog is accessed from tables when viewed on the Definition tab. When table formatting is changed locally on a table
definition, any default formatting inherited from the table type in System Setup is overridden.

To access the Change Table Settings dialog and apply local formatting to a table, follow these steps.

1. In the Tree, select the relevant product, classification, or product-override, and then click the Tables tab.

2. Select the relevant table, then click the Definition tab.

3. Right-click inside of any table cell, then select Change Table Settings.
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4. The Change Table Settings dialog displays. The settings in this dialog are identical to those in the Change
Defaults dialog that is accessed from the table type in System Setup.

5. If a setting is inherited from the table type, 'Table Type' will display to the right of the options.
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6. When a setting is changed, the 'Inherited' label no longer displays, and nothing is listed to the right of the options.

Note: When a table setting is changed locally, no gray triangles display anywhere within the table to indicate
that something inherited from System Setup has been overridden. A gray triangle does appear when the
settings of a columns, rows, or cell are overridden.
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Configuring Settings for Column Types and Columns
Settings and formatting definitions for column types are applied in System Setup. These formatting definitions are
global, meaning that they will inherit to the column type wherever it is used in STEP. Since case-by-case exceptions to
global formatting are sometimes needed, these definitions can be overridden locally on columns within table definitions.
Row formatting takes priority over column formatting in tables.

Note: Style tags, colors, and rules must be created in System Setup before they can be applied to column
types and columns. For more information, refer to the Configuring Table Formatting in System Setup and
InDesign topic.

Configuring Default Column Type Settings
To configure settings for column types in System Setup, follow these steps.

1. On the Column Type tab, click the ellipsis button ( ) in the Defaults field.

2. The Change Defaults dialog displays.
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3. Settings applied from this dialog apply to all columns that will be created from the column type. For full details on
these settings, refer to the Configuring Table Settings topic.

Configuring Local Column Settings
When column formatting is changed locally, all inherited formatting is overridden. Local changes to column formatting
are made using the Change Row Settings dialog. To access this dialog and apply local formatting to a column, follow
these steps:

1. In the Tree, click the relevant product, classification, or product-override, then click the Tables tab.

2. Select a table, and then click the Definition tab.

3. Select a column, right-click, and then click Change Settings.

4. The Change Column Settings dialog displays. The settings in this dialog are identical to those in the Change
Defaults dialog that is accessed from the column type in System Setup.
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5. The level from which the settings are inherited is displayed to the right of the options, which is both Table Type and
Column Type in this example.

6. When a setting is changed, the 'Inherited' label no longer displays, and nothing is listed to the right of the options.

7. Additionally, a gray triangle appears in the column type definition cell to indicate that the column has local settings
applied that override inherited settings.
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Configuring Settings for Row Types and Rows
Settings and formatting definitions for row types are applied in System Setup. These formatting definitions are global,
meaning that they will inherit to the row type wherever it is used in STEP. Since case-by-case exceptions to global
formatting are sometimes needed, these definitions can be overridden locally on rows within table definitions. Row
formatting takes priority over column formatting in tables.

Note: Style tags, colors, and rules must be created in System Setup before they can be applied to row types
and rows. For more information, refer to the Configuring Table Formatting in System Setup and InDesign topic.

Configuring Default Row Type Settings
To configure settings for row types in System Setup, follow these steps.

1. On the Row Type tab, click the ellipsis button ( ) in the Defaults field.

2. The Change Defaults dialog displays.
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3. Settings applied from this dialog apply to all rows that will be created from the row type. For full details on these
settings, refer to the Configuring Table Settings topic.

Configuring Local Row Settings
When row formatting is changed locally, all inherited formatting is overridden. Local changes to row formatting are
made using the Change Row Settings dialog. To access this dialog and apply local formatting to a row, follow these
steps:

1. In the Tree, select the relevant product, classification, or product-override, then click the Tables tab.

2. Select the relevant table, then click the Definition tab.

3. Select a row, right-click, and then click Change Settings.
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4. The Change Row Settings dialog displays. The settings in this dialog are identical to those in the Change Defaults
dialog that is accessed from the row type in System Setup.

5. The level from which the settings are inherited is displayed to the right of the options, which is both Table Type and
Row Type in this example.

6. When a setting is changed, the 'Inherited' label no longer displays, and nothing is listed to the right of the options.

7. Additionally, a gray triangle appears in the row type definition cell to indicate that the row has local settings applied
that override inherited settings.

© Stibo Systems - Public - 2025.3 - September 2025 68



Configuring Settings for Cells
Settings that apply to individual cells can only be applied from within table definitions, using the Change Cell Settings
dialog. Settings applied to cells take priority over all other formatting—table, row, and column. To access this dialog and
apply settings to a cell, follow these steps.

1. In the Tree, select the relevant product, classification, or product-override, then click the Tables tab.

2. Select a table, and then click the Definition tab.

3. Right-click inside of the relevant cell, then click Change Cell Settings.

4. The Change Cell Settings dialog displays. The level from which the settings are inherited is displayed to the right of
the options, which include Table Type, Table, and Column Type in this example.

For full details on these settings, refer to the Configuring Table Settings topic.
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5. After a cell is overridden, the 'Inherited' label no longer displays, and nothing is listed to the right of the options.

6. Additionally, a gray triangle appears in the cell to indicate that the cell has local settings applied that override
inherited settings.

© Stibo Systems - Public - 2025.3 - September 2025 70



Creating Tables
Tables are created in STEP on product, classification, or product-override objects, typically at a higher level of the
hierarchy where it can be inherited to lower levels. The first step in creating a table is to add a table type to the relevant
product, classification, or product-override object.

Prerequisites
This topic assumes the following:

A table type has already been created in System Setup

You have determined the location in the product hierarchy where the table will be built. The creation point is
important because tables are inherited downwards in the hierarchy, unless overridden by a local variation of the
table. For more information on table inheritance, refer to the Table Inheritance and Suppression topic.

Important: Though tables can be created on classifications, it is recommended to only create them in the
product hierarchy to simplify the maintenance of inherited tables.

Add a Table Type to a Product or Classification
1. In the Tree, navigate to the relevant product, classification, or product-override object, then select the Tables tab.

2. Click Add Table Type to display the Select Table Type dialog.

Add Table Type can also be accessed from the STEP Edit menu.
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3. Browse or search for the relevant table type, then click Select.

4. The table type appears in the Tables list on the Tables tab.

You can now create tables with the Create Table wizard or by starting with an empty table, then specifying the contents
and settings of the table. For more information, refer to the following topics: Using the Create Table Wizard topic and
Creating a New Empty Table topic.

Delete a Table
1. Right-click the table you want to delete, then click Delete Table.
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2. If the table was defined locally, but the local table overrode a table inherited from a higher level, the text under the
Defined At column changes from Local to the name of the node on which the table is built, and the table type itself
remains. Due to the inheritance, the table type cannot be deleted; only suppressed. Refer to the Table Inheritance
and Suppression topic for more information on table suppression.

3. If the table was defined locally and did not override a table built at a higher level, then Local changes to Not
Defined. The table type can then be deleted by right-clicking on the table type and selecting Remove Table Type.

Remove Table Type can also be accessed from the STEP Edit menu.
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Using the Create Table Wizard
The Create Table wizard enables you to build a basic table through a two-step process that involves selecting the
products, then selecting the attributes that should appear in the table. This wizard enables the creation of two basic
types of tables—horizontal and vertical.

Most tables that are built with the Create Table wizard will need additional configurations once created, such as the
addition of plain text or images, dynamic content definitions, and transformations. However, using this wizard gets the
basic structure and content of the table in place. For information on how to add these more advanced features, refer to
the Content Definitions topic.

Prerequisites
This topic assumes the following:

A table type has already been created and linked to the product, classification, or product-override where you will be
building the table

The table type has at least one legal column type and one legal row type

You have determined the location in the product hierarchy where the table will be built. The creation point is
important because tables are inherited downwards in the hierarchy, unless overridden by a local variation of the
table. For more information on table inheritance, refer to the Table Inheritance and Suppression topic.

Create a Basic Table
1. In the Tree, select the product, classification, or product-override object on which the table will be built.

2. Go to the Tables tab, then select the relevant 'Not Defined' table type.

3. Right-click the table type and choose Create Table to display the Create Table wizard.
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4. In the Select Products step of the Create Table wizard, browse to or search for the product(s) that should be
included in the table. Products can be multi-selected by holding the Shift or Ctrl key while making selections. It is
possible to select products that are located at different levels in the hierarchy than where you are creating the table.

Note: A common setup for tables is to place a product, product-override, or classification object with
children (e.g., a product family) into a single row, then apply a content definition to the row that will
dynamically display the child objects in additional rows of the table. Refer to the Product Content Definitions
topic for more information.

5. Next, specify whether the table should be horizontal or vertical by choosing whether products appear in rows or
columns.

Select Products in rows to create a standard horizontal table where the information that relates to specific
products is placed across the table, in rows. In the Type dropdown list, choose the row type to use for the product
rows. The available row types are those that are legal for the table type.
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Select Products in columns to create a vertical table where the information that relates to specific products is
placed from top to bottom in the table, in columns. In the Type dropdown list, choose the column type to use for
the product columns. The available column types are those that are legal for the table type.

6. After making the preferred selections, click 'Next' to proceed to the Select Attributes step.

7. On the Select Attributes screen, three options are available to choose the attributes for the table. You can browse
to or search for attributes in the attributes hierarchy, or you can choose Legal Attributesto limit the list to the
specification attributes that are valid for the products you selected in the previous step. In any of these methods,
multiple attributes can be selected. The below screenshot shows how the attributes tree displays on the Browse tab.

Note: Only individual attributes can be chosen in this step; entire attribute groups cannot. Even though the
system will let you choose attribute groups if you have already selected at least one individual attribute, only
the individual attributes will display in the finished table.

8. When Legal Attributes is selected, two options are available from the dropdown:
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Choose Linked Local to view all attributes that are linked locally to the selected products. In this option, attributes
inherited from a higher level are not displayed. For more information on locally linked attributes, refer to the
Attribute Links topic of the System Setup documentation.

Choose All Legal Attributes to view all specification attributes that are valid for the selected product(s). This
includes both inherited attributes and attributes that are linked locally. For more information on attribute validity,
refer to the Validity on Specification Attributes topic of the System Setup documentation.

9. For the Linked Local and All Legal Attributes options, select the desired attributes in the left window of the dialog
and choose Add to add them to the Selected window. Attributes may be multi-selected by holding the Ctrl or Shift
key while making selections. To add all of the attributes to Selected, click Add All. To remove a selection of
attributes from Selected, choose the relevant attributes, then click Remove. To remove all attributes from Selected,
click Remove All.
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10. In the Type dropdown, select the column or row type that you want to use for the attributes. The available options
will be based on whether you selected 'Products in rows' or 'Products in columns' in the 'Select Products' step of the
wizard. If you chose 'Products in rows,' then the dropdown list will contain column types. If you chose 'Products in
columns,' the dropdown will contain row types.

11. After selecting the relevant attributes, click Finish.

12. A table is created with the selected products and attributes.
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Creating a New Empty Table
Instead of using the Create Table wizard, an alternate method of creating a new table is to create an empty table. This
method allows you to create a table without necessarily having to know beforehand what attributes and/or products will
be used, other than the product on which the table will be built. As with tables that are built with the Create Table wizard,
an empty table will also need additional configurations once created, such as the addition of plain text or images,
dynamic content definitions, and transformations. For information on how to add these more advanced features, refer to
the Content Definitions topic.

This topic assumes the following:

A table type has already been created and linked to the product, classification, or product-override where you will be
building the table

The table type has at least one legal column type and one legal row type

You have determined the location in the product hierarchy where the table will be built. The creation point is
important because tables are inherited downwards in the hierarchy, unless overridden by a local variation of the
table. For more information on table inheritance, refer to the Table Inheritance and Suppression topic.

Create an Empty Table
1. In the Tree, select the product, classification, or product-override object on which the table will be built.

2. Go to the Tables tab, then select the relevant 'Not Defined' table type.

3. Right-click the table type and choose Create Empty Table.

4. An empty table grid with one free text cell is created. The cell is composed of one row and one column. The row type
and column type used are the ones chosen as default row / column types when the table type was created in System
Setup.
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5. Next, define the column and row Content Definitions of the table. For instructions, refer to the Adding, Editing, and
Overriding Content Definitions topic.
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Creating Tables From the Clipboard
To create a table based on tabular data from an external application such as Excel or Word, you can copy and paste the
information directly from the source document into STEP. This creates a table composed entirely of free text rows and
columns, i.e., the data is pasted exactly as-is from the source document. The system will build the table using the
specified default row types and column types.

Note: All content contained in a pasted table is free text and has no relation to attribute values in STEP, making
the table non-dynamic. Also note that the pasted content ignores any styling from the source document.

Prerequisites
This topic assumes the following:

A table type has already been created and linked to the product, classification, or product-override where you will be
building the table

The table type has at least one legal column type and one legal row type. If the table type uses more than one row
type or column type, a default type must be specified for each.

You have a spreadsheet or Word document ready that contains the tabular data that will be copied and pasted

You have determined the location in the product hierarchy where the table will be built. The creation point is
important because tables are inherited downwards in the hierarchy, unless overridden by a local variation of the
table. For more information on table inheritance, refer to the Table Inheritance and Suppression topic.

Creating a Table From a Spreadsheet
1. On your spreadsheet, highlight and copy the cells from which you would like to create the table.
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2. In the Tree, select the product, classification, or product-override object on which the table will be built.

3. Go to the Tables tab, then select the relevant 'Not Defined' table type.

4. Right-click the table type and choose Create Table From Clipboard.

5. The content from the clipboard is pasted into the table. The row types and column types are those set as the default
row and column type on the table type.
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Creating a Table From aWord Document
The same steps are used as those for creating the table from Excel, except the table is copied and pasted from aWord
document.
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Copy and Paste Tables, Rows, Columns, and Cells
This topic explains how to copy and paste tables from one node to another, as well as how to copy and paste columns,
rows, and cells within the same table or from one table to another table.

Copy and Paste Tables
Tables can be copied and pasted from one node to another. When a table has already been built, it can often be much
simpler to copy and paste it onto another node than to build a new table from scratch. Then, adjustments can be made
to the pasted table, as needed. Also, a table can be pasted over an existing table, which has already been defined, to
override a table definition that is inherited from a higher node.

Tables can be copied and pasted from different object types (i.e., from an item object to a family object) as well as from
product / product-override objects to classification objects (and vice versa). The copied table type does not have to be
of the same table type as the target table type, though it is typically recommended that the tables are of the same type,
since the pasted rows and columns may use row types and column types that are not legal for the target table.

The following steps assume that at least one source table has been created and defined on a product, classification, or
product-override object, and that at least one table or table type exists on the target product, classification, or product-
override object.

1. Navigate to the Tables tab of the product or classification object on which the source table has been built.

2. Right-click on the table, then select Copy.

3. Navigate to the Tables tab of the product, classification, or product-override object on which the target table or table
type has been added. The table does not have to say 'Not Defined'; if a table already exists, it can be pasted over.

4. Right-click on the table, then select Paste.
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Note: The table does not have to be of the same table type, but if the column and row types from the source
table are not valid for the target table type, the column type / row type cells will be highlighted red to alert you
that the types are not valid.

Copy and Paste Rows, Columns, and Cells
Rows, columns, and cells may be copied and pasted within the same table or from one table to another table.

1. Select the row, column, or cell that you would like to copy, then right-click and select the applicable option from the
menu:

Copy Rows

Copy Columns

Copy Cell Overrides

Copy Cell Settings

2. Select a row, column, or cell in the destination location, then right-click and select the applicable option from the
menu:
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Paste Rows

Paste Columns

Paste Cell Overrides

Paste Cell Settings

3. The copied row is pasted beneath the destination row. The copied column is pasted to the right of the destination
column. The copied cell overrides or cell settings are pasted directly into the destination cell and overwrite the
destination cell.

To multi-select rows or columns, click on the content definition cell of the row or column and hold the Shift or Ctrl
key while making selections.

Considerations for Copying and Pasting From One Table to Another

When copying and pasting rows, columns, and cells from one table to another, keep in mind the following:

Any formatting settings (text, color, rules, etc.) applied to the source row, column, or cell will be copied along with
it to the destination table

If the pasted row or column uses a row type or column type that is not valid in the destination table type, the row
type / column type will display in red, as found in the below screenshot. In this instance, either the column type
must be changed in the destination table to a column type that is valid for the destination table type, or the column
type itself must be made valid for the destination table type.
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Table Inheritance and Suppression
This section contains information about table inheritance, how to create and remove local overrides for tables, and how
to suppress and unsuppress tables.

STEP tables are based on the principle of inheritance. Just like product attributes set at a higher level in the product
hierarchy are inherited by products lower in the hierarchy, tables that are linked or defined at higher levels in the product
or classification hierarchy are then inherited by lower levels.

You can override the table definitions at lower levels if you need to create local variations of a table. This means that
you can create a table with a default look that applies to an entire publication. You can then override that table style with
a different style for specific a section of that catalog. That section can, in turn, contain a third variation of the table, and
so on.

Inheritance also applies to table formatting and table transformations. Refer to the Configuring Table Formatting and
Table Transformations topics for more information.

Table Inheritance
Before creating a table, you should consider carefully where in the product hierarchy it should be built. The creation
point is important because tables are inherited downwards in the hierarchy, unless overridden by a local variation of the
table.

If you plan to use your table on a large number of products, it should be defined close to the root of your product
hierarchy. If you are creating a table that will only be used on a small number of product families, or only one, then
select a definition point close to or on the actual product family level.

Making a Local Override
The following modifications result in an override of the inherited table style.

Adding, changing and removing columns and rows

Spanning or overriding cells

Changing the graphical settings for columns, rows or cells

Adding, changing or removing transformations

Changing the contents of a free text type cell

Note: If you modify the layout of a table in InDesign, it does not create a local override of the table in STEP.

Overriding a table at a lower level

The following example shows a table that is created at a high level in the hierarchy, and then overridden at a lower level.
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In this example, the Price Table and Sales Price Table have been created at the Products level. When you have
selected the node on which the table is defined, Local displays in the Defined Atcolumn.

On lower levels in the hierarchy, the Defined At column displays where the tables are defined. In this example, the
'Apparel' node is selected, and 'Products' displays in Defined At.

When an inherited table is changed at a lower level, a local override of the table is created. In this example, if changes
are made to the table contents at the Apparel level, the table still has the same name, but the table definition is now
different than the table defined at the Products level. Local is again displayed in the Defined At column, and, in turn, all
products below the current level will now inherit the new table definition.

Note: Products at sibling levels still inherit the table definition from the higher level in the hierarchy.
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In this example, changes have been made to the Price Table on the 'Apparel' level. Defined At now displays as Local.

Subsequently, the nodes below Apparel now inherit the version of the table built on Apparel.

Removing a Local Table Override
A local instance of a table can be removed to return to the definition of the table inherited from a higher level. This
deletion only removes the instance of the table defined at the local level; the table from the higher level remains.

1. Right-click on the Local table type that you want to delete, then select Delete Table.
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2. If the table was defined locally, but the local table overrode a table inherited from a higher level, the text under the
Defined At column changes from Local to the name of the node on which the table is built. Due to the inheritance,
the table itself cannot be deleted; only suppressed.

Suppressing Tables
Inherited tables cannot be deleted, only suppressed. Conversely, tables that are created locally cannot be suppressed,
only deleted. Refer to the Creating Tables topic for information on how to delete tables altogether.

A table is suppressed to keep it from being output when mounted to InDesign. For example, you have created an
InDesign template that has text frames for two table types and you have two tables defined on a selection of products in
STEP. Not all products will need both tables included on the mounted page. Suppress the one you do not need for each
product so that it will not be output to InDesign.

1. Right-click on the inherited table that you want to suppress, then click Suppress Table.
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2. Suppressed now displays in the Defined At column. The table can also no longer be defined or previewed; nothing
will display on either the Definition or Preview tab when a suppressed table is selected.

Unsuppress Tables

To unsuppress a table, right-click on the suppressed table and click Remove Suppression.
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Previewing Tables
The table Preview shows a rough estimation of what your table currently looks like. The preview displays the text,
colors, and lines based on how they are defined in System Setup. It does not exactly match what the table will look like
when mounted onto the InDesign page; this is determined by the InDesign settings in the publication template. So,
while the formatting options enable you to assign graphical attributes such as bold, italic, or color to your tables, it is not
a true rendering of the final output.

Preview a Table
Before you can preview a table, you have to select a specific publication version, since the table can include row types
and column types that are only valid in specific publication types. Additionally, if the table has a row or column with a
Commercial Data content definition, the publication version is important because commercial data is tied to publication
versions.

The table preview only shows the columns and rows that are valid in the selected publication and filters away any other
tables and rows. Likewise, commercial data is specified for a specific publication version, and is therefore only
displayed in the table if the relevant publication version is selected.

The attribute values, references, and images that are displayed in the preview depend on the selected context.

1. In the Tree, navigate to the relevant product, classification, or product-override object, then click the Tables tab.

2. Select the table that you want to preview, then click the Preview tab.

3. In the Select Version list, select the preferred publication version. If you cannot view the relevant version, click
Other, and search or browse for the relevant publication in the Select Publication Version window.
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Note: The Select Version text is displayed in red if the version points to a different context and workspace
than the ones selected in the toolbar. In this case, you have to change the context and workspace in the
toolbar to match the context and workspace defined on the version.

Previewing Transformations
The Preview tab is also where all local table transformations are assigned to the table that you are previewing. The
table transformations added are only added locally and do not override the table transformations on the table type. For
information about adding table transformations, refer to the Table Transformations section.
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Content Definitions
Content definitions determine what content appears in table rows, columns, and cells. The below table gives a brief
overview of each content definition and a link to more details in subsequent sections of the Tables documentation.

The third column of the below table indicates whether the content definition is considered a data provider or a data
selector. A data provider is a content definition that provides data; for example, a product that is placed into the table
using the 'Current Object' content definition. A data provider is acted upon by a data selector, which is a content
definition that selects data; for example, an attribute value being returned from the product by using the 'Attribute'
content definition. A common orientation for a table is a horizontal table, where data providers (e.g., products) are in
rows, and data selectors (e.g., attributes) are in columns.

Content Definition Description Data
Provider or
Data
Selector

Related Topic

Attribute Displays an attribute value for the selected
object. The Name and ID of an object is also
considered an attribute.

Data
selector

Attribute Content
Definitions

Attribute Group Attributes Extracts all attributes in a group. Data
selector

Meta Data Attribute Functions like the Attribute content definition
except it can display an attribute that is defined
on a reference. This will only display the value
on a reference when the opposing row or
column is using the Node Reference content
definition (as opposed to the Referenced Node
content definition).

Data
selector

Legal Attributes Dynamically resolves legal attributes of the
extracted products.

Data
selector

Composite Attribute - All
Attributes

Dynamically creates a row / column for each
attribute within the composite attribute type
every time the table is rendered.

Data
selector

Composite
Attribute Content
Definitions
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Content Definition Description Data
Provider or
Data
Selector

Related Topic

Composite Attribute - Single
Attribute

Creates a single row / column for each
attribute selected from the composite attribute
type.

Data
selector

Composite Attribute Values Required to enable the two other composite
attribute content definitions. I.e., if 'Composite
Attribute - All Attributes' is placed in a column,
then 'Composite Attribute Values' must be
placed in a row to return the values from the
specified composite attribute type on the
current object.

Data
provider

Current Object Extracts or resolves an object based on where
the table is extracted.

Data
provider

Product Content
Definitions

First SubProduct,
Classification

Dynamically returns information from the first
child (subproduct) of a selected classification.
This can, for example, be used to create a
header in a table.

Data
provider

First SubProduct, Family Similar to 'First Subproduct, Classification.'
Dynamically returns information from the first
child (subproduct) of a selected product family.

Data
provider

Node Reference Extracts values from a referenced product,
classification, or asset where the reference is
owned by a configured product, classification,
or asset.

Data
provider

Parent Extracts the parent product up a specified
number of levels in the product hierarchy.

Data
provider

Parent Name Displays the name of the parent product of the
product that is inserted in the table.

Data
selector
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Content Definition Description Data
Provider or
Data
Selector

Related Topic

Product/Classification/Asset Enables you to select a specific product,
classification or asset.

Data
provider

Referenced Node Extracts values from a referenced product,
classification or asset.

Data
provider

SubClassifications,
Classification

Extracts classifications that are children of the
current classification or a configured
classification.

Data
provider

SubProducts, Classification Extracts product families manually by pointing
to any level in the classification hierarchy or
dynamically from the level where the table is
defined.

Data
provider

SubProducts, Family Extracts products by pointing to any level in
the product hierarchy or dynamically from the
level where the table is defined.

Data
provider

Asset Points to a specific image or asset. Data
selector

Asset Content
Definitions

Asset Reference Inserts an image or asset based on the
selected asset type.

Data
selector

Free Text Enables you to enter free text content directly
in table cells. Free text is used where no
suitable attribute exists, or where you need to
enter some ad hoc data. Free text cells take
priority over any selections made at the row or
column level, meaning that the free text will
appear regardless of what content definition
has been chosen for the other row or column.

N/A Creating Table
Types

Free text cells
can be translated
if the table type is
language
dependent.
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Content Definition Description Data
Provider or
Data
Selector

Related Topic

Commercial Data Includes terms from a commercial list. Data
selector

Commercial Data
Content
Definitions

Commercial Data Aspect Includes a date aspect from the data field of a
commercial list.

Data
selector

Date Spread Commercial Data Uses commercial data from a publication
dynamically.

Data
selector

Blank Inserts a blank row or column. N/A N/A; No
additional
documentation
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Adding, Editing, and Overriding Content Definitions
This topic explains how to add, remove, and override content definitions them within rows, columns, and cells in tables.

Add or Edit Content Definitions for Rows and Columns
1. In the Tree, locate the table that you want to edit, then click on the Definition tab.

2. Right-click in the content definition cell on the column or row that you would like to edit, then click Edit. In the
following screenshot, the content definition cell has a preexisting content definition of .

Alternatively, you may double-click the content definition cell.

3. In the Row/Column Type & Content Definition dialog that displays, choose the relevant content definition from the
dropdown list. For most content definitions, a new dialog will display after you make your selection, requiring you to
make additional configurations.
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4. Refer to the Content Definitions section for next steps on how to choose and configure the desired content definition.

Override Content Definitions – Override Cell
In some instances, it may be necessary to overwrite the content definition of a row and/or column at the cell level. One
use case is when using the Asset content definition. If applied to an entire column or row, an identical image will appear
in every cell across the row or column. For this reason, the Asset content definition is typically applied at the cell level.

1. With your table open on the Definition tab, right-click inside the cell(s) that you want to edit, then choose Edit. Cells
may be multi-selected by holding Ctrl or Shift while making selections.

2. In the Override Cell dialog, you can choose to override the content definition of the row, column, or both.

3. Select the preferred content definition, then click OK. The dialog changes according to the content definition you
have selected.

To Remove Cell Overrides

1. Follow step 1 above to access the Override Cell dialog.

2. Choose None from the desired Column/Row Content definition dropdown list, then click OK.

© Stibo Systems - Public - 2025.3 - September 2025 103



Attribute Content Definitions
Attribute content definitions insert attributes for the selected object(s) in the table. Due to table inheritance, the
attributes chosen for the table do not actually have to be valid on the object on which the table is built, if the table will be
built dynamically using child objects. This would be the case, for example, when building a horizontally read table that
uses attribute content definitions in the columns and a product content definition such as 'SubProducts, Family' or
'SubProducts, Classification' in the rows.

Attribute content definitions can be applied for individual attributes (both specification and description) as well as for
attribute groups. The available attribute content definitions are:

Attribute and Meta Data Attribute Content Definitions

Attribute Group Attributes Content Definition

Composite Attribute Content Definitions - All Attributes

Composite Attribute Content Definitions - Single Attribute

Composite Attribute Content Definitions

Legal Attributes Content Definition
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Attribute and Meta Data Attribute Content Definitions
The Attribute and Meta Data Attribute content definitions inserts an attribute for the selected object in the table. The
Name and ID of an object is also considered an attribute. Both of these content definitions are configured identically,
except Attribute pulls the value of a Specification attribute and Meta Data Attribute pulls the value of a Description
attribute.

Note: Only individual attributes can be chosen when using the Attribute or Meta Data Attribute content
definition; entire attribute groups cannot. To select attribute groups, the Attribute Group Attributes definition
must be chosen. Refer to the Attribute Group Attributes Content Definition for more information.

1. Follow the steps in the Adding, Editing, and Overriding Content Definitions topic to open the Row/Column Type &
Content Definition dialog for your row or column.

2. In the Column/Row Content definition dropdown list, select Attribute or Meta Data Attribute. The steps in this topic
show the Attribute definition.
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3. Select Name to insert the object names in the table. If Name is inserted in a column, and the row extracts a product,
then the name of the product is inserted in the table.

4. Select ID to insert the object IDs in the table. If ID is applied to a column, and the row extracts a product, then the ID
of the product is inserted in the table.

5. Select Attribute to insert a specific attribute in the table. Three tabs are available for locating the attribute: Browse,
Search, and Legal Attributes.The screenshot below shows the dialog with the Browse tab selected.

Note: In any of these methods, multiple attributes can be selected by pressing Ctrl or Shift while making
selections. A new row or column will be created for each attribute selected.

6. When Legal Attributes is selected, two options are available from the dropdown:

© Stibo Systems - Public - 2025.3 - September 2025 106



Linked Local: Select this to view all specification attributes that are linked locally to the selected products. In this
option you will not view any attributes inherited from a higher level. For more information on locally linked
attributes, refer to the Attribute Links topic.

All Legal Attributes: - Select this to view all specification attributes that are valid for the selected product. This
includes both inherited attributes and attributes that are linked locally. For more information on attribute validity,
refer to the Validity on Specification Attributes topic.

7. For the Linked Local and All Legal Attributes options, select the desired specification attributes in the left window of
the dialog and choose Add to add them to the Selected window. Attributes may be multi-selected by holding the Ctrl
or Shift key while making selections. To add all of the attributes to Selected, click Add All. To remove a selection of
attributes from Selected, choose the relevant attributes, then click Remove. To remove all attributes from Selected,
click Remove All.
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Resolving Attributes
Several options are available in the Attribute dropdown list that determine how the attribute values will resolve in
the table. Refer to the Resolving Attributes topic for information on these selections.

Default Attribute
By using the inheritance feature of STEP, you can link an attribute higher up in the Tree to make it valid at the
appropriate points in the hierarchy, on particular object types. Insert the 'Default Value' at the top level and let it
inherit down. Then, if you need to change this value on some of the children, you can change the value. If later you

© Stibo Systems - Public - 2025.3 - September 2025 108



remove the overridden value, the default value will again populate.

To add a default attribute:

1. Click the ellipsis button ( ) to launch the Select Default Attribute dialog.

2. Locate the default attribute using either the Browse, Search, or Legal Attributes tab, then click OK. If an attribute has
previously been chosen and you want to remove it, click Select None.
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Transformation
There are numerous reasons to apply a transformation to an attribute in a table. One example would be if the attribute is
multivalued. You can then apply a transformation that specifies how to separate the values.

1. To apply an attribute transformation to the selected attribute, click the ellipsis button ( ) under Transformation.

2. Select the relevant transformation in from the Select Transformation dialog, then click OK.
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For more information about applying attribute transformations to table content, including initial setup, refer to
the Applying Attribute Transformations to Table Content topic.
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Attribute Group Attributes Content Definition
The Attribute Group Attributes definition enables you to select an entire group of attributes and add them to a table in
one operation. Each attribute will appear in its own column / row. For example, if you assign a column to an attribute
group that contains six individual attributes, six columns will be created in the table, unless limiting options are applied;
refer to the steps below for more information.

The Attribute Group Attributes content definition extracts all attributes in a group dynamically. Therefore, if new
attributes are added to the attribute group in System Setup after the table has been created, new columns or rows for
these attributes will be created dynamically.

1. In the Column/Row Content definition list, select Attribute Group Attributes.
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2. In the Pull dropdown list, select what content should be displayed for each attribute. Available options are:

Value & Unit

Unit & Value

Value

Unit

LOV Value ID

Convert to Base Value

Refer to the Resolving Attributes topic for information on these options.

3. Browse or search for the relevant attribute group using the Browse or Search tab.

4. To apply an attribute transformation, click the ellipsis button ( ) next to the Transformation field and choose the

relevant attribute transformation from the Select Transformation dialog.

For more information about applying attribute transformations to table content, including initial setup, refer to
the Applying Attribute Transformations to Table Content section.

5. Check Apply Recursively to apply the transformation.

6. Select Limit Attributes (to only Legal attributes and...) so that only specification attributes that have been made
legal for the specific products included in the table will be included as columns / rows in the table. Selecting this also
makes more limitations available.

© Stibo Systems - Public - 2025.3 - September 2025 113



7. Select Include Attributes from Classifications to include specification attributes that are inherited from
classifications.

8. Select Only non empty rows/columns so attributes values will not be included as columns / rows in the table.

9. In the Maximum number of rows/columns field, enter the maximum number of rows / columns to include. If left
blank, rows / columns will be created in the table for all attributes in the group, unless otherwise limited. For
example, if 'Only non empty row/columns' is checked, empty rows / columns will not be included, regardless.

10. From the Sort on list, select the relevant sorting attribute, or leave the default selection of Name to sort the rows /
columns alphabetically by attribute name. The list is composed of all description attributes in the system that have
been made valid on the Attribute object type and have a validation base type of Number. The below screenshot
shows a representative sample; the attributes will vary from system to system.

The recommended practice for this option is to create a special 'table sort' attribute that is exclusively used for
sorting rows and/or columns created using the Attribute Group Attributes content definition. For more
information, refer to the Controlling the Attribute Order in 'Attribute Group Attributes' topic.

11. Check Exclude if empty to include only attributes that have a sorting sequence entered. In other words, any
attributes (even if they have values entered) without a value in the selected sorting sequence metadata attribute will
NOT be displayed. If this box is not selected, the attributes without a value for the sorting sequence attribute will be
included at the end in alphabetical order.

12. Click OK. The Attribute Group Attributes definition is added.
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Composite Attribute Content Definitions
Composite attribute content definitions are applied to columns and rows in tables to dynamically pull information from
attributes within composite attributes that have been configured on product objects.

When a composite attribute content definition is used in a table, it is represented by the square icon pictured in the
below screenshot.

The available composite attribute definitions are:

Composite Attribute - All Attributes: Dynamically creates a row / column for each attribute within the composite
attribute type every time the table is rendered.

Composite Attribute - Single Attribute: Creates a single row / column for each attribute selected from the
composite attribute type.

Composite Attribute Values: Required to enable the two other composite attribute content definitions. I.e., if
'Composite Attribute - All Attributes' is placed in a column, then 'Composite Attribute Values' must be placed in a row
to return the values from the specified composite attribute type on the current object.

Note: Composite attributes are also known as data containers. As such, all configuration work for composite
attributes is performed on the Data Containers tab in the STEPWorkbench. For information on the setup and
configuration of composite attributes / data containers, refer to the Data Containers topic of the System Setup
documentation.
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Prerequisites
The following configuration instructions presume that you have already created a table definition on your product, and
that you are now defining the content definitions on a column or row. For more information on the preliminary steps of
adding content definitions, refer to the Adding, Editing, and Overriding Content Definitions topic.

Composite Attribute - All Attributes
The Composite Attribute - All Attributes content definition extracts the values from all attributes within the composite
attribute type defined on the product. A row or column is dynamically created for each attribute within the composite
attribute every time the table defined on the product is rendered.

The Composite Attribute - All Attributes content definition is a data selector. It is used to select the composite attribute
content provided by the Composite Attribute Values content definition, which is a data provider. For more information on
how data selectors and data providers are defined, refer to the Content Definitions topic.

To configure the Composite Attribute - All Attributes content definition, follow these steps.

1. In the Column/Row Content definition dropdown, select Composite Attribute - All Attributes.

2. In the Composite Attribute Type dropdown list, select the relevant composite attribute object type.

3. From the Pull list, select the relevant option for how to resolve the attribute value. Refer to the Resolving Attributes
topic for more information on the available options (e.g., Value & Unit).

4. In the Transformation field, click the ellipsis button ( ) to apply an attribute transformation to all values returned

from the composite attribute. For more information on adding attribute transformations to attributes in tables, refer to
the Applying Attribute Transformations to Table Content topic.
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5. Check Only non empty rows/columns to ensure that there are no empty rows or columns in the table if an attribute
is missing a value in the composite attribute.

6. In the Maximum number of rows/columns field, enter a number that corresponds to the maximum number of rows
or columns that should display. If left blank, all attributes within the composite attribute will display, unless otherwise
limited. For example, if 'Only non empty row/columns' is checked, empty rows / columns will not be included,
regardless.

7. From the Sort on list, select the relevant sorting attribute, or leave the default selection of Name to sort the rows /
columns alphabetically by attribute name. The list is composed of all description attributes in the system that have
been made valid on the Attribute object type and have a validation base type of Number. The below screenshot
shows a representative sample; the attributes will vary from system to system.

8. Check Exclude if empty to include only attributes that have a sorting sequence entered. In other words, any
attributes (even if they have values entered) without a value in the selected sorting sequence metadata attribute will
NOT be displayed. If this box is not selected, the attributes without a value for the sorting sequence attribute will be
included at the end in alphabetical order.

9. Click OK to complete the configuration.

Composite Attribute - Single Attribute
The Composite Attribute - Single Attribute content definition extracts the value of selected attributes within the
composite attribute. This definition is also a data selector, like the Composite Attribute - All Attributes definition.

To configure the Composite Attribute - Single Attribute content definition, follow these steps.
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1. In the Column/Row Content definition dropdown, select Composite Attribute - Single Attribute.

2. In the Composite Attribute Type dropdown list, select the relevant composite attribute object type.

3. From the Pull list, select the relevant option for how to resolve the attribute value. Refer to the Resolving Attributes
topic for more information on the available options (e.g., Value & Unit).

4. In the left window, select the attribute(s) that you want to display in the table, then click the right-facing arrow to add
the attribute(s) to the right window. To remove an attribute, select the attribute in the right window and click the left-
facing arrow. Each attribute you select will create an individual column or row in the table.

5. For Default Attribute, click the ellipsis button ( ). If a value is missing for any of the selected attributes, then it will

be populated with the value of the attribute chosen as the default attribute. The default attribute does not have to be
one of the attributes that has been selected to display in the table.
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6. Transformation: Click the ellipsis button ( ) button to apply a transformation to the selected attribute value(s). For

more information about applying attribute transformations to table content, refer to the Applying Attribute
Transformations to Table Content topic.

7. Click OK to complete the configuration.

Composite Attribute Values
Composite Attribute Values is a data provider content definition that is used to provide content for the Composite
Attribute - All Attributes and Composite Attribute - Single Attribute content definitions. Values are resolved where
the Composite Attribute Values content definition intersects with one of the other two composite attribute content
definitions.

To configure the Composite Attribute Values content definition, follow these steps.

1. In the Column/Row Content definition dropdown, select Composite Attribute Values.

2. In the Composite Attribute Type dropdown, select the relevant composite attribute type.

Note: This composite attribute type must be the same composite attribute type chosen in the intersecting
composite attribute content definition. If they do not match, the values will not resolve.

3. Click OK to complete the configuration.

Sample Composite Attribute Tables
The following two examples show resolved tables using the Composite Attribute - All Attributes content definition, in
conjunction with the Composite Attribute Values content definition. The first example uses a composite attribute type
that contains one data container, and the second example uses a composite attribute type with two data containers.

Example 1 - Composite Attribute With One Data Container

1. On the 'Corrugated Box' product, a composite attribute / data container type named 'Industry Standard B' has been
defined on the Data Containers tab. The composite attribute contains four attributes.
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2. The table definition contains one column and two rows. The Spec Column uses the Composite Attributes - All
Attributes content definition, configured to select values from the Industry Standard B composite attribute. The
Normal Row uses the Composite Attribute Values content definition, configured to provide values from the Industry
Standard B composite attribute. The Spec Header row uses the Attribute content definition to pull the STEP name of
the attributes within the composite attribute.

3. The table preview shows each attribute within the composite attribute in a separate column. No sort attribute was
provided, so the attributes are sorted alphabetically.

Example 2 - Composite Attribute With More Than One Data Container

1. On the 'Silicone Sealants' product, two composite attribute / data containers of the 'Industry Standard A' type named
have been defined on the Data Containers tab. Each composite attribute contains three attributes.
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2. The table definition contains one column and two rows. The Spec Column uses the Composite Attributes - All
Attributes content definition, configured to select values from the Industry Standard A composite attributes. The
Normal Row uses the Composite Attribute Values content definition, configured to provide values from the Industry
Standard A composite attributes. The Spec Header row uses the Attribute content definition to pull the STEP name
of the attributes within the composite attribute.

3. The table preview shows each attribute within the composite attribute in a separate column. Since there are two
data containers within the composite attribute, two rows display. No sort attribute was provided, so the attributes are
sorted alphabetically.

Considerations and Limitations
The following considerations and limitations should be kept in mind when working with composite attribute content
definitions in tables:

Since tables cannot be resolved on entities in STEP, this functionality only applies to composite attributes / data
containers on products.

Composite attribute content definitions will only resolve on the current object.
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Composite attribute values, once mounted onto InDesign pages using Publisher, cannot be written back to STEP
from within InDesign.

Composite attribute rows / columns cannot be expanded within the table definition. For example, a composite
attribute with four attributes will always be represented by a single row / column in the table definition, and cannot be
expanded to show four separate rows.
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Legal Attributes Content Definition
The Legal Attributes content definition limits the number of available attributes to specification attributes that are legal
on the selected object. It also enables additional limitation and sorting options.

1. In the Column/Row Content definition list, select Legal Attributes.

2. Select Include Attributes from Classifications to include attributes from classifications.

3. Select Only non empty Rows/Columns to resolve only attributes with values.

4. In the Maximum number of Rows/Columns field, enter the maximum number of attributes to be resolved.

5. From the Sort on list, select the relevant sorting attribute, or leave the default selection of Attribute Name to sort the
rows / columns alphabetically by attribute name. The list is composed of all description attributes in the system that
have been made valid on the Attribute object type and have a validation base type of Number. The below
screenshot shows a representative sample; the attributes will vary from system to system.

6. Check Exclude if empty to include only attributes that have a sorting sequence entered. In other words, any
attributes (even if they have values entered) without a value in the selected sorting sequence metadata attribute will
NOT be displayed. If this box is not selected, the attributes without a value for the sorting sequence attribute will be
included at the end in alphabetical order.

7. Click OK when configurations are complete.
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Resolving Attributes
The following options are available in the Attribute dropdown list that determine how the attribute values will
resolve in the table. This list is titled Pull in the Legal Attributes and Attribute Group Attributes content definitions.

1. Value & Unit - Attribute values and units are resolved with values (1, below) resolved before units (2, below).

2. Unit & Value - Attribute values and units are resolved with units (1, below) resolved before values (2, below).
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3. Value - Only values are resolved. If the values also have a unit, the unit will not be resolved.

4. Unit - Only units are resolved. Attribute values will not be resolved.

5. LOV Value ID - The IDs of the LOVs will be resolved.

Example before LOV value ID resolve:

Example after LOV value ID resolve:

6. Convert To Base Value - This will resolve and give the result of the base value. In the below example, two value
units—g (gram) and kg (kilogram)—are used in the ItemWeight column. When using the Convert to Base Value
option, the values will be converted to grams.

Example before Convert to Base Value resolve:
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Example after Convert to Base Value resolve:
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Controlling the Attribute Order in 'Attribute Group Attributes'
Understanding the control mechanisms available for the Attribute Group Attributes content definition in tables will
help explain why you need to create a special 'table sort' description attribute to control the order of rows and/or
columns created dynamically from an attribute group.

Though a standard 'attribute display sequence' attribute can be used to sort table rows and columns created from
an attribute group, this approach is not ideal when different attribute sequencing is needed for different product
categories. Due to this, a special 'table sort' attribute should be created to control the sequencing.

The steps in this topic assume the following:

You have created a table type and legalized it

You have created a table and are creating a column / row content definition of 'Attribute Group Attributes' (refer to
the Attribute Content Definitions topic for more information)

You have an understanding of how to create and populate attributes
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Creating a Table Sort Description Attribute
1. In System Setup, navigate to the attribute group in which you would like to create the new description attribute, then

right-click and select New Attribute.

2. In the Create Attribute dialog, give the attribute an ID and Name (for example, 'Table Sort Order'), then select
Number for Validation Base Type and No for Multi Valued.

3. Select Description, then click Next.

4. Click Next two more times to bypass the screens for steps 3 and 4 of the wizard. (No validation rules or units are
needed for this attribute.)

5. In step 5 (Valid For), expand the Valid for Link Types flipper and check the Product attribute validation box. (Also
check Classification attribute validationif you intend to link any of your attribute group attributes to a classification.)
Click Next two more times to skip to step 7 (Link to Hierarchy).

6. Link to the Primary Product Hierarchy, then click Finish.

Populating Values for the Table Sort Attribute
Before the 'table sort' attribute can be used in your table, it must contain values. There are three ways to populate
values for this attribute:

1. Manually enter values on the References tab of the relevant specification attributes within the attribute group that is
being used in the table

2. Manually enter values on the References tab of the product(s) used in the table (values may be entered at a higher
level of the product hierarchy in order to inherit to products below)

3. Import values using a STEPXML file
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Note: Because the 'table sort' attribute is not valid for the Attribute object type (unlike a standard 'display
sequence' attribute used to sort attributes in the workbench), the table sort attribute cannot be modified from
the Attribute tab of the attributes that are being used in the table.

It is recommended to initially set a sequence by using 10, 20, 30, and so forth. To add attributes in between later,
you can then use 15, 25, 35, etc.

Editing from the Attribute Group

1. In System Setup, navigate to the attribute group that you intend to use in your table, then select the attribute inside
the group that you would like to edit. (Only one attribute at a time can be edited using this method.)

2. On the References tab, expand the Valid in Products flipper.

3. Enter values for the table sort attribute. Values may be different for the different levels of the product hierarchy to
which the attribute is linked.

Editing from the Product Hierarchy

1. In the Tree, navigate to the level (node) of the product hierarchy where you would like to populate the table sort
attribute.

2. On the References tab, expand the Linked Attributes from Product Hierarchy flipper.

3. Insert the relevant values for the table sort attributes. Multiple attributes can be populated at once from this view.
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If all tables in a particular product category (node) should contain the same column / row sequencing, then values for
the 'table sort' attribute should be populated at the highest level of the category in order to inherit to objects below.
However, inherited values for the 'table sort' attribute cannot be overridden at a lower level of the hierarchy unless the
attribute group attributes are linked to the lower level or values for the table sort attribute are imported through a
STEPXML import. For more information on linking attributes to nodes within the product hierarchy, refer to the Linking
Specification Attributes section of the System Setup documentation.

Editing by STEPXML Import

When the attribute group attributes are linked to a higher level (node) of the product hierarchy, the field for the sort
attribute on the References tab is yellow on lower levels of the product hierarchy. This means that the table sort
order cannot be edited from this lower level, as shown in the following screenshot.
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The field can become editable if the relevant specification attributes are linked to the level of the hierarchy where
you need to set the value of the table sort attribute. However, if this is not possible or not practical, a STEPXML
load will allow you to edit the table sort attribute value on all object(s) where the specification attributes are valid,
whether that was where they were linked or where the link has inherited to. In other words, this STEPXML load will
allow you to enter values into the yellow fields without having to manually relink the specification attributes to
various locations throughout a product hierarchy.

The following is sample XML that could be used to import a value into a metadata 'table sort order' attribute. The ID of
the table sort attribute in the following example is TableSortOrder.

<?xml version="1.0" encoding="utf-8"?>

<STEP-ProductInformation ImportContext="English US" ContextID="Context1"

WorkspaceID="Main" UseContextLocale="false">

<Products RejectNewProducts="true">

<Product ID="121168" UserTypeID="Level2" ParentID="121166"> <!--Sample node in the

product hierarchy-->

<Name>Party Hats</Name>

<AttributeLink AttributeID="BaseUnitOfMeasure"> <!--Category-specific specification

attribute linked to the node in the hierarchy-->

<MetaData>

<Value AttributeID="TableSortOrder">100</Value> <!--Table sort description attribute

with value of 100-->

</MetaData>

</AttributeLink>

</Product>

</Products>

</STEP-ProductInformation>
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Product Content Definitions
Most content definitions used in tables are Product content definitions. A common table setup (for a horizontally read
table) uses attribute content definitions for columns and product content definitions for rows.

Product content definitions can be applied to pull information from individual products or classifications, from the
children or parents of these products / product-overrides / classifications, and more. The available product content
definitions are:

Current Object

First SubProduct, Classification

First SubProduct, Family

Node Reference

Parent

Parent Name

Product/Classification/Asset

SubProducts, Classification

SubProducts, Family

Note: Any content definition that applies to products also applies to product-overrides.

In all the images that follow, a drop down for row type is shown. The types will be different if adding a column.

Current Object
The Current Object content definition resolves to the object on which the table is extracted. You cannot point a current
object row to a specific object. If you, for example, mount a table on the product 123-123 in InDesign, the current object
resolves to 123-123.

In a horizontally read table, a current object row type is typically used with Attribute or Asset Reference column types to
display selected attributes for the products in the rows.
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First SubProduct, Classification
The First SubProduct, Classification content definition will extract the first product or product family from either a
specified classification node or dynamically from where the table is defined.

1. Select Local Classification to pull the information dynamically from the node on which the table is resolved.

2. Select Specify to choose a specific node in the classification hierarchy. This makes the content definition static, i.e.,
information from the specified classification will be pulled regardless of the node on which the table is resolved.

3. If Specify is chosen, use the Browse or Search tab to either browse to or search for the relevant classification.
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4. In the Classification Level field, specify the level from where the products should be extracted. For example, if you
select a product group with three levels below, you can specify 1 - 4 depending on how many levels you want to
view.

5. To also include the intermediate levels, check the Include Intermediate Levels box.

6. If you only want the first subproduct of a particular object type to appear, select the object type from the Object Type
dropdown list.

7. Click OK to add the definition

Example

8. The first screenshot below shows how the content definition looks on the table on the Definition tab. The second
screenshot shows the table on the Preview tab, which is only pulling the first subproduct.

First SubProduct, Family
The First SubProduct, Family definition will insert the first child product under the family into the table. If you are
already on the lowest level in the node, no product will show up in the table.

You are allowed to indicate at which level the products should be extracted and also if the intermediate levels should be
included. You can also specify which Object Types should be extracted.
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1. Select Local Product to pull the information dynamically from the node on which the table is resolved.

2. Select Specify to choose a specific node in the product hierarchy. This makes the content definition static, i.e.,
information from this specified product will be pulled regardless of the node on which the table is resolved.

3. If Specify is chosen, use the Browse or Search tab to either browse to or search for the relevant product.

4. In the Level field, enter specify the level from where the products should be extracted. For example, if you select a
product group with three levels below, you can specify 1 - 4 depending on how many levels you want to view.

5. To also include the intermediate levels, check the Include Intermediate Levels box.

6. If you only want the first subproduct of a particular object type to appear, select the object type from the Object Type
dropdown list.

7. Click OK to add the definition.

Example

The first screenshot below shows how the content definition looks on the table on the Definition tab. The second
screenshot shows the table on the Preview tab, which is only pulling the first subproduct.
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Node Reference
The Node Reference will insert a row or column in the table that resolves a reference for a product, classification,
or asset.

© Stibo Systems - Public - 2025.3 - September 2025 136



1. For Resolve, choose Product, Classification, or Asset from the dropdown list.

2. Based on the selection you made from the Resolve drop down list, choose a reference type from the Select
Reference Type dropdown.

3. Enter a Reference number to determine how many of the references to show. This field is only relevant if there is
more than one object referenced with the selected reference type. To resolve all references, either leave the field
empty or enter 0.

4. Browse or Search for the object from which you want to extract the reference(s). Click OK.

Parent
Pulls information from a Parent object. Enter a number in the Level field to determine how many levels up in the
hierarchy to go to locate the parent.

Parent Name
The Parent Name content definition extracts the name of the parent product of the selected product.

The parent name that is displayed comes either from the product or the classification hierarchy. Because product can
be linked to both a product hierarchy and a classification hierarchy, the parent name depends on whether the product
was inserted as a classification or a product.
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To apply a transformation to the parent name value, click the ellipsis button ( ) in the Transformation field. For more

information about applying attribute transformations to data in tables, refer to the Applying Attribute Transformations to
Table Content topic.

Example

The first screenshot below shows the table on the Definition tab, with the Parent Name content definition applied in the
last column. The second screenshot shows how the table looks resolved, on the Preview tab. The object name is
extracted in the first column (1), and the names of the objects' parents are extracted in the fourth column (2).

© Stibo Systems - Public - 2025.3 - September 2025 138



Product/Classification/Asset
The Product/Classification/Asset content definition enables you to select a specific product, classification, or asset. This
selection is not dynamic; the content selection remains the same regardless of where the table is resolved.

In a horizontally read table, a Product/Classification/Asset row type is typically used with Attribute column types. For
example, if you want to display the name of the object or selected attributes on the object.

If you select an asset, the asset itself (e.g., image) is not displayed in the target cells. However, if using the Attribute
content definition for the column, you can display the name or the ID of the asset in the cell(s). Likewise, if you select a
classification, you can let the target cells display the name or ID of the classification.

1. In the 'Column/Row Content definition' list, select Product/Classification/Asset.

2. Browse to or search for the relevant product, classification or asset. Click OK. Multiple objects can be selected by
holding Ctrl or Shift while making selections. Individual rows / columns will be created for each selected object.

3. The following is an example of a product object in a row, with Attribute content definitions in the columns pulling the
Name and ID of the product.
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Referenced Node
The Referenced Node content definition extracts values from a referenced product, classification or asset.

If the product that you have created the table on has a product reference to another product, adding a Referenced Node
row type enables you to extract values from the referenced product. For example, a product 'AAA-100' has a product
reference to another product, 'AAA-200.' The reference type is 'Accessory Optional.' Creating a table on 'AAA-100' with
a row type 'Referenced Node' will allow you to extract values from 'AAA-200.'

Note: Using Reference node in tables will only bring you the referenced products from the current node. You
will not be able to fetch the subproduct(s) referenced products using this functionality.

1. Select the relevant object type from the Resolve list. The available options are Product, Classification, and Asset.

2. From the Select Reference Type list, select the relevant reference type.

3. In the Reference Number field, specify the number of the reference type to resolve. This field is only relevant if there
is more than one object referenced with the selected reference type. To resolve all references, either leave the field
empty or enter 0.
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Example

In the below example, the table will be resolved on the 'Heels - High: 3" or higher' product object. On the
References tab, three products are linked from a different folder using the 'Accessory Optional' reference type.

A very simple table has been built that will pull the name of the objects that are linked using the Accessory
Optional content definition.

The resolved table lists the names of the referenced objects.
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SubClassifications, Classification
The SubClassifications, Classification content definition works identically to the 'Subproducts, Classification'
definition, except this definition displays sub-classifications instead of subproducts. Refer to the following
subsection, 'SubProducts, Classification' for more information.

SubProducts, Classification
The SubProducts, Classification content definition extracts all products that are children within a specific classification,
either manually from a specific level in the classification hierarchy, or dynamically from where the table is defined.
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When you have selected a level in a classification, a row is inserted in the table for each product that the classification
contains. So, if a classification contains three products, three rows are added to the table, unless filtering options such
as object type are applied (refer to steps below for more information).

In a horizontally read table, a Subproducts, Classification row type is typically used with Attribute or Asset Reference
column types. You can, for example, use the Attribute column type to display selected attributes for the products in the
rows.

1. Select Local Classification to extract the product families dynamically. The subproducts are added to the table
depending on where the table is extracted.

2. Select Specify to choose a specific classification from where to extract the product families. This selection is static,
and remains the same regardless of where the table is extracted.

3. Search or Browse for the relevant classification.

4. In the Classification Level field, specify the level from where the products should be extracted. For example, if you
select a product group with three levels below, you can specify 1 - 4 depending on how many levels you want to
view.

5. To also include the intermediate levels, check the Include Intermediate Levels box.
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6. If you only want the first subproduct of a particular object type to appear, select the object type from the Product
Object Type dropdown list.

7. Click OK to add the definition

Example

The first screenshot below shows the Subproducts, Classification content definition on the Definition tab. The
second screenshot shows the resolved table on the Preview tab, with one subproduct per row.

SubProducts, Family
Use this when you want to extract all products contained within the selected level in the product hierarchy.

The Subproducts, Family content definition extracts product families either manually from a specific level in the product
hierarchy or dynamically from where the table is defined.

When you have selected a level in the product hierarchy, a row is inserted in the table for each product that the product
level contains. So if a product level (family) contains three products, three rows are added to the table, unless filtering
options such as object type are applied (refer to steps below for more information).
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In a horizontally read table, a SubProducts, Family row type is typically used with Attribute or Asset Reference column
types, for example, if you want to display selected attributes or images for the products in the rows.

1. Select Local Product to extract the product families dynamically. The subproducts are added to the table depending
on where the table is extracted.

2. Select Specify to select a specific product level from where to extract the product families. This selection is static,
and remains the same regardless of where the table is extracted.

3. Optionally, enter the Level from where you want the products to be extracted. This refers to the number of nested
subfolders downward in the hierarchy. For example, if 2 is entered for Level, then the objects mounted in the table
will be pulled from two levels below where the table is built.
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4. If you want the intermediate levels to be included as well, click the Include Intermediate Levels checkbox.
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5. Optionally, select an object type from the Object Type list, to limit the number of extracted products to a specific
object type.

Additional Example

The first screenshot below shows the Subproducts, Family content definition on the Definition tab. The second
screenshot shows the resolved table on the Preview tab, with one subproduct per row.
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Asset Content Definitions
Two content definitions are used to display assets in STEP Tables: Asset and Asset Reference. In most cases, assets
that are displayed in tables are images.

Asset
Use the Asset content definition to point to a specific asset. This is not a dynamic content type.

The Asset definition is most often used at the cell level in combination with the Cell Override setting. This is because, if
applied to an entire column or row, an identical image will appear in every cell across the row or column. Asset cells
take priority over any selection that has been made at the row or column level with the exception of Free Text. For more
information on the Cell Override setting, refer to the Adding, Editing, and Overriding Content Definitions topic.

Applying the Asset Content Definition to a STEP Table Row or Column

1. With your table open on the Definition tab, Right-click in the content definition cell on the column or row that you
would like to edit, then click Edit. (In the following screenshot, the content definition cell has a preexisting content
definition of ).

2. In the 'Row/Column Type & Content Definition dialog,' select Asset from the Column/Row Content definition list.
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3. Browse or search for the preferred asset, and then click OK. Only one asset may be selected.

4. The Content Definition of the row or column is now set to Asset. The STEP Name of the asset (e.g., TruckIcon)
appears in the Content Definition cell on the Definition tab.

5. The selected asset is visible in the table, both on the Definition tab and the Preview tab.
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Asset Reference
The Asset Reference content definition is also typically used to insert images into table cells. However, unlike the Asset
content definition, which only allows the selection of a specific asset, the Asset Reference content definition is a
dynamic content type.

The Asset Reference content definition is used to insert assets that are linked to products, classifications, or product-
overrides by an asset Reference Type.

In a horizontally read table, the Asset Reference content definition is typically used in a table column in conjunction with
one or more table rows that use one of the following content definitions:

Current Object

SubProducts, Classification

SubProducts, Family

Product/Classification/Asset

Applying the Asset Reference Content Definition to a STEP Table Row or Column

1. With your table open on the Definition tab, right-click in the content definition cell on the column or row that you
would like to edit, then click Edit. (In the following screenshot, the content definition cell has a preexisting content
definition of ).
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2. In the Row/Column Type & Content Definition dialog, select Asset Reference from the Column/Row Content
definition list.

3. Select the relevant reference type from the Select Reference Type list, (for example, Primary Product Image).

4. Check Extract All to extract all referenced images of the selected type. This is only relevant if the product,
classification, or product-override object has multiple images referenced using the same Reference Type. If there
are multiple images referenced, all of the images will be inserted into the same table cell.

5. Click OK.

6. The content definition of the row or column is now set to Asset Reference. The STEP Name of the asset reference
type (e.g., Primary Product Image) appears in the content definition cell on the Definition tab.
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7. The referenced images / assets appear in the table on the Preview tab.
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Commercial Data Content Definitions
Commercial Data content definitions enable you to reference commercial data from a publication version in a table.
Three content definitions are available for commercial data:

Commercial Data

Commercial Data Aspect

Date Spread Commercial Data

Commercial Data
The Commercial Data content definition is used to extract values from commercial terms lists.

1. In the 'Column/Row Content definition' list, select Commercial Data.

2. From the next dropdown list, select the commercial list that you want to include in the table.
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3. In the Break-point No field, enter the value of the break-point number of the term that you want to reference.

4. Select the relevant term type from the available types (Name, ID, Price, etc.).

5. To apply an attribute transformation to the resolved commercial data, click the ellipsis button ( ). in the

Transformation field. A common transformation for commercial data is to add a currency symbol before the prices,
e.g., $ or €.

For more information about adding attribute transformations to data in tables, refer to the Applying Attribute
Transformations to Table Content topic.

Example

The following table has a Commercial Data content definition in the last column.

The resolved table displays the pricing values.
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The three products mounted in the table pull their values from the 'Acme Party Winter Retail Pricing' list.

This list is connected to the English US Version of the Acme Party Supplies catalog.
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The pricing is viewed in the resolved table by selecting the Acme Party Supplies/English US version from the
'Select version' dropdown list on the tables Preview tab.

Commercial Data Aspect
The Commercial Data Aspect content definition is used to extract a value from a terms list that is not in the Value field.
The following aspects can be extracted:

Start Date

End Date

Minimum Quantity

Maximum Quantity
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When pulling a date, this definition can display, for instance, the name of a weekday without having to store this
weekday explicitly in STEP.

Important: For the Commercial Data Aspect content definition to work, you must apply the 'Date Spread
Commercial data' content definition in an opposite row or column.

1. In the 'Column/Row Content definition' list, select Commercial Data Aspect.

2. In the Value To Extract list, choose 'Start Date' or 'End Date' to pull a date value. Choose 'Minimum Quantity' or
'Maximum Quantity' to pull a quantity value.
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3. If you chose Start Date or End Date in the Value to Extract list, select the relevant aspect from the Date Aspect
dropdown. This is not relevant if you selected Minimum Quantity or Maximum Quantity.

Date aspects resolve as follows:

Date Aspect Renders

MM-DD-YYYY 06-11-2025

Day 6

Month 11

Month Name November

Short Month Name Nov

Weekday Thursday

Short Weekday Thu

Year 2025

Date Spread Commercial Data
The Date Spread Commercial data content definition enables you to pull multiple commercial data values from a single
product. For example, if a single product has multiple prices for different time periods, a corresponding number of rows
with these prices can be created dynamically.
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For each product in a table, Date Spread Commercial data pulls all values (typically prices) from the commercial list and
sorts them by time periods. For each time period, a row is created dynamically.

Important: It is not possible to make Date Spread Commercial data rows and columns non-dynamic.

1. From the 'Column/Row Content definition' list, select Date Spread Commercial data.

2. Select the commercial list that contains the terms you want to include in the table, then click OK.
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Modifying Tables
This topic explains how to make changes to cells, rows, and columns in a table. Also described is how to add, delete,
and resequence columns and rows; copy and paste columns, rows, and cells; and how to span or merge multiple table
cells.

This topic assumes that you have already built your table and have it open with the Definition tab selected.

Add Rows and Columns
You can create columns and rows before the current column or row or as the final (end) row or column of the
table.

Add Row Before

1. Right-click inside of the content definition cell ('Local,' in the below example) or the number of the row (row 2 in the
example below) that you would like to add a new row before, then click Add Row Before.

2. The Row/Column Type & Content Definition dialog displays.
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3. In the Column/Row Type list, select the relevant row type.

4. In the Column/Row Content definition list, select the relevant content definition.

5. Click OK to add the row. In the below example, a row type of Normal and a content definition of Free Text was
chosen.

Add Row at End

1. Right-click inside of the content definition cell or the number of any row in the table, then click Add Row at End.
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2. Follow steps 2 - 5 in the previous section to add the row.

Add Column Before

1. Right-click inside of the content definition cell or the number of the column where you would like to add a new
column before, then click Add Column Before.
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2. Follow steps 2 - 5 from the 'Add Row Before' section above to add the column.

Add Column at End

1. Right-click inside of the content definition cell or the number of any column in the table, then click Add Column at
End.
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2. Follow steps 2 - 5 from the 'Add Row Before' section above to add the column.

Duplicate Rows and Columns
1. Right-click inside of the content definition cell or the number of the column where you would like to add a new

column before, then click Add Column Before and select Duplicate.
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2. A duplicate of the row or column appears directly beneath the source row / to the right of the source column.

Remove Rows and Columns
Right-click inside of the content definition cell or the number of the row / column that you want to remove, then
select Remove Row or Remove Column.
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Expand Rows and Columns
This option only applies to rows or columns with the following dynamic content definitions:

SubProducts, Classification

SubProducts, Family

Attribute Group Attributes

When you expand a column or row, the column or row is no longer dynamic. The content of the column or row remains
as it is even if more products are added to the product family.

Note: You cannot expand dynamic rows created using the 'Date Spread Commercial data' content definition.

1. Right-click inside of the content definition cell or the number of the row / column that you want to expand, then select
Expand.
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2. Click Ok in the 'Expand row' / 'Expand column' dialog.

3. The dynamic row / column is expanded into individual non-dynamic rows. The below example shows a table defined
on a product family object with three child objects. Once expanded, the table contains three individual rows for each
child product. If another product is added to the family, a new row will not be automatically created.
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Change the Sequence of Columns and Rows
Columns and rows can be resequenced within a table using drag and drop.

1. Select the column or row that you want to move by clicking on its number.

2. Drag the column or row to its new location.

Span Cells
Two or more cells may be merged into one by using the span option. When cells are spanned, the cell in the upper left
corner will span the full area and overwrite content in all other cells in the spanned area.
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1. Select the cells that you want to span, either by holding your left mouse button and dragging your cursor across the
cells, or by holding Ctrl or Shift while clicking on the cells.

2. Right-click, and then select Span.

3. The cells are now spanned.

Remove Spans

Right-click anywhere within the spanned area, then click Remove Span(s).
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Applying Attribute Transformations to Table Content
An attribute transformation performs a task on an attribute such as inserting a prefix or converting periods to commas.
There are numerous reasons to apply a transformation to an attribute in a table, but some additional use cases include
removing a space between numbers and units and specifying how to separate values if there are multivalued attributes
in the selected attribute group.

Transformations can be applied to rows, columns, or cells that use any of the following content definitions:

Attribute

Attribute Group Attributes

Commercial Data

Composite Attribute - All Attributes

Composite Attribute - Single Attribute

Parent Name

This topic explains how to apply preexisting attribute transformations to data in tables. For more information on how to
create and configure an attribute transformation, refer to the Attribute Transformations section of the System Setup
documentation.

To Apply Attribute Transformations
1. Follow the steps in the Adding, Editing, and Overriding Content Definitions topic to open the Row/Column Type &

Content Definition dialog for your row or column.

2. In the 'Column/Row Content Definition' dropdown list, select one of the relevant content definitions mentioned in the
introductory section of this topic (e.g., Attribute, Attribute Group Attributes, etc.). For this example, Attribute has
been selected.

© Stibo Systems - Public - 2025.3 - September 2025 172



3. In the Transformation field, click the ellipsis button ( ) to display the Select Transformation dialog. The top

section of the dialog lists the 'Attribute Specific' transformation(s), e.g., transformations that have been applied to
the attribute.
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The bottom section of the dialog lists the 'Global' transformations, which are transformations that have nothing
selected under the 'Applies To' flipper on the Attribute Transformation tab. Having no options selected allows
these transformations to be global and not limited in where they can be used.
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4. Select the relevant attribute transformation from the list, then click OK. The transformation is applied to the selected
attribute.

To Remove Attribute Transformations

In the 'Select Transformation' dialog, click Select None.
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Basic Attribute Transformation Example for a Table Column
This example uses an attribute transformation that appends a text value of -A to the STEP ID.

The attribute transformation has been applied to the ID in System Setup.
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Because the transformation has been specifically applied to something (in this case, ID), the transformation appears in
the upper half of the Select Transformation dialog, and not at the bottom with the global transformations.

Table before applying the transformation:
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Table after applying the transformation:

Advanced Attribute Transformation Example for a Table Column
The following example shows a more advanced attribute transformation that can be applied to a table column to change
all codes (STEP IDs) that start with the letter 'D' to all caps and a red text color. This example combines the following
STEP functionalities:

A STEP style tag that utilizes an InDesign character tag in its output formatting. For more information, refer to the
Publication Template Layout, Formatting, and Styles topic in the Publisher (Adobe InDesign Integration)
documentation.

A regular expression. For more information, refer to the Regular Expression section of the Resource Materials
online help documentation.

Sample Setup

1. First, create a style tag in System Setup that is configured to output red text. The tag in this example corresponds to
a character style in the publication template named 'red,' which is called out in the output formatting within the
InDesign tag <CharStyle:red>.
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2. Next, create an attribute transformation in System Setup intended to transform the STEP ID to upper case.

3. Click Add Transformation to add a second transformation using 'Replace substrings of the value using a regular
expression.'

4. Configure this second transformation as follows:
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Replace first match of

(D.+)

with <red>$1</red>

5. Apply this transformation to a table column that contains STEP IDs, following the steps outlined in the first section of
this topic.
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Table Header Attributes - Recommended Practice
Creating a description attribute that is valid on attributes—and exclusively used for creating table header values—is a
recommended practice when generating table headers. Using this type of attribute is a more flexible and dynamic way
to generate table headers instead of using non-dynamic free text or cumbersome transformations to change an attribute
name into a value suitable for a table header. Free text is too easily removed or edited by a workbench user, and
language translation is difficult to set up and maintain.

In addition, such an attribute can be used in product templates if table headers must be placed onto the template
instead.

The instructions in this topic assume the following:

You have created a table and understand how to define content definitions.

You have an understanding of how to create and populate attributes.

Example Table Using a Table Header Attribute
In this basic example, the table has four columns containing specification attributes, each with a content definition of
Attribute. The header row is using a content definition of Meta Data Attribute.

The values in the header row—Name, Color, Summary, and Details—are populated by the values of a description
attribute named 'Table Header.' This attribute is valid on the Attribute object type.

If attribute 'Name' were used instead of 'Table Header' for the header row's content definition, then the names of the
attributes would be pulled for the values instead—Product Name, Primary Color, Short Item Description, and Long Item
Description. In all likelihood, these would not be the preferred values for the column headers.

Creating a Table Header Description Attribute
1. In System Setup, navigate to the attribute group in which you would like to create your attribute, then right-click and

select New Attribute.

2. In the Create Attribute dialog, give the attribute an ID and Name (for example, 'Table Header'), then select Text for
Validation Base Type and No for Multi Valued. Click Next.

© Stibo Systems - Public - 2025.3 - September 2025 181



3. Provide a Maximum Length that aligns with the typical number of characters currently used as a column header in
step 3 (Enter Validation Rule). This will probably be around 30 or 40 characters rather than the default 100.

4. Click Next two more times to bypass the screens for steps 4 and 5 of the wizard. (As this attribute will only be valid
on attributes, there is no need to make it valid on product types. However, you may later make it valid on additional
objects if a need arises.)

5. In step 6 (Apply Dimension Dependencies), choose Country and/or Language if you want the values of this attribute
to be translatable.

6. Click Finish. No additional steps are needed, as this is a description attribute valid only on attributes.

Applying Attribute Validity to the Table Header Attribute
1. Next, navigate to the Attribute object type, located in System Setup > Object Types & Structures > Basic Object

Types > Attribute Group > Attribute.

2. On the Object Type tab, expand the 'Valid Attributes' flipper, then click Add Attribute.

3. In the dialog that displays, browse to or search for the table header attribute that you just created, then click Select.

4. The table header attribute is now valid on attributes.

© Stibo Systems - Public - 2025.3 - September 2025 182



Populating Values for the Table Header Attribute
Now that the table header attribute is valid on attributes, it appears under the Description flipper on all attributes.

1. In System Setup, navigate to the specification attributes that you will be using in your table.

2. Locate your table header description attribute, then enter the value that you would like to appear as the table header
for this attribute.

3. In the following screenshot, a value of 'Summary' has been entered as the value for 'Table Header' on the attribute
named 'Short Item Description.'
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4. Now, on the table, the value of 'Summary' appears as the header for the 'Short Item Description' column.
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Table Transformations
Table transformations are used to manipulate the content and appearance of a table. A table transformation can
perform operations on an entire table or part of a table, such as applying color to certain rows or merging cells with
equal values. Transformations are added and configured on the tables Preview tab, allowing their effects on the table to
be viewed in real-time.

For a list of all available transformations, refer to the List of Transformations topic.

General Transformation Information
When you use transformations, be aware of the following:

Most transformations are applied in a two-step process: First you add the transformation, then you modify the
parameters.

Transformations are cumulative, which means that you can add a range of transformations to your table. The
transformations are executed in the sequence they are listed, and a transformation takes effect upon the result of
the previous transformation. To change the sequence of transformations, you can drag and drop a transformation
row to a new location.

Transformations can impact the table formatting such as the text style or background color of a row or column. In
some cases, you may have to set the formatting on the transformation as well.

Adding Transformations
You can apply table transformations locally in the product or classification hierarchy of the Tree, and/or globally in
System Setup. Any transformation added globally can be overridden later at the local level

Local transformations are added on the Preview tab of the selected table on the Table tab.
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Global transformations are added in the Default Transformations area on the Table Type tab.
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Important: You can only change the sequence of table transformations on a table type from the table type
itself in System Setup. When you change the sequence of transformations on the table type, it affects all tables
that are based on the table type.

Add a Transformation to a Table or Table Type
The following steps describe how to add transformations to an individual table. However, the process for adding
transformations to a table type is similar, except that you add the transformation on the table type in System Setup.

1. With the relevant table open on the Preview tab, click Add Transformation.

2. In the Select Transformation dialog, select the preferred transformation, then click OK.
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3. For most transformations, additional parameters will need to be configured. These additional parameters are
described in the following sections of this documentation topic.
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Modify Transformation Parameters
1. Return to the Preview tab and locate the transformation that you want to configure.

2. Click inside of the Parameters field to display the ellipsis button ( ).

3. Make the desired changes, and then click OK. Parameters are different for every transformation, and are described
in detail in the following topics of this documentation section.

Remove a Transformation
1. Click the arrow in front of the transformation that you want to remove, then click Remove Transformation.
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Copy and Paste a Transformation
To save effort, transformations can be copied and pasted. To copy and paste to a different table means that the
transformation does not have to be created again from scratch. To copy and paste within the same table could also be
useful since transformations are applied accumulatively and sequentially. For example, a Remove Empty
Rows/Columns transformation might be applied to remove empty rows or columns, then another transformation applied
later removes additional values that create new empty rows or columns. So, the Remove Empty Rows/Columns
transformation would need to be applied again, below the transformation that created new empty rows / columns.

1. Click the arrow in front of the transformation that you want to remove, then click Copy Transformation.

2. Click on an arrow by a different transformation, either on the same table or a different table, then click Paste
Transformation.

Note: To paste a transformation to a different table, at least one transformation must already exist on the
target table.
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3. The pasted transformation will be placed adjacent to the transformation where you clicked to paste.
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List of Transformations
The below tables list the transformations available in STEP for tables. Each transformation is described in further detail
in the related online help topic referenced below.

Layout Transformations

Transformation Description Related Topic

Apply Alternate Row
Colors

Shades alternate rows according to a specified frequency. Layout
Transformations

Repeated Rule Inserts specified rule styles as top and bottom borders of a
row.

Rule When Different Inserts a specific rule style for a specific type of content.

Sorting Transformations

Transformation Description Related Topic

Sortings Sorts the rows in a table according to the specified settings. Sorting Transformation

Formatting Transformations

Transformation Description Related Topic

Attribute
Formatting
Transformations

Applies a transformation to a specific attribute. Formatting
Transformations

Cell Formatting Formats cells with specific content.

Row/Column Text
Formatting

Applies text formatting to a specific column or row. The transformation
also calculates, replaces, and applies prefixes and suffixes to values.

Tab Formatting Inserts a tab stop in a row or column.
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General Transformations

Transformation Description Related Topic

Assign
Row/Column
Types to
Rows/Columns

Allows users to assign row and/or column types to fixed row / column
numbers. This functionality is primarily intended for use after a Pivot
Transformation has been applied.

Assign
Row/Column
Types to
Rows/Columns

Delete Table if
Only Headers or
Footers

Checks if all of the current rows or columns in a table are designated as
Headers or Footers, i.e., if they are designated as anything other than
Normal. If either all rows or all columns are headers or footers, then the
entire table is deleted.

Delete Table if
Only Headers or
Footers

Fold Table Divides a table into two or more side-by-side tables where the content
flows across the tables.

Fold Table

Footnote
Transformation

Controls how footnotes are displayed in a table. Footnote
Transformation

Horizontal Fold
Table

Splits a wide table into two or more vertical 'folds' based on a designated
number of folds.

Horizontal Fold
Table

Horizontal Wrap
Table

Splits a wide table into two or more vertical 'wraps' based on a specified
column type.

Horizontal Wrap
Table

Make Header
Row from
Column

Transforms column content into subheadings. Make Header
Row from Column

Merge Equal
Cells

Merges adjacent cells with identical values. The transformation merges
equal cells in the entire table or in specific rows or columns. Both
horizontally and vertically adjacent cells are merged.

Merge Equal
Cells

Merge Equal
Rows/Columns

Merges consecutive rows or columns if they have identical data. Merge Equal
Rows/Columns

Merge Over
Empty Cells

Merges row or column contents with empty cells. Use this transformation
when you want to span dynamically created cell content.

Merge Over
Empty Cells
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Transformation Description Related Topic

Merge
Rows/Columns

Merges the content of the specified rows or columns. Merge
Rows/Columns

Move Units
to Header

Enables a header row or header column to be built from unique units that
appear on values inside the table. If all units are they same within the
column or row, they are removed from the values and then moved into the
new or existing header row / header column.

Move Units to
Header

Pivot
Transformation

Creates a pivot table that allows you to summarize and analyze the data in
your table independent of the original data layout of your table.

Pivot Table
Transformation

Remove Attribute
Rows/Columns in
Group

Removes all attributes that belong to a specific attribute group. Remove Attribute
Rows/Columns in
Group

Remove Empty
Rows/Columns

Removes empty rows or columns. The entire row or column must be
empty.

Remove Empty
Rows/Columns

Remove
Rows/Columns

Removes a specific row or column. Remove
Rows/Columns

Row/Column
Consolidation

Consolidates consecutive rows or columns that are identical except for
the values in one designated row or column. The values in those cells
corresponding to the designated row or column are merged.

Row/Column
Consolidation

Suppress
Rows/Columns

Suppresses a row or column if a specified string matches a value in the
selected column or row.

Suppress
Rows/Columns
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Layout Transformations
When you add a transformation, you typically need to specify parameters for the transformation to work. The following
layout transformations are available and are defined in the sections below:

Apply Alternate Row Colors

Repeated Rule

Rule When Different

Prerequisites
The instructions in the following subsections assume that you have already added the specified transformations to your
table by following the instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table
Transformations topic.

Alternate Row Colors
The Alternate Row Colors transformation alternates the background shading of rows at a specified frequency; for
example, every other row, every two rows, etc.

Example

In this example, every other row is shaded Light Blue.
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Steps

1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Alternate Row Colors dialog

displays.

© Stibo Systems - Public - 2025.3 - September 2025 196



2. In the Restart count after Headings list, select either Ignore Headings, 1, or 2. Selecting 'Ignore Headings' will
actually include headings in the row shading. For example, if the Normal Color is blue and the Alternate Color is
white, then the header row will be shaded blue if 'Ignore Headings' is selected.

Selecting 1 will cause the row shading to start with the normal row(s) that appear directly below Heading (1)
rows. Selecting 2 will cause the row shading to start with the normal row(s) that appear directly beneath Sub
Heading (2) rows.

Check Ignore Footers to prevent row colors from being applied to Footer rows.

3. In the Normal Colored Rows field, enter the number of rows to shade in the Normal Color before shading rows with
the Alternate Color.

4. In the Alternate Colored Rows field, enter the number of rows to shade in Alternate Color before shading rows with
the Normal Color again.

In the table example shown at the beginning of this topic, 1 has been selected for both the Normal and
Alternate options.

© Stibo Systems - Public - 2025.3 - September 2025 197



5. In the Normal Color list, select the relevant color.

6. In the Alternate Color list, select the relevant color.

7. Click OK.

Note: For a more complex level of control over the appearance of alternate-colored rows in lengthy, split tables
with multiple repeated headers, the Alternating row colors settings available in the Header Repeating
Pagination Plugin may be a better option than using the Alternate Colored Rows transformation. For more
information, refer to the Header Repeating Pagination Plugin topic.

Repeated Rule
The Repeated Rule transformation inserts a specified line style based on table rules; for example, a rule line of a
certain width is added at a specified frequency.

Example

In the below example, a 2 pt rule line is added every two rows.

Steps

1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Repeated Rule dialog

displays.

© Stibo Systems - Public - 2025.3 - September 2025 198



2. From the Restart Heading Level list, choose either None, 1, or 2. The default setting is None, meaning that no line
style is inserted at the heading level. When you select 1 or 2, the line style is applied again after each header row of
the specified level number.

3. Check Restart when other rule found to reset the count when another line style is found in the table.

4. In the Add rule per rows field, enter a relevant number of rows to put in a line style.

5. From the Rule Above list, select the relevant line style to be used as the top border of the row.

6. From the Rule Below list, select the relevant line style to be used as the bottom border of the row.

7. Click OK.

Rule When Different
The Rule When Different transformation will automatically inserts a rule style when column contents are changed.

Example

In this example, a 3 pt rule line is added every time a value in the Size column changes, so a 3 pt rule surrounds all size
S rows, all size M rows, etc. This is how the table looks before the transformation:
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After the transformation:
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Steps

1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Rule When Different dialog

displays.
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2. Select Ignore Headings if you do not want the transformation to consider contents in Heading columns types.

3. Select Override Cell Settings to have the applied rule override any existing rule settings on affected cells. This
setting ensures that a horizontal rule will be applied across all columns of a row when the 'Rule When Different'
transformation is applied after a Pivot Transformation.

4. In the Column field, click the ellipsis button ( ) to display the Select Column dialog.

Select Attribute to apply the transformation to the column that contains the specified attribute. Click the ellipsis
button ( ) to search or browse for the relevant attribute.

Select Product/Classification/Assetto apply the transformation to the column that contains the specified object.
Click the ellipsis button ( ) to search or browse for the relevant object.

Select Heading to identify the column by typing the header text of the relevant column.

Select Type to choose a specific column type from the dropdown list.
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Select Number to identify the column by entering the sequence number of the relevant column. For example, to
apply the transformation the second column, type 2.

Select Group to apply the transformation to a group or columns and/or a range of columns, then click the Setup
button.

Click Add in the Select Row/Columns to be grouped dialog to add columns to the group individually.

After clicking Add, an Undefined field displays. Click the ellipsis button ( ) to launch another Select

Column dialog. This is identical to the previous 'Select Column' dialog, except without the Group option.

Click Add again to repeat the previous steps and add more columns to the group. Click OK.

To add a Range of columns to the group, click Add Range.
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Enter the starting and ending column numbers in the Column From and To fields. Click OK. To enter a
range that will contain the remainder of the table if columns are added later, enter a larger number in the 'To'
field such as 5999. Note that these fields can only contain integer values.

4. From the Rule Below list, click the relevant Line Style to be used as the bottom border of the row.

5. Click OK.
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Sorting Transformation
Only one sorting transformation, Standard Sorting, exists for tables. The Standard Sorting transformation enables you
to sort the rows in your table according to the contents of one or more columns.

Example

In this example, the table includes a listing of T-shirt sizes in S, M, L, XL, XXL, and XXXL. Two Size columns are
present. One lists the T-shirt sizes, and the second contains numbers that correspond to the sizes—1 for S, 2 for M, etc.
This is so an ascending sort can be applied to sort the T-shirts from smallest to largest size (S, M, L, XL, etc.) instead of
alphabetically (M, L, S, XL, etc.)
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The Standard Sorting transformation is added to the second Size column (in this example, column 7) to sort the
rows by ascending numbers.
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To finish the look of the table, a Remove Rows/Columns transformation is added to remove the sort column, so the
finished table has the rows sorted by S, M, L, etc. Refer to the Remove Rows/Columns topic for more information on
this transformation.
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Steps

1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Standard Sorting dialog

displays.

2. Click Add Sorting Row/Column to display the sorting priority options.
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3. In the Heading Rows field, enter the number of heading rows that you want to exclude from the sorting
transformation.

4. In the Trailing Rows field, enter the number of trailing rows that you want to exclude from the sorting transformation.

5. In Undefined, click the ellipsis button ( ). The Select Row/Column dialog displays.

Select Row or Column to specify whether the transformation applies to a row or a column.

Select Attribute to apply the transformation to the row or column that contains the specified attribute. Click
the ellipsis button ( ) to search or browse for the relevant attribute.

Select Product/Classification/Assetto apply the transformation to the column that contains the specified
object. Click the ellipsis button ( ) to search or browse for the relevant object.

Select Heading to identify a column or row by typing the header text of the relevant column or row.

Select Type to identify the column or row by selecting Column Type or Row Type.
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Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then type 2.

Click OK.

6. Check Ascending to sort the rows in ascending order.

7. Select Alphabetic, Numeric, or Fraction to specify the sorting type.

8. Click Add Sorting Row/Column again to add another row or column to sort on, if needed.

9. Click OK.
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Formatting Transformations
Formatting transformations enable you to apply transformations to attribute values, rows, column, tabs, and cells. The
following formatting transformations are available and are defined in the sections below:

Attribute Formatting Transformations

Cell Formatting

Row/Column Text Formatting

Tab Formatting

Prerequisites

The instructions in the following subsections assume that you have already added the specified transformations to your
table by following the instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table
Transformations topic.

Attribute Formatting
The Attribute Formatting transformation allows you to apply an attribute transformation to any selected attribute in the
table. These transformations perform tasks on an attribute such as calculating or replacing a value, or applying a prefix
or a suffix.

Example
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The below column samples show how attribute values look before applying the transformation (left) and how they look
after (right). The applied attribute transformation inserts the text 'Made of' before the attribute values for 'Material.'

Steps

1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Attribute Formatting dialog

displays.

© Stibo Systems - Public - 2025.3 - September 2025 212



2. Search or browse for the attribute to which you want to apply a transformation. Alternatively, click on the Legal
Attributes tab to access the specification attributes linked locally to the product / classification node on which your
table is built.

3. Click Add Transformation to launch the Select Transformation dialog. Select the relevant transformation, and then
click OK.

The list of transformations is identical to those that are available when creating an attribute transformation in
System Setup. For more information on the attribute transformations and what they do, refer to the
Transformations topic in the Resource Materials online help documentation.

Three transformations to perform cell-level text transformations are also available within the list of
transformations: 'Sort values within cells,' 'Range consolidation within cells,' and 'Remove duplicate values
within cells.' For more information on these transformations, refer to the Cell Text Formatting Transformations
topic.
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Cell Formatting
The Cell Formatting transformation allows you to narrow down formatting to individual cells in a table.

Example

This example uses two Cell Formatting transformations—one to change cells containing the word 'Blue' to have a light
blue background and bold text, and the second to change cells containing the text 'Royal Blue' to a darker blue color,
retaining the bold text applied in the first Cell Formatting transformation.
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Steps

1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Cell Formatting dialog

displays.
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2. In Search Expression, enter a regular expression to find specific cells. This option is case sensitive. For example:

Enter the search expression 'Blue.' The value Blue is searched in the entire table and, if the value matches, the
specified style will be applied to the cell.

Enter the search expression as [A-Z]. The characters A to Z will be searched and, if any matches are found, the
specified style will be applied to the cell.

For more information on regular expression and practical examples, refer to the Regular Expression topic in
the Resource Materials online help documentation.

3. Check the Only for rows/columns box if you want the formatting to apply only for cells in specific rows or columns.

4. If you selected Only for rows/columns, then click the ellipsis button ( ) to launch the Select Row/Column dialog.
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Select Attribute to apply the transformation to the row or column that contains the specified attribute. Click the
ellipsis button ( ) to search or browse for the relevant attribute.

Select Product/Classification/Assetto apply the transformation to the row or column that contains the specified
object. Click the ellipsis button ( ) to search or browse for the relevant object.

Select Heading to identify the row or column by typing the header text of the relevant row or column.

Select Type to choose a specific row or column type from the dropdown list.

Select Number to identify the row or column by entering the sequence number. For example, to apply the
transformation to the third column, type 3.

Select Group to apply the transformation to a group of rows / columns and/or a range of row / columns, then click
the Setup button.

Click Add in the Select Row/Columns to be grouped dialog to add rows or columns to the group
individually.

After clicking Add, either a Row or Column field displays, depending on whether you are selecting a
row or column. Click the ellipsis button ( ) to launch another Select Row/Column dialog. This is

identical to the previous 'Select Row/Column' dialog, except without the Group option. Click OK after
making your selection.
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Click Add again on the 'Select Row/Columns to be grouped' dialog to repeat the previous steps and
add more columns to the group. Click OK when done.

To add a Range of columns to the group, click Add Range.

Enter the starting and ending column numbers in the Column From and To fields, then click OK when
done. To enter a range that will contain the remainder of the table if rows or columns are added later,
enter a large number in the 'To' field such as 5999. Note that these fields can only contain integer
values.

4. In the Color to apply list, select the color you want to apply to the cells, or leave the default option of 'Do not change
background color.'

5. In the Style to apply list, select the style that you want to apply to the cells, or leave the default option of 'Do not
change text style.'

6. Click OK.
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Row/Column Text Formatting
The Row/Column Text Formatting transformation enables you to transform data in specific columns or rows. You can
calculate or replace values or apply prefixes and suffixes to values in entire columns and rows in one operation. Where
the Attribute Formatting transformation is applied to a specific attribute, the Row/Column Text Formatting
transformation enables you to transform data in columns and tables of your own choice.

1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Row/Column Text Formatting

dialog displays.

2. Select Ignore Headings if you want the transformation to ignore contents in header column types.

3. Click the ellipsis button ( ) to launch the Select Row/Column dialog.

The options available in this dialog have already been explained in this topic in the Cell Formattingsection
above; refer to that section for more information.

© Stibo Systems - Public - 2025.3 - September 2025 219



4. Click Add Transformation to launch the Select Transformation dialog.

The list of transformations is identical to those that are available when creating an attribute transformation in
System Setup. For more information on the attribute transformations and what they do, refer to the
Transformations topic in the Resource Materials online help documentation.

Three transformations to perform cell-level text transformations are also available within the list of
transformations: 'Sort values within cells,' 'Range consolidation within cells,' and 'Remove duplicate values
within cells.' For more information on these transformations, refer to the Cell Text Formatting Transformations
topic.

5. Select the relevant transformation, then click OK.

Tab Formatting
The Tab Formatting transformation inserts a tabulator in a row or column, which indents the text in the row or column
with a tab.

Example

The below screenshot shows how a column looks before (left) and after (right) applying the transformation, which in this
example inserts a tab before the values in the 'Color' column.
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Steps

1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Tab Formatting dialog

displays.

2. Select Ignore Headings if you want the transformation to ignore contents in header column types or header row
types.

3. Click the ellipsis button ( ) to launch the Select Row/Column dialog. The options available in this dialog have

already been explained in this topic in the Cell Formatting section above; refer to that section for more information.
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4. Click OK.
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Cell Text Formatting Transformations

Three cell text formatting transformations are available that can sort values, consolidate ranges, and remove duplicate
values within table cells. These are:

Sort values within cells

Range consolidation within cells

Remove duplicate values within cells

Note: Though these text transformations also appear in the list of transformations available for attribute
transformations created in System Setup, they are only used to transform content within table cells. As such,
they serve no purpose for attribute values that display outside of tables. For more information on other attribute
transformations and what they do, refer to the Transformations topic in the Resource Materials online help
documentation.

Sort values within cells
The Sort values within cells text transformation is used to sort multiple values when they are contained within a single
table cell. It is available as a selection under 'Add Transformation' within the Attribute Formatting and Row/Column
Text Formatting table transformations, as shown below:

Entries within a cell may be sorted alphabetically, numerically, or by fractional values, and in ascending or
descending order. Since the sorting affects multiple values within a single cell, a separator (value delimiter) must
be placed between the values to differentiate them. If a hard return should separate the entries in a cell, the
delimiter of \n should be used.

Examples

The following examples use the pipe character (|) as the delimiter:
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The value string '2002|2007|2005|2012' becomes '2002|2005|2007|2012' when sorted using the Ascending and
Numeric options.

'A|C|H|B|G ' becomes 'A|B|C|G|H' when sorted using the Ascending and Alphabetic options.

'DC7|DC9|DC13|DC12|DC5|DC6' becomes 'DC5|DC6|DC7|DC9|DC12|DC13' when sorted using the Ascending
and Numeric options.

The following example shows a table in which this transformation will be applied to sort values in ascending
alphabetic order using the '/ ' delimiter. As shown in the field with the ellipsis button, the transformation has been
selected to apply to cells within the 'Engine Series' column.

Before the transformation is applied, the values in the Engine Series column (column 5) display in non-alphabetical
order, e.g., AL / AJ / AG / AH / AM / AK / AU.
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After the transformation is applied, the values display in alphabetical order, e.g., AG / AH / AJ / AK / AL / AM / AU.

Remove duplicate values within cells
The Remove duplicate values within cells text transformation is used to remove duplicate values when they are
contained within a single cell of a table. Like the 'Sort values within cells' transformation, it is available as a selection
under 'Add Transformation' within the Attribute Formatting and Row/Column Text Formatting table transformations,
as shown below:

This transformation is useful when consecutive rows in a table have been consolidated into one row. When this is
done, the resultant row will often have cell entries of merged data that require some cleanup and/or consolidation.
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Duplicates are removed by specifying a value delimiter. For example, using the pipe character (|) as the delimiter,
the string 'DC9|DC9|DC7|DC12|DC9|DC7' becomes 'DC9|DC7|DC12'. If a hard return separates the entries in a
cell, the delimiter of \n should be specified.

Example

The following example shows a table with two adjacent rows that contain identical information except for in one column
(Engine series, column 5).

After a Row Consolidation transformation is applied, the value 'ED' appears twice in the Engine Series column.
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To remove this duplicate value, the 'Remove duplicate values within cells' transformation is applied as part of the
Row/Column Text Formatting transformation. It is configured to remove values from the Engine Series column
that are separated by the ' / ' delimiter.

After the transformation is applied, the duplicate 'ED' values are removed and consolidated into a single value.
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Range consolidation within cells
The Range consolidation within cells text transformation is used to consolidate ranges of data that might exist within a
single cell of a table. Like the 'Sort values within cells' and 'Remove duplicate values within cells' transformations, it is
available as a selection under 'Add Transformation' within the Attribute Formatting and Row/Column Text Formatting
table transformations, as shown below:

As part of the consolidation process, the transformation allows users to provide delimiter characters to be used
between values, as follows:

Value Delimiter: Users may enter one or more characters to indicate the delimiter between the entries in a cell. If a
hard return separates the entries in a cell, the delimiter of \n should be used.

Range Delimiter: Users may enter one or more characters that denote the delimiter. This delimiter is used when
ranges are created as the result of this operation. A range can be created that is ascending (low-to-high) or
descending (high-to-low). Example: 2007-2012 or 2012-2007 if a numerical range, and A-F or F-A for an alphabetic
range.

The following examples assume the value delimiter is the pipe character (|) and the range delimiter is a hyphen (-):

The string '2002|2003|2004|2005|2006|2007' becomes '2002-2007'

'2015|2014|2013|2012' becomes '2015-2012'

'A|B|C|F|G|H' becomes 'A-C|F-H'

'2002|2003|2004|2005|2007|2008' becomes '2002-2005|2007-2008'

Note: This transformation only operates on numbers or single characters in the ASCII range 'A to Z' or 'a to z.'
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Example

The following example shows a table in which a cell contains a range of values after a Row Consolidation
transformation has been applied. The values are both unsorted and separated by '\\ ' as a delimiter.

To sort these values and convert them into a range, two transformations are applied. The Sort values within cells
text transformation is first applied to sort the numbers in ascending numeric order. Next, Range consolidation
within cells is applied, which has been configured to remove the \\ value delimiters and replace them with 'to.'

After the transformations are applied, the values are consolidated into a range.
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General Table Transformations
The general table transformations are defined in detail in the following topics in this documentation section.

Assign Row/Column Types to Rows/Columns

Delete Table if Only Headers or Footers

Fold Table

Footnote Transformation

Horizontal Fold Table

Horizontal Wrap Table

Make Header Row from Column

Merge Equal Cells

Merge Equal Rows/Columns

Merge Over Empty Cells

Merge Rows/Columns

Move Units to Header
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Pivot Table Transformation

Remove Attribute Rows/Columns in Group

Remove Empty Rows/Columns

Remove Rows/Columns

Row/Column Consolidation

Suppress Rows/Columns
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Assign Row/Column Types to Rows/Columns
The 'Assign Row/Column Types to Row/Column Numbers' table transformation allows users to assign row and/or
column types to fixed row / column numbers. This functionality is intended for use after a Pivot Transformation has
been applied.

Though available for any table created in STEP, this transformation is especially useful for tables created for the
PMDM for Automotive solution. These tables tend to be very structured, using a consistent number of columns
with the same attributes in the same order, and have fixed column widths. The number of columns can be quite
high—15 or more columns is not unusual. It is also very common that the Pivot Transformation is required in these
tables.

The Pivot Transformation does not allow for the assignment of so many different column types to the 'common
values' columns. This transformation solves this issue by allowing users to assign column types to these columns
after the Pivot Transformation. Further, it can define the designation of header row types instead of using the Pivot
Transformation.

Prerequisites
The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example
The following example shows a table in which this transformation will be used to apply two different column types to four
different columns (columns 7, 8, 9, and 10).

Before the transformation is applied, the columns have no background shading:
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The transformation has been configured to apply the 'Primary PartNo Column' column type to columns 7 and 8 and
the 'Secondary PartNo Column' column type to columns 9 and 10.
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The Primary PartNo Column type has a 'Red Tint' background and the Secondary PartNo Column has a 'Silver'
background.

After the transformation is applied, columns, 7, 8, 9, and 10 reflect the styles of the applied column types.
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Additional Configuration Information
To configure the Assign Row/Column Types to Row/Column Numbers transformation:

1. After adding the transformation, click the ellipsis button ( ) under Parameters to display the Assign Row/Column

Types to Rows/Columns dialog.

2. In the dialog, Row is selected by default. Click Add new row to choose a row number to which you would like to
assign a row type.

3. Click Add to select the row or column to which you would like to assign a new row or column type.
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4. Under Rows/Columns, click the ellipsis button ( ) to select the row(s) or column(s) that you want to replace with a

different row or column type.

5. In the Select Row/Column dialog that displays, choose from the following options. The most common selections for
this transformation will be to enter a row or column Number or a range of rows or columns (selected under the
Group option).

Select Attribute to apply the transformation to the row or column that contains the specified attribute. Click the
ellipsis button ( ) to search or browse for the relevant attribute.

Select Product/Classification/Assetto apply the transformation to the row or column that contains the specified
object. Click the ellipsis button ( ) to search or browse for the relevant object.

Select Heading to identify the row or column by typing the header text of the relevant row or column.

Select Type to choose a specific row or column type from the dropdown list.
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Select Number to identify the row or column by entering the sequence number. For example, to apply the
transformation to the third column, type 3.

Select Group to apply the transformation to a group of rows / columns and/or a range of row / columns, then click
the Setup button.

Click Add in the Select Row/Columns to be grouped dialog to add rows or columns to the group
individually.

After clicking Add, either a Row or Column field displays, depending on whether you are selecting a
row or column. Click the ellipsis button ( ) to launch another Select Row/Column dialog. This is

identical to the previous 'Select Row/Column' dialog, except without the Group option. Click OK after
making your selection.

Click Add again on the 'Select Row/Columns to be grouped' dialog to repeat the previous steps and
add more columns to the group. Click OK when done.

© Stibo Systems - Public - 2025.3 - September 2025 238



To add a Range of columns to the group, click Add Range.

Enter the starting and ending column numbers in the Column From and To fields, then click OK when
done. To enter a range that will contain the remainder of the table if rows or columns are added later,
enter a large number in the 'To' field such as 5999. Note that these fields can only contain integer
values.

6. To add additional rows, click Add new row. Click OKwhen finished.

7. If you are working with columns instead, choose Column, then follow the same steps outlined above for selecting
rows.
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Delete Table if Only Headers or Footers
The Delete Table if Only Headers or Footers transformation checks if all of the current rows or columns in a table are
designated as Headers or Footers, i.e., if they are designated as anything other than Normal Row in the System Setup
for Rows and Columns. If either all rows or all columns are headers or footers, then the entire table is deleted.

This transformation is used when prior transformations, such as Remove Rows/Columns or Remove Empty
Rows/Columns, have been applied to the table, leaving only header rows and/or footer rows. Since the table no longer
has any relevant content, it should not be mounted on an InDesign page. By removing the remaining headers and/or
footers, the entire table is removed and nothing is output to InDesign.

This transformation can be applied both on rows and columns. It requires no additional configuration, and has no
additional functionality other than deleting the table.

Prerequisites
The instructions in this topic assume that you know how to add a transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example
In the following basic example, a transformation that removes all 'Normal rows is first applied, then the Delete Table if
Only Headers or Footers transformation is applied.

Before

This is how the table appears on the Definition tab. It has one Header row and five Normal rows.
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Before the transformation to remove all Normal rows is applied (Remove Rows/Columns), the table looks like this:

After applying the Remove Rows/Columns transformation, all that remains of the table is the Header.
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After

After applying the Delete Table if Only Headers or Footers transformation, the remainder of the table (the Header row)
is deleted, leaving nothing.
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Fold Table
The Fold Table transformation enables you to split a table into two or more equal table columns. The transformation
breaks the table so that the content flows from one column to the next. This is useful if you have a very tall table and
would like to convert it to a shorter, more horizontally defined table.

Important: Rows in the table align over the folded table and space in between rows is divided evenly. If the
number of rows does not divide fully with the number of folds, empty rows are added at the end of the last fold.
This means that if there is an uneven number of rows, Fold 2 will have one less row than Fold 1.

Prerequisites
The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example

Before

Before the Fold transformation is applied, the table is very tall and vertically oriented.
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After

After the Fold transformation is applied, the table is horizontally oriented, with two folds.
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Steps
1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Fold Tabledialog displays.

2. Select Repeat All Heading 1's at top and/or Repeat Last Heading 2 depending on whether one or two table
headings need to be repeated in the next fold.

3. Protect against orphans. and Orphans to Move: 'Orphan' is a typographical term that refers to a paragraph-
opening line that appears by itself at the bottom of a page or column, thus separated from the rest of the text. The
same concept applies to 'orphaned' rows in folded tables. Sometimes a 'Normal' (non-header) row end up by itself
on a fold when the headers are repeated, causing it to be orphaned.

Check 'Protect against orphans' to move any orphaned rows, and in the 'Orphans to move' field, enter the
number of orphans that should be moved.
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4. In the Folds field, enter the desired number of folds. Click OK. The minimum number of folds is 2.

5. Click OK.
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Footnote Transformation
The Footnote transformation enables you to control how footnotes are displayed in a table and create a specified footer
row for footnotes.

For tables with uncomplicated footnotes, a typical standard setup is to keep the footnotes in separate text boxes
below the table on the product template, driven by a regular footnote text attribute, as pictured below. This works
well when footnotes apply to the entire table in general. It may also be easier to set up and maintain.

However, the table footnote transformation is often a better option when there are multiple footnotes in a table.
The transformation also provides these advantages:

Automatic superscript for footnote markers (e.g., superscript 1, 2).

The setup is more dynamic; footnotes are embedded within attribute values and do not have to be stored in separate
footnote attributes.

Footnote numbering is dynamic; users do not have to manually enter superscript numbers into attribute fields,
avoiding the possibility of numbers being incorrectly sequenced.
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Footnotes may be added into a free text cell of a table, again avoiding the need for separate footnote attributes.

Footnotes are placed in a dedicated, spanned row at the bottom of the table, which is an advantage when using
folded tables.

Creating the Footnote Tag
If no footnote tag exists, you must create one in System Setup. For more detailed information on how to create tags,
refer to the Tags section of the System Setup documentation.

Follow these steps to configure a footnote tag.

1. Go to Tags under system setup and select the Footnotes tag group. Right-click and create a new Footnote tag.

The footnote tag should not have any output formatting. It is merely needed for the system to set up the
transformation. If the tag is not created, 'Insert Footnote' will be disabled when you want to add a footnote to an
attribute value.

2. If the same long text is used many times throughout a catalog, you can create the footnote text as a character tag
that you can insert in all the places where you want to use the text. This tag will be created as a regular character
tag, not as a footnote tag, though it will be used in conjunction with the footnote tag (i.e., it is not a replacement for
the footnote tag). Creating the footnote text as a character tag will ensure that the text is consistent (e.g., always
spelled correctly).

Note: It is not necessary to create a footnote text character tag if the text is different on all footnotes.

Add Footnote Texts to an Attribute Value
Before you can add the footnote transformation, you first have to add footnote text to an attribute value.
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Note: Do not add footnotes to attributes that may later be extracted for a publication index, e.g., a part number
attribute.

1. Navigate to the product In the Tree that has the attribute to which you would like to add a footnote. This must be a
text-based attribute.

2. Double-click the attribute value field to edit it, then place your cursor in the location where you want to add the
footnote.

3. Right-click and select Insert Footnote.

4. In the Insert Footnote dialog, choose the relevant Footnote tag from the Footnote type dropdown list.
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5. In the Footnote field, enter the footnote text as either free text or as a character tag, then click OK. The footnote text
can also be styled in this dialog.

6. The footnote symbol (1) displays in the attribute field.

Note: If the same free text footnote is used for different products in same table, the footnote symbols are the
same for all footnotes. If the text does not match 100 percent, then different footnote symbols are displayed.

7. Repeat these steps for all attributes to which you would like to add a footnote.
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Edit or Remove a Footnote

1. If you need to edit the footnote, place your cursor before or after the footnote symbol in the attribute field, then right-
click and select Edit Footnote.

2. To delete the footnote, delete the footnote symbol from the attribute field.

Setting Up the Table
1. Create a footnote row type for your table in System Setup. In this step you are only creating the row type; you will

not create the footnote row on the table itself. The footnote transformation will later 'fetch' the row and insert it for you
as part of the transformation functionality. Then, you can apply styling to the row type if desired.

The row must be designated as Footer for the transformation to work properly.

Important: This row type must only be used for footnotes.

2. Navigate to the table in which you want to add the footnote, then view the table on the Preview tab.

3. If the footnotes were added correctly in the attribute fields, the footnote symbols in the table are displayed.
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Adding the Footnote Transformation
1. With your table open on the Preview tab, click 'Add Transformation' to launch the Select Transformation dialog.

2. Expand the 'Transformations' folder and select Footnote Transformation, then click OK.
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3. The Footnote Transformation is added. Click inside of the Parameters field to display the ellipsis button ( ).
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4. Click the ellipsis button ( ) to launch the Footnote Transformation dialog.

5. Select the Footnote Tag from the dropdown list. This must be the same footnote tag used when you added the
footnote text to the attribute value.

6. Select the relevant Footnote Row Type from the list.

7. In the Start below column field, specify the column where the footnote row should begin below. This is typically
column 1, then the row spans all columns.

8. In the Footnote separator field, specify the separator to be used in between multiple footnotes when mounted in
InDesign. This applies when different footnote texts with the same footnote tag are found in the same table. In this
example, the character tag <LineBreak/> tag is used, though any separator may be used.
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Note: The field does not recognize the repeat separators that are used in InDesign, such as \n.

Example

<LineBreak/> tag in System Setup:

<LineBreak/> footnote separator in table preview:
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Mounted footnote row in InDesign:

9. In the Footnote Marker field, specify how to mark the footnotes in the table; for example, 1, 2, 3, 4, 5. It does not
matter whether or not spaces are added after the commas. When all footnote markers have been used in the same
table, the numbers / characters start over from the beginning. These values display as superscript characters by
default, without needing to have styling applied.

Example

Footnote markers in table preview:
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Mounted footnote row in InDesign:

Leaving the field blank will mount superscript numbers with a closing parenthesis character after them, which may
not always be desirable.

10. Click the Style Settings button to specify a style for the footnote text and/or additional styling for the footnote row,
such as background color, alignment, borders and so forth. The following screenshot shows the result when 'italic' is
chosen as the footnote text style.
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Using Characters Other Than Digits as Footnote Markers

To use characters other than digits as footnote markers, special characters or character tags, right-click inside of
the Footnote Marker field of the Footnote Transformation dialog.
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Footnote markers for each desired symbol must be placed into the field. Multiple footnote markers must be placed
in this field if multiple footnotes are anticipated. If only one marker is placed in the box, it will only be used for
footnote 1, and subsequent footnotes will revert to the '2)' style.

Example
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Footnotes Based on Calculated Attribute Values
You can use footnotes based on calculated attribute values to handle new symbols in front of order numbers and
generate footnote text below the tables that contain the new symbols.

1. Create a calculated attribute using the following value template for the calculation. For information on how to create
a calculated attribute, refer to the Calculated Attributes section of the System Setup documentation

In this example, the calculation does the following:

If the brand name is Acme pens, then the attribute value is "Acme pens” with a footnote sign. The footnote sign
is defined as: <RegistrationFoot><FootnoteRegistration/></RegistrationFoot> where the tags are:

<RegistrationFoot> and </RegistrationFoot>: The footnote tag types. There is a start and an end tag.

<FootnoteRegistration/>: The character tag that defines the output of the footnote text.

2. Make the calculated attribute valid for the part of the product hierarchy where you want the calculated attribute to
result in table footnotes.
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Horizontal Fold Table
The Horizontal Fold Table transformation is used to 'fold' wide tables that contain a large number of columns into a
taller, vertically oriented table. Users may have a need for the Horizontal Fold Table transformation if the table is so
wide that it either cannot fit within a single InDesign page column or page, or if a vertical layout is desired.

This transformation works similarly to the 'Horizontal Wrap Table' transformation (documented in the Horizontal Wrap
Table topic), as both facilitate the ability to 'fold' a wide table into multiple table sections ('folds' or 'wraps') that stack on
top of one another. However, unlike the Horizontal Wrap Table transformation, a table folded using the Horizontal Fold
Table transformation is folded based on a designated number of folds, not on particular column types. This
transformation is also similar to the Fold Table transformation (documented in the Fold Table topic), except the Fold
Table transformation takes a table that is very tall and folds it over into a horizontally oriented table.

Though there are many combinations of configurations that can be applied within the transformation, the following two
screenshots show a sample 'before' and 'after' of a table (as previewed within the workbench) after applying the
Horizontal Fold Table transformation.

Example
Before

After
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Prerequisites
In order to take full advantage of this transformation, the table should meet these conditions:

Required

The table has a minimum of three columns

Optional

Though not required to use the transformation, tables using the Horizontal Fold Table transformation typically use at
least one column type of Heading (1) and/or Sub Heading (2).
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Important: Columns in the table align over the split table and space in between column is divided evenly. i.e.,
the width of the each column and in each fold will have the same measurement.

This topic assumes the following:

You have already built the table to which you will be applying the Horizontal Fold Table transformation. Instructions
on how to build the table itself are not provided in this topic; refer to the Creating Tables documentation for more
information.

You have already designated which columns should be used as the header(s) and/or subheader(s). This topic does
not describe how to designate columns as such; for information, refer to the Creating Column Types topic.

Applying and Configuring the Horizontal Fold Table Transformation
For this topic, the example table has eight columns, two of which are headers (a header column and subheader
column), and the remainder of which are 'Normal Row' columns. (Even though the setting is Normal 'Row,' this
setting applies to both rows and columns and means that the column / row is not used as a header, a subheader,
or a footnote column / row.)
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The Preview of the table looks like this before any transformations are applied:

To apply the Horizontal Fold Table transformation:

1. In the Tree, navigate to the product, classification, or product-override object that contains the table to which you
would like to apply the transformation, then click the Tables tab.

2. Select the table type to which you would like to apply the transformation, then click the Preview tab.

3. Beneath the table preview, click 'Add Transformation' to display the Select Transformation dialog.

4. Select the Horizontal Fold Table transformation, then click OK to apply the transformation.
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5. Next, the transformation itself must be configured. Click the ellipsis button ( ) on the transformation to launch the

Horizontal Fold Table configuration dialog.
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6. The options within the Horizontal Wrap Table transformation dialog and their functions are as follows. The options
are described in the logical order in which they are typically selected.

Folds: In the Folds field, enter a number to designate how many times the table should be folded. The following
screenshot shows a preview of the table with (3) entered in this field.

Repeat All Heading 1's at left.: Check this box to repeat all Heading (1) columns at the beginning of each wrap.
The below example shows how this table looks with the settings configured as follows:
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Repeat Last Heading 2: Check this box to repeat the last subheader column at the beginning of each wrap. A
typical setup includes only one header and one subheader column. The below example shows how this table
looks with the settings configured as follows:
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Protect against orphans. and Orphans to Move: 'Orphan' is a typographical term that refers to a paragraph-
opening line that appears by itself at the bottom of a page or column, thus separated from the rest of the text. The
same concept applies to 'orphaned' columns in folded tables.

Sometimes a 'Normal' (non-header) column can end up by itself on a fold when the headers are repeated, causing
it to be 'orphaned,' as such:
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Note: Number of folds takes precedence over orphan protection, so this option is more of a 'protect if
possible' option. In addition, this option only works when Sub Heading (2) columns are repeated; it will not
work if only Heading (1) level columns are repeated.

For the table pictured in the previous screenshot, ticking 'protect against orphans' will move the orphaned column
(Sale Price) up to the previous fold so it is no longer by itself. For this configuration, (1) has been entered for
Orphans to move.
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The 'orphan' Sale Price column is now moved to the previous fold:
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Orphaned Header Columns

As illustrated in the preceding section, moving an orphaned 'Normal' column can sometimes create an orphaned
header. In this example, it is the 'Part Number' Heading (1) column that has been orphaned and now appears by itself
on the last fold. Removing it will require a separate table transformation. (It is not unusual, however, to have multiple
transformations stacked on one another, as this is common with tables in order to manipulate them to their final form.)

To remove this 'empty' header, the 'Remove Empty Rows/Columns' transformation must be added after the Horizontal
Fold Table transformation. Full instructions on how to configure this transformation are described in the Remove Empty
Rows/Columns topic. But, to illustrate the configuration for this example, a value of '1' is entered in the 'Heading
Columns' field and the 'Remove Rows' box is checked.

The table now looks like this:
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Horizontal Wrap Table
The Horizontal Wrap Table transformation is used to 'wrap' wide tables that contain a large number of columns into a
taller, vertically oriented table. Users may have a need for the Horizontal Wrap Table transformation if the table is so
wide that it either cannot fit within a single InDesign page column or page, or if a vertical layout is desired.

This transformation works similarly to the 'Horizontal Fold Table' transformation (documented in the Horizontal Fold
Table topic), as both facilitate the ability to 'fold' a wide table into multiple table sections ('folds' or 'wraps') that stack on
top of one another. However, unlike the Horizontal Fold Table transformation, a table folded using the Horizontal Wrap
Table transformation is not folded based on a designated number of folds, but rather on particular column types,
providing control over where these particular column types land within the folds.

Though there are many combinations of configurations that can be applied within the transformation, the following two
screenshots show a sample 'before' and 'after' of a table (as previewed within the workbench) after applying the
Horizontal Wrap Table transformation.

Before:

After:
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Prerequisites
In order to take full advantage of this transformation, the table should meet these conditions:

Required:

The table has a minimum of three columns

The table uses the same column type in at least two places within the table. This is the column type on which the
table will be wrapped and must be a column type of 'Normal Row.'

Optional:

Though not required to use the transformation, tables using the Horizontal Wrap Table transformation typically use
at least one column type of Heading (1) and/or Sub Heading (2).
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This topic assumes the following:

You have already built the table to which you will be applying the Horizontal Wrap Table transformation. Instructions
on how to build the table itself are not provided in this topic; refer to the Creating Tables documentation for more
information.

You have already designated which columns should be used as the header(s) and/or subheader(s). This topic does
not describe how to designate columns as such; for information, refer to the Creating Column Types topic.

Applying and Configuring the Horizontal Wrap Table Transformation
For this topic, the example table has eight columns, which includes the repeating column type of 'Dimensions.'
The Dimensions column is a 'Normal Row' column. (Even though the setting is Normal 'Row,' this setting applies
to both rows and columns and means that the column / row is not used as a header, a subheader, or a footnote
column / row.)
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The 'Dimensions' column type is used in three places in the table. The attributes used for the 'Dimensions' column
are Size, Product Width, and Product Height.

Before applying the transformation, the table looks like this in the Preview view (Dimensions columns types are
outlined):

To apply the Horizontal Wrap Table transformation:
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1. In the Tree, navigate to the product, classification, or product-override object that contains the table to which you
would like to apply the transformation, then click the Tables tab.

2. Select the table type to which you would like to apply the transformation, then click the Preview tab.

3. Beneath the table preview, click 'Add Transformation' to display the Select Transformation dialog.

4. Select the Horizontal Wrap Table transformation, then click OK to apply the transformation.

5. Next, the transformation itself must be configured. Click the ellipsis button ( ) on the transformation to launch the

Horizontal Wrap Table configuration dialog.

6. The options on the Horizontal Wrap Table and their functions are as follows. The options are described in the logical
order in which they are typically applied.

Wrap on column type: Select the column type on which the table should be wrapped. This is a dropdown list that
contains all column types used in the table. For the example table in this topic, the Dimensions column type is
used.

Repeats: Enter the number of times the chosen 'wrap on' column type should appear in each wrap (fold) of the
table. If (1) is entered, one 'Dimensions' column will appear on each table wrap:
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If (2) is entered, there will be two Dimensions columns on each 'wrap.' (Only one Dimensions column appears on
the second wrap in this example since there are only three Dimensions columns in the table.)
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Repeat All Heading 1's at left.: Check this box to repeat all Heading (1) columns at the beginning of each wrap. The
below example shows how this table looks with the settings configured as follows:
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Repeat Last Heading 2: Check this box to repeat the last subheader column at the beginning of each wrap. A
typical setup includes only one header and one subheader column. The below example shows how this table looks
with the settings configured as follows:
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Make Header Row from Column
The Make Header Row from Column transformation enables you to transform the contents of a selected column to
header rows. This is useful, for example, if you want to save space or enhance readability by removing a column, and
instead have the contents of that column display as header rows in the table.

In the following example, the Size column is transformed into header rows.

Before the Make Header Row from Column transformation is applied, the table is sorted on the Size column by S - M -
L - XL - XXL - XXXL.

After applying the transformation, the Size column has been removed and header rows have been created based on the
contents of the Size column. A new header row is created every time the value changes, for example, from M to L. The
rows in this example also have had styling applied within the transformation, including a background shading of light
blue and an italic text style.
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Adding the Make Header Row from Column Transformation
1. With your table open on the Preview tab, click 'Add Transformation' to launch the Select Transformation dialog.

2. Expand the 'Transformations' folder and select Make Header Row from Column, then click OK.

3. The transformation is added. Click inside of the Parameters field to display the ellipsis button ( ).
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4. Click the ellipsis button ( ) to launch the Make Header Row from Column dialog.

5. In the Heading rows field, Enter 1 to ignore 'Heading (1)' rows. Enter 2 to ignore 'Sub Heading (2)' rows. Enter 0 to
include all heading rows.

6. By the Columns field, click the ellipsis button ( ) to launch the Select Column dialog. This is where you specify

which column to convert to header rows.
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Select Attribute to apply the transformation to the column that contains the specified attribute. Click the ellipsis
button ( ) to search or browse for the relevant attribute.

Select Product/Classification/Assetto apply the transformation to the column that contains the specified object.
Click the ellipsis button ( ) to search or browse for the relevant object.

Select Heading to identify a column by typing the header text of the relevant column.

Select Type to identify the column or row by selecting Column Type.

Select Number to identify the column by entering the sequence number of the relevant column. For example, if
you want to apply the transformation the second column, then type 2.

Click OK to close the dialog.

8. In the Row Type list, select the row type that will be used for the converted column.

For the remaining options, leaving them as 'Not Defined' will cause the formatting to be inherited from the
specified row type. To override the inherited settings, make a selection.

9. In the Text style list, select text style that will be used in the header rows that are created by the transformation.

10. In the Background Color list, select the background color you want to use for the header rows that are created by
the transformation.

11. In the Rule Above list, select the line style you want to use as the top border of the header rows created by the
transformation.

12. From the Rule Below list, select the line style you want to use as the bottom border of the header rows created by
the transformation.

13. Click OK.
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Merge Equal Cells
The Merge Equal Cells transformation merges adjacent cells that contain identical / equal values. It can be applied to
merge equal cells in the entire table or in specific rows or columns. Both horizontally and vertically adjacent cells can be
merged. The transformation also merges adjacent spanned cells that contain identical values.

If two equal cells appear from merging other cells, they are also merged. The transformation repeats the merging
process until there are no more cells to merge.

Note: The cells must be adjacent to one another in the table before they can be merged. This means that
additional transformations, such as Standard Sorting, may need to be applied to position the cells next to each
other so they can be merged.

Prerequisites
The instructions in this topic assume that you have already added the Merge Equal Cells transformation to your table by
following the instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table
Transformations topic.

Example

Before

This is how the table appears before applying the Merge Equal Cells transformation:
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After

This is how the table looks after.
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Steps
1. After adding the transformation, the identical cells that are adjacent to one another will automatically merge.

2. If you want to limit the cells that are merged to specific rows or columns, click the ellipsis button ( ) under

Parameters to launch the Merge Equal Cells dialog.

3. Check Limit to row/column to apply the transformation to a specific row or column only, then click the ellipsis button
( ) to launch the Select Row/Column dialog.

Select Attribute to apply the transformation to the row or column that contains the specified attribute. Click the
ellipsis button ( ) to search or browse for the relevant attribute.

Select Product/Classification/Assetto apply the transformation to the row or column that contains the specified
object. Click the ellipsis button ( ) to search or browse for the relevant object.
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Select Heading to identify the row or column by typing the header text of the relevant row or column.

Select Type to choose a specific row or column type from the dropdown list.

Select Number to identify the row or column by entering the sequence number. For example, to apply the
transformation to the third column, type 3.

Select Group to apply the transformation to a group of rows / columns and/or a range of row / columns, then click
the Setup button.

Click Add in the Select Row/Columns to be grouped dialog to add rows or columns to the group
individually.

After clicking Add, either a Row or Column field displays, depending on whether you are selecting a
row or column. Click the ellipsis button ( ) to launch another Select Row/Column dialog. This is

identical to the previous 'Select Row/Column' dialog, except without the Group option. Click OK after
making your selection.

Click Add again on the 'Select Row/Columns to be grouped' dialog to repeat the previous steps and
add more columns to the group. Click OK when done.
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To add a Range of columns to the group, click Add Range.

Enter the starting and ending column numbers in the Column From and To fields, then click OK when
done. To enter a range that will contain the remainder of the table if rows or columns are added later,
enter a large number in the 'To' field such as 5999. Note that these fields can only contain integer
values.

4. Click OK when complete.
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Merge Equal Rows/Columns
The Merge Equal Rows/Columns transformation merges consecutive rows or columns if they have identical data.

Prerequisites
The instructions in this topic assume that you know how to add a transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example
In the following example, there are two consecutive columns with identical data, which are then merged by the Merge
Equal Rows/Columns transformation.

Before

This is how the table appears before the transformation is applied.

After

This is how the table appears after. There is now one column with the '88' values.
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Steps
1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Merge Equal Rows/Columns

dialog displays.

2. Select whether you want to Merge Rows or Merge Columns, then click OK.

3. The transformation is applied.
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Merge Over Empty Cells
The Merge Over Empty Cells transformation merges row or column contents over empty cells. This transformation is
useful when you want to span cells with dynamically created content where you cannot use the Span Cells functionality.

Note: This transformation also merges equal spanned cells.

Prerequisites
The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example
The below screenshots show three examples of the same column, before and after the application of the Merge Over
Empty Cells transformation.

1. The first is the original column, with individual empty cells.

2. The second is how the column appears after applying the transformation. Cells are merged from top to bottom.

3. The third is how the column appears after applying the transformation and checking the Reverse Direction box in
the Merge Over Empty Cells dialog (more information is provided in the steps below). Cells are merged from
bottom to top.
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Steps
1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Merge Over Empty Cells

dialog displays.

2. Click the ellipsis button ( ) to launch the Select Row/Column dialog.

Select Attribute to apply the transformation to the row or column that contains the specified attribute. Click the
ellipsis button ( ) to search or browse for the relevant attribute.

Select Product/Classification/Assetto apply the transformation to the row or column that contains the specified
object. Click the ellipsis button ( ) to search or browse for the relevant object.

Select Heading to identify the row or column by typing the header text of the relevant row or column.

Select Type to choose a specific row or column type from the dropdown list.
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Select Number to identify the row or column by entering the sequence number. For example, to apply the
transformation to the third column, type 3.

Select Group to apply the transformation to a group of rows / columns and/or a range of row / columns, then click
the Setup button.

Click Add in the Select Row/Columns to be grouped dialog to add rows or columns to the group
individually.

After clicking Add, either a Row or Column field displays, depending on whether you are selecting a
row or column. Click the ellipsis button ( ) to launch another Select Row/Column dialog. This is

identical to the previous 'Select Row/Column' dialog, except without the Group option. Click OK after
making your selection.

Click Add again on the 'Select Row/Columns to be grouped' dialog to repeat the previous steps and
add more columns to the group. Click OK when done.
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To add a Range of columns to the group, click Add Range.

Enter the starting and ending column numbers in the Column From and To fields, then click OK when
done. To enter a range that will contain the remainder of the table if rows or columns are added later,
enter a large number in the 'To' field such as 5999. Note that these fields can only contain integer
values.

3. Check the Reverse Direction box to merge over the empty cells from bottom to top instead of top to bottom. Refer to
the example given at the beginning of this topic for an illustration.

4. Click OK when done.
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Merge Rows/Columns
The Merge Rows/Columns transformation enables you to merge single columns or rows, groups of columns or rows, or
a range of columns or rows into one column or row.

When you merge columns or rows, the values of all rows or columns are retained and usually separated by a separator
character. After the merge, it will look as if two or more attributes are placed in the same column or row.

Prerequisites
The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example
In the following example, the 'Neck Style' and 'Material' columns are merged. Though it is common to merge columns or
rows that are directly adjacent to one another, any columns or rows can be chosen. E.g., in the below example, 'Product
Name' and 'Color' could be merged, and so forth.

Before

Before the merge, the 'Neck Style' and 'Material' attributes are maintained in two separate columns.

After

After the merge, the contents of the two columns are now merged into one column, and the values are separated by a
hyphen with a space on either side.
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Steps
The Merge Rows/Columns transformation is set up in a three-step wizard. The steps are Orientation, Rows/Columns,
and Result.

To get started, after adding the transformation, click the ellipsis button ( ) under Parameters to display the Merge

Rows/Columns wizard.

Orientation

In the Orientation step, specify whether you want to merge columns or rows. Click Next.

Rows/Columns

In the Rows/Columns step, two merge options are available—Merge Single Columns and Merge Group of
Columns.
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To Merge Single Columns

Select the Merge Single Columns radio button, then click the ellipsis button ( ) on the first parameter to choose

the first row or column that you want to merge.

In the Select Column dialog that displays, choose the column or row by selecting one of the available options
(Attribute, Product/Classification/Asset, etc.). These options are explained in detail in the 'Rule When Different'
subsection of the Layout Transformations topic; refer to that topic for more information.
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Click the ellipsis button ( ) in the second field to choose the second row or column to be merged, following the

same steps that you used to choose the first row or column.

After choosing both rows / columns, click Next to go to the Result step.

To Merge a Group of Columns

Select the Merge Group of Columns radio button, then click the ellipsis button ( ).

In the Select Column dialog that displays, select Group, then click Setup.
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3. On the Select Row/Columns to be grouped dialog, click Add to select individual columns to be grouped.

4. If you are grouping columns, a Column field will appear (and conversely, a Row field will appear if grouping rows).
Click the ellipsis button ( ) to launch the Select Column (or, Select Row) dialog. Specify the first row to be

grouped, then click OK.
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Click Add again to create a second Column (or Row) field. Repeat these steps until you have added all of the
desired columns or rows to the group. Click Remove to remove a column / row selection.

When finished, click OK in the Select Row/Columns to be grouped dialog. Then, click OK in the Select Column (or,
Select Row) dialog.

Click Next to go to the Result step.

To Merge a Range of Columns

On the Select Row/Columns to be grouped dialog, click Add Range.
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2. If merging columns, a Column From field and a To field will display. If merging rows, a Row From field and a To field
will display.

3. Enter the number of the 'from' column / row in the Column From / Column Row field, then enter the number of the 'to'
column / row in the To field. Note: These fields will take number entries only.

4. To add an additional range, click Add Range again and follow the previous steps.

When finished, click OK in the Select Row/Columns to be grouped dialog. Then, click OK in the Select Column (or,
Select Row) dialog.

Click Next to go to the Result step.
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Result

1. In the Result step, specify the row or column type to use for the merged column or row. In addition to the legal
column types / row types available for the table, you can also choose to keep the style of the first merged column /
merged row.

2. If you choose 'Use Column Type/Settings from First Merged Column' (or, if merging rows, 'Use Row Type/Settings
from First Merged Row'), the Keep localized cell settings from first merged column / Keep localized cell settings
from first merged row checkbox will become activated. This setting enables cell-level formatting to be retained from
the first merged column or row.
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3. Enter the Separator character(s) that should appear between values in the merged column or row. In this example,
the separator is ' x ', an x with a space on both sides. Then, choose one of the three available options:

Always insert separator

Do not insert separator if only one value is empty

Do not insert separator if both values are empty

4. Click Finish to complete the transformation setup.

Additional Example - 'Keep localized cell settings' and 'Separator'
In the following example, the 'Height,' 'Width,' and 'Depth' columns will be merged using the Merge Rows/Columns
transformation. Before the transformation is applied, a single pink cell appears in the 'Height' column, and all dimension
values appear independently, each in their own column.
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After the transformation is applied, the pink shading is retained in the merged cell, and all merged values now appear in
the same column, separated by ' x '. This is due to Keep localized cell settings from first merged column being
selected and a separator of ' x ' being used as the separator on the Result screen of the wizard.

Had Keep localized cell settings from first merged column been left unchecked, the pink shading would have
been lost and the table would look like this:
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Move Units to Header
The Move Units to Header transformation enables a header row or header column to be built from unique units that
appear on values inside the table. One use for this transformation would be for tables that contain highly technical
product information; for example, for electronic components that use units such as Ohms (Ω). Additionally, it helps to
save space on column widths or table heights.

The transformation parses through the actual column units of a table and, if all units are the same, a header row or
header column is built from the unique unit. When moving the units to the header, either a new header is built using the
unique unit, or the unit text is appended to the text of an existing header. In either instance, the units are removed from
the values within the table after they are moved to the header.

Prerequisites
The instructions in this topic assume that you know how to add a transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example
The following example uses a table that contains technical specifications about a set of surround speakers. The
included units are Decibels (dB), Hertz (Hz), Ohms (Ω), and Watts (W). To keep the units from appearing multiple times
in the table, they will be moved to the header row. This example uses an existing header and does not create a new
one. However, configurations are present in the transformation that can allow for a new header to be created, e.g., if the
units should appear in a subheader row.

Before

This is how the table appears before the units are moved to the header row.
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After

This is how the table appears after. The units are moved to the header and a delimiter of ' in ' is applied so that the
header columns read, for example, 'Frequency Response in Hz" instead of 'Frequency Response Hz.'

Steps
1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Move Units to Headerdialog

displays.
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2. Select Row Header to move the units to a header row. Select Column Header to move the units to a header
column.

3. Select Place units in existing Header to move the units to an existing header row or column, then enter a number in
the Header Row Position field to specify whether the units should be in the topmost header (1), the second header 
(2), and so forth. If no value is inserted for Header Row Position, a default header row is calculated to place the units
in the last header row above the body rows or the last column row before the body columns.

4. Select Place units in new Header to create a new header row or column for the units, then, select a row or column
type from the dropdown list. The row or column type can be any row or column type that is legal for the table and
does not have to be specified as a Header or Subheader row on the row type or column type in System Setup.

5. Enter a value in the Unit Prefix field to add content before the moved unit and enter a value in the Unit Postfix field
to add content after the moved unit. A value can be placed in both the Unit Prefix and Unit Postfix fields to surround
the unit with characters such as brackets. For example, add '[' as the prefix and ']' as the postfix to form [Hz]
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6. Enter a value in the Header Delimiter field to add text that should separate the header text from the unit. In the
example screenshots shown at the beginning of this topic, the text ' in ' has been added (the word 'in' with a space
before and after).

7. Click OK when complete to apply the transformation.
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Pivot Table Transformation
Pivot tables (sometimes referred to as Compact or Compacted Tables), are useful in print applications to display
product data in a compact manner. They allow more products and product data to be presented in a smaller physical
area than a non-compacted table. Not only does this type of table require less space on a printed page, it also enables
the reader to compare similar products. Although it is not always the case, pivot tables usually show more than one
product in a single row. In addition to the table's compactness, another purpose of this type of presentation is to allow
the reader to view both the common attribute values of similar products as well as their differences.

Pivot tables in STEP are created using the Pivot Transformation. You can apply pivot transformations to any table.
However, this transformation does require a high degree of data accuracy and consistency. The following approach is
recommended when working with this transformation.

Create a pivot table type in System Setup if it does not already exist. For more information, refer to Creating Table
Types in System Setup.

Create a table on a product in the Tree based on the pivot table type.

Apply a Pivot Transformation to the table, experimenting with different setups.

This initial approach to learning about pivot transformations should help in understanding the functionality of the
transformation. It is very likely that you will need to create new row types and/or column types during your initial
experiments, so creating these new row / column types on this new table type will be easier to implement, as opposed
to modifying an existing table type. After learning the features and capabilities of the transformation, then you may
decide to modify your existing table types accordingly.

Areas of a Pivot Table – Introducing the Table Guide
The following figure shows a pivot table that has been specifically created to show how a pivoted table is built. The
different areas of the pivot table are identified by the use of background colors. There are seven areas. This table is the
same as that which is displayed in the Pivot Transformation Wizard, and is called the Table Guide. As you progress
through each step of the Pivot Transformation Wizard, the Table Guide will help you visually by highlighting the area
that will be affected by the options you select.
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One of the purposes for presenting information in this manner is to allow the reader to easily compare similar products,
viewing both their common specification values and their differences. For example, a reader looking at the first part
number in the table (8J5H1), can view that there are some similar products, (8J5F4 and 8J6S4). They have the same
specifications for Diameter, Length, # Flutes, Angle, and Grade, but have different specifications for the Material and
the Brand Name. Since there are differences between these three products, the Price will usually reflect that by also
having a different value.

The different background colors identify seven areas. Each of these areas has a separate setup screen in the Pivot
Transformation Wizard. The name and purpose of each of these different areas are defined as follows, in the order that
they are presented in the Wizard:

The yellow cells denote the Left Common Values area. You may define the attributes that are common to all the
products in the same row. The attributes will be located on the left side of the table. There is a similar capability to define
attributes that should be placed on the right side of the table (in the brown area). If within the Pivot Transformation no
attributes are defined in either of these areas (yellow or brown), then table compaction cannot be accomplished. That is,
there must be at least one attribute declared as being a 'common value' attribute for the transformation to function. In
the Table Guide, the attributes used in this area are: Diameter, Length, and Number of Flutes (# Flutes).
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The light blue cells denote the Top Pivotal Values area. In the Wizard you can identify the attributes to be
'promoted' into one or more header rows and these header rows will be created and placed at the top of the table.
There is a similar ability to define one or more attributes to be located in an automatically generated row (or rows)
at the bottom of the table, (the dark pink area). For any Pivot Transformation to work, there must be at least one
attribute declared as either a Top or Bottom Pivotal Value. In the Table Guide, the 'promoted' attributes in this top
area are: Brand and Material.

The green cells denote the Compacted Values area. In the transformation you can state which attributes should
be placed in this area and these attributes will be rearranged so that products with the same common values will
be placed on the same row, and that they will be placed in the appropriate column corresponding to the promoted
attributes in the header rows. In the Table Guide the attributes that will be used are the SKU and the Price.

The dark blue cells denote the Column Heading area. In the Table Definition tab a standard setup will have one header
row that holds all the column headings for the attributes that are called out in each column. In the Pivot Transformation
you can declare certain attributes to use for the table compaction (the 'promoted' attributes), and the system will
generate the appropriate number of header rows at the top and/or bottom of the table. In our example, the attributes
Brand and Material were the promoted attributes (and Box Type was promoted to the Bottom Pivotal Values area, not
shown). Since the cells with the attribute names in the generated top and bottom header rows originated from the first
row in the table definition (the column headings row), they are still considered as 'column headings', thus the reason for
showing them in their dark blue color. It is easy to suppress these attribute names from appearing.
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The brown cells denote the Right Common Values area. This is an identical setup to that of the Left Common
Values area. In any Pivot Transformation there must be a minimum of one attribute defined in either the Left
Common Values or the Right Column Values. If no attributes are defined in either of these areas, (yellow or
brown), table compaction cannot be accomplished. In the Table Guide, the attributes used in this area are: Angle
and Grade.

The dark pink cells denote the Bottom Pivotal Values area. This is similar to the Top Pivotal values area, with the
exception that the system will generate an appropriate number of header rows at the bottom of the table
depending on the attributes selected. For any Pivot Transformation to work, there must be at least one attribute
declared as either a Top or Bottom Pivotal Value. In the Table Guide, the attribute in this bottom area is: Box Type.

The red cells denote the table's Corners area. These areas are really independent of one another and may be
used for a variety of purposes. You may enter free text into any of these areas, or you may access attribute values
or image references from the original defined table. In the Table Guide, the information in the top left, top right, and
bottom right corners are all free text. In the bottom left corner an attribute has been called out to display the
'Quantity per Package type' attribute.

Preparing Tables for Pivot Transformation
The contents of table cells may be free text, product attribute values, product Names or IDs, meta-data, product
references, or asset references. In order to simplify this documentation only product attributes and free text are
used for the cell contents. But the other cell content types are equally valid and may be used in the Pivot
Transformation.

It is recommended that the tables that are going to be involved with pivot transformations are all constructed in a similar
manner. That is, products in rows and attributes in columns are shown in the following general example that matches
that shown in the Table Guide.
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In the example shown, there is only one header row used for the Attribute Names. It is of no use to set up a Table
Definition with more than one header row, since it will conflict with the Pivot Transformation. The transformation will
create additional header rows according to the setup within the transformation. It will only accept one header row in the
original Table Definition.

In the above example, the elements are organized in the following way. The first two columns will be used in the
Compacted Values area, the next three columns will be used for the Left Common Values, columns 6, 7, and 8 will be
used to generate header rows at the top and bottom of the table, and columns 10 and 11 will be used for the Right
Common Values. Column 9 is included in the table definition (attribute = End Type), but if an attribute is not 'mentioned'
in the Pivot Transformation then it will be ignored (filtered out) and will not appear anywhere in the resultant transformed
table. Thus column 9 is included only to demonstrate that it is not present in the transformed table, regardless of
whether or not there are attribute values in that column. As far as the Table Guide is concerned, column 9 is redundant.
And as far as the Pivot Transformation is concerned, it does not exist. The attribute in column 12 will be used in the
bottom left corner of the pivoted table.

Considerations

The product attributes are all called out individually in this table definition, and the content definition of 'Attribute Groups
Attributes' has not been used. That option may be used if it is desired that the table is more 'dynamic', and to reduce the
number of localized tables. However, the Pivot Transformation does require that you state exactly which attributes are
to be used in the different areas of the table, either by attribute, Column Number, or Column Type. So if you do use the
'Attribute Group Attributes' method you must know beforehand which attributes in that group to include within the
transformation. Empty attribute columns can be easily discarded either within the Pivot Transformation or via the
standard transformation that removes empty columns and rows.

The above setup does make use of the content definition 'SubProducts, Family', so that the number of rows that initially
make up the table is dynamically sized according to the number of child products in the product family. If a successful
table compaction is done, there will be fewer rows after the pivot transformation.

You can create different column types for the different 'areas' in which the attributes will be used. But you should be
aware that no matter what you set up in the table definition tab you will still need to declare the different row and column
types within the transformation, since during the transformation all the original row and column types are basically
'discarded'. So for the Table Definition, whether or not you organize your tables with different column types is a matter
of personal choice. However, there is one major advantage to assigning the column types to match their intended 'area'
in the pivoted table, and that will also be explained later in the Working with the Pivot Transformation Wizard.
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Pivot Transformation Step 1 Left Common Values

In the Table Guide, the Left Common Values will be the attributes for Diameter, Length, and # Flutes.

Note: The contents of table cells may be free text, product attribute values, product Names or IDs, meta-data,
product references, or asset references. But for purposes of simplicity in this document the terms 'attribute' and
'attributes values' are used when referring to a cell's content.

In this step you choose the attributes whose values are common to all the products in the same row and that will be
positioned on the left hand side of the table. You have the following options:

Select None if you do not want any attributes in this area. If you choose this option, you will need to define at least
one attribute in the Right Common Values area. Otherwise the transformation cannot be accomplished.

To choose one or more attributes to be placed on the left side of the table, click the ellipsis button ( ) to open the

window where you will choose those attributes. The Column Selector radio button is automatically set and the
following screen displays:
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The options in this dialog box should be familiar; they are used for identifying columns or rows of attributes in several
other table transformations. If you know that you will be defining more than one attribute in the Left Common Values
area, then you should immediately select Group > Setup, which launches the 'Select Row/Columns to be Grouped'
window.

If you know that you will only be defining one single attribute in the Left Common Values area, then you may make your
selection in the usual manner from the options provided.

If you have selected Group > Setup, then click Add on the 'Select Row/Columns to be Grouped' window. Click the
ellipsis button ( ) by the Column field to launch the 'Select Column' window, then choose the columns that

should be in your group. Define as many attributes as needed.
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Each time you select the 'Add' button (top picture) you are presented with the options for identifying the attribute to
appear on the left side of the table (bottom picture). The attributes display in the pivoted table in the same order
they appear in this setup. So, the order in which the columns appear in the Table Definition is irrelevant. It is at this
wizard step that you select the order of the columns to be displayed.

The selection of attributes that matches the Table Guide.

When you are finished with your selections, click OK to return to the main Wizard screen. Your selections will
appear in the Column Selector line, similar to the following:
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Format Button – Left Common Values
The Format Button is available in seven of the Wizard screens. The options within the Format window are very
similar.

After making your selections as to which attributes will be placed on the left side of the table you need to define how the
attribute values in the newly formed columns should be displayed. If you click the Format button, you can control the
assignation of all the required Column Types in this area.

The options and selections in this window are the same as those for the Right Common Values.

Although the selections in the Format window for the Left Common Values and Right Common Values windows are
exactly the same they are completely separate. So when you are in the Left Common Values area you will only be
establishing setups for that area and not for the Right Common Values area.
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The window is divided into two distinct areas. On the right hand side of the Format window (shown above) you may
apply column types to the attributes that you just selected. However, no matter what setups are defined within those
Column Types that you have specified, the settings in the area over on the left hand side of the Format window will
override those settings. You can therefore consider the settings on the left side to be 'global overrides'. For more
information refer to the section on Priority of Cell Formatting Setups.

For example, in the above screenshot, if there is a Background Color of 'Mango' defined in the Column Type = LH
Compact Specification, it will only take effect if there is no Background Color specified on the left.

Summary: Any setting that is not defined in the 'global overrides' area will allow the setting from the Column Type
(specified on the right side) to take effect. However, there are some additional conditions that will influence this,
refer to the section on Priority of Cell Formatting Setups.

Applying Column Types

Up to five 'rules' may be applied when assigning column types. Each rule has the same selection of options.

There are different ways of assigning Column Types since the number of attributes selected in the Left Common Values
area may vary from table to table. You have up to five sets of options or "rules" that you can apply to the assignation of
the Column Types:

The available selections within each rule.
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Unused: No Column Type is defined.

First Column: The specified Column Type will be assigned to the first column in the Left Common Values area.

Second Column: The specified Column Type will be assigned to the second column in the Left Common Values
area.

Third Column: The specified Column Type will be assigned to the third column in the Left Common Values area.

Fourth Column: The specified Column Type will be assigned to the fourth column in the Left Common Values
area.

Fifth Column: The specified Column Type will be assigned to the fifth column in the Left Common Values area.

Every Column: Every column in the Left Common Values area will be assigned the specified Column Type.

Every First of Two Columns: Starting at the first column in the Left Common Values area, every alternate column
will be assigned the specified Column Type.

Every Second of Two Columns: Starting at the second column in the Left Common Values area, every alternate
column will be assigned the specified Column Type.

Every First of Three Columns: Starting at the first column in the Left Common Values area, every third column
will be assigned the specified Column Type.

Every Second of Three Columns: Starting at the second column in the Left Common Values area, every third
column will be assigned the specified Column Type.

Every Third of Three Columns: Starting at the third column in the Left Common Values area, every third column
will be assigned the specified Column Type.

Remaining Columns: All columns in the Left Common Values area following the ones affected by the previous
rules will be assigned the specified Column Type. For example, if rules have been applied to the first three
columns, then from column 4 onwards the specified Column Type will be assigned.

Last Column: The last column in the Left Common Values area will be assigned the specified Column Type.

When column types are applied, the rules are applied in the order they are listed, thus a later rule overrides an earlier
rule. For example, if the first rule is 'Every Column' and the second rule is 'Third Column', then all columns will be
assigned the Column Type defined in the first rule, except the third column, which will be assigned the Column Type
defined in the second rule.

As a result of these different options it is possible to achieve the same result in different ways. For example, review the
setups in the following picture – they accomplish the same thing:
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Pivot Transformation Step 2 Top Pivotal Values
In this Step you choose the attributes that you want the system to promote into the table headers, creating as many
header rows as required. The procedure is very similar to Step 1 with the exception being the formatting options, where
instead of Column Types you define the Row Types for the attributes that have been promoted into row headers.

In the Table Guide, the Top Pivotal Values will be the attributes for Brand and Material.

The method of selecting the attributes is identical to that in Step 1. The above selection of the attributes Brand and
Material correspond to the attributes shown in the Table Guide.

Format Button
In Step 1 the functionality of the Format button was described in detail. Refer back to Pivot Transformation Step 1
Left Common Values for further information. The only difference between the Format window presented and that
in Step 1 is that you will select the Row Types for the attributes that you chose to be promoted into header rows.
And the options in the 'Row Types to apply' will reflect row numbers, not column numbers. Refer to the following
image for reference.
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In the Table Guide example two different Row Types have been applied, corresponding to the two attributes Brand
and Material that were selected to be promoted into row headers. This would allow for different fonts, point sizes,
background colors, etc. to be applied to the attribute values in the header rows. If the two new header rows will
have thew exact same specifications, there is no real benefit in assigning two different row types. Note that the row
types that you specify may or may not be the same as that of the first row in the Table Definition, they could be
completely different row types.

A reminder that in our sample table, the row type used for the column headers is 'Column Header Row'. This may
or may not be the same row type that is desired for the additional header rows that are created by promoting
attributes into those new rows.
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If the format specifications will be the same for all header rows, it is perfectly acceptable to apply the row type that
is used in the Table Definition (in this case, 'Column Header Row') to all rows in the Top Pivotal Values, thus:

You could also apply setups in the 'global override' area of the Format window. But that does not mean that you
can leave the right side 'blank', since as a minimum you do need to tell the system that the rows are header rows
and not normal rows. If the table is mounted to a page and the system needs to split the table, then it needs to
know what the header rows are so that the appropriate row(s) can be carried over to the next column or page. So
as a minimum you need to fill in at least one entry for the Row Types, and that Row Type should have its Header /
Footer option set to set to Heading (1). That would be the standard setup.

The options for the Bottom Pivotal Values in step 6 of the Wizard are identical to this one.
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Pivot Transformation Step 3 Compacted Values

In Step 3, you choose which attributes you want to go into the compacted area. You must select at least one
attribute. The method of selecting the attributes is the same as in the prior steps.

In the Table Guide example the column types of PartNo and Price were selected.

The Format screen dialog is similar to that shown in Step 1 and 2, except you can specify both Row and Column Types.
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In the above setup each group of compact values will alternatively be assigned the Column Types of Compact Part
Column and Compact Price Column. This matches the settings for the Table Guide, where the column types of Part No
and Price were defined.

Also, in this step, you determine whether the compacted values will display within that area in a left-to-right manner (as
shown in the Table Guide, Price columns next to the SKU columns) or whether the display will show in a top-to-bottom
manner (SKU numbers displayed in one row, prices displayed on the next row). You can request the system to further
compact this area if, say, all the prices in the first price column are the same as the prices in the second price column.
For example, in the Table Guide you can view that all the prices for the HSS and Titanium products are the same, so
further compaction is possible. This is accomplished by the Horizontal Values setting and its attendant options.
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Effect of the Horizontal Values Setting

This is best shown by pictures. The following picture shows the effect on the display of cell contents within the
Compacted Area as a result of selecting the Horizontal Values checkbox. Note that it matches the example of the
Table Guide:

The following picture shows the effect on the display of cell contents within the Compacted Area as a result of
deselecting the Horizontal Values checkbox:
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Performing Further Consolidation within the Compacted Area

Consider the following:

Note that the prices are the same in the first two compacted price columns.

Now review the following setting:

In the Column Selector, the column that held the prices was defined as the second column to compact. By using
the setting for the Compacted Values Column (set to 2, referring to the Compact Price column), the transformation
can then further consolidate the data, thus:
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Note that in the setting, 'Collapse Right' was chosen. This indicates (in this case) that the column furthest to the
right after the compaction should be used. If in this example 'Collapse Left' had been chosen, the price column
would have been positioned between the column starting with part number 8J5H1 and the column starting with
part number 8J5F4, since that would be the 'left-most' of the compacted price columns.

Also note that if you have more than just two attributes in the Compacted Area, you can compact those additional
attribute values. As you enter a value for one Compacted Values Column the system will automatically add
another blank entry for you to make your additional selection. Example:

Note: Merging the column headings of 'SKU' into one cell may be done by a subsequent standard
transformation.
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Pivot Transformation Step 4 Column Headings

In this step you choose which row in the Table Definition is the one to use for the Column Headings. As usual, you can
select that row by specifying the Attribute, Product/Classification/Asset, Heading, Row Type or Row Number. It is
expected that in the vast majority of cases the selection will be made either by Row Type or Row Number.

Note that it is not at all common for there to be more than one Column Headings row set up in the Table Definition.
Usually, any multi-row table headers are made up of the original header row plus the new header rows that have been
generated as a result of promoting attributes into that area (in Step 2 above).

The setup that matches that for the Table Guide.
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Pivot Transformation Step 5 Right Common Values

In this step, you choose which attributes that you want to appear on the right hand side of the table, i.e., to the right of
the Compacted Values area. The setup method is essentially the same as that described in Step 1, which defined the
attributes to the left of the Compacted Values area. Refer to Step 1 for more details. Some screenshots are included
showing the setup that corresponds to the Table Guide.

Since any Pivot Transformation requires at least one attribute to be defined either in the Left Common Values area or in
the Right Common Values area, then if None was selected in Step 1, you will be required to make an entry at this point
because the None radio button option will be disabled.

The above picture shows the selection of attributes for the Right Common Values that match the Table Guide.
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The above picture shows the Format screen with all columns being assigned the column type 'RH Compact
Specifications'.
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Pivot Transformation Step 6 Bottom Pivotal Values
In Step 6, you choose which columns to use for the bottom header rows. The procedure is the same as in Step 2. Any
new rows generated as a result of promoting an attribute will be placed at the bottom of the table. Refer to Step 2 for
details, some screenshots are included to show the setup that corresponds to the Table Guide.

In the Table Guide example, the attribute Box Type is used to create a bottom header row.

The above image shows the selection of the attribute Box Type. Since only one attribute will be promoted to the
Bottom Pivotal Values the group option was not necessary.
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The above shows the setup that matches that for the Table Guide example.
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Pivot Transformation Step 7 Corners
In Step 7, you define the contents of the four corners of the pivot table.

The information specified in each of the four corners are independent of each other.
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The image above shows the setup that matches the Table Guide example. Note that in the example the top left,
top right, and bottom right corner cells will have free text values, and that the bottom left corner cell is set up to
reference a row/cell number in the original Table Definition, thus:

For each corner cell, you have the following options:

Leave the cell empty.

Retrieve the contents of a specific cell in the original table by specifying the intersecting row and column numbers.
The row/column numbers refer to the original table before the Pivot Transformation, and the contents of the cell in
the Table Definition may be an attribute reference, asset reference or free text.

Enter the value (including any STEP tags) as free text.

Click the Format button to define the formatting of the cell in each corner.
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The above picture reflects the setup for the top left corner cell of the Table Guide example.

The format of the cells in the corners does not have anything to do with any row or column type formatting. Thus
each of the four Format windows allows a different format style to be applied to the four corner cells.
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Pivot Transformation Step 8 Sorting
In Step 8, click the Add Sorting Option button to define the sorting of the information in the Top or Bottom Pivotal
Values area and/or information in the Left or Right Common Values areas.

The sorting mechanism is similar to that of the Table Sorting Options, except that instead of specifying the sort criteria
by row / column type or attribute, instead you specify the column number in the Left or Right Common values, or by row
number for the columns that are in the Compacted Values area.

Example 1, sorting via the Left Common Values area:

The above setup specifies to sort the 'body' rows of the table (i.e., the non-header rows) according to the values in the
second column in the Left Common Values Area, and in descending order. In the Table Guide example the second
column is the 'Length'. With this setup, if you have a table that matches the sample Table Guide, it would look like this:

Note that the rows are now sorted according to the descending values of the Length.

Example 2, adding more sort criteria :
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The above setup specifies to sort the 'body' rows, first according to the values in the third column in the Left Common
Values Area, then second according to the values in the second column. Both are sorted by ascending values. The third
column is '# Flutes', and the second column is the 'Length'. With this setup a table that matches the Table Guide would
look like this.

You may also sort on the Right Side Common Values area, instead of selecting 'Left Side' in the dropdown you
would select 'Right Side'. You may specify the desired sorting of the body rows by combining left side and right
side sorting options respectively

Common Values Sorting

The Common Values Sorting setup in essence specifies the order in which the rows are displayed in the pivoted
table. To also specify the order that the columns are displayed in the Compacted Area, use the 'Compacted
Columns Sorting'. So if, for example, you wanted the columns that have the headings 'Acme Drill Co.' and 'PSV
Co.' to display in reverse alphabetical order, and if you then wanted the columns 'HSS' and 'Titanium' to occur in
reverse alphabetical order, then the setup would look like this:
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And the resultant table that matches the Table Guide would look like this:

You may also sort on the Bottom Pivotal Values in a similar manner to sorting on the Top Pivotal Values. Instead
of selecting 'Top Pivotal Values' in the dropdown you would select 'Bottom Pivotal Values'.

The above examples used only the ascending and descending option (Alphabetic). But you also may also sort on
Numeric, and Fraction, thus:
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Pivot Transformation Step 9 Settings
In Step 9, you define some general settings.

A number of these options can be explained by referring to the Table Guide:

These options are explained as follows:

Merge Equal Cells in the Left Common Values Rows: The Table Guide shows the effect of this setting. The values
in the '# Flutes' column have been merged when consecutive cells have an equal value.

Merge Equal Cells in the Right Common Values Rows: The Table Guide shows the effect of this setting. The
values in the cells of the 'Angle' and 'Grade' columns have been merged when consecutive cells have equal values

Merge Equal Cells in the Top Pivotal Values Columns: The Table Guide shows the effect of this setting. The
attribute value 'Acme Drill Co.' was merged since consecutive cells had the same value.

Merge Equal Cells in the Bottom Pivotal Values Columns: The Table Guide shows the effect of this setting. The
attribute value 'Pop-Open Plastic' was merged since consecutive cells had the same value.
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Remove Empty Value Rows: Removes any row in the Compacted Area where all the cells have empty values. This
would only take effect if you had deselected the 'Horizontal Values' checkbox in Step 3.

Remove Empty Value Columns: Removes any column in the Compacted Area where all the cells have empty
values. This would only take effect if you had deselected the 'Horizontal Values' checkbox in Step 3. So referring to
the Table Guide, if in the Compacted Values Area all the Prices were missing for the PSV Co. products, that column
would be removed. Thus:

Allow More Than One Value in Cells in the Compacted Values Area: Consider the following table—

Notice that in the first 'body' row there are cells with two part numbers and prices. However, there is no data in
that row or column that distinguishes one product from the other. In other words the reader cannot view any
difference between part number 8J6S4 and 8J6S5. The price is different, but there is no supporting data to
differentiate between the two products. So all that a reader would view is that part numbers 8J6S4 and 8J6S5
have identical specifications, but one is more expensive than the other. Thus any normal customer would
always order the less expensive item. Or they would have to investigate by some other method the difference
between the products.

This situation usually occurs when either a) the Table Definition is missing an attribute that would indicate the
difference in the products, or b) the data that does distinguish the two products is present in the Table
Definition but has not been accounted for in the Pivot Transformation, or c) the actual data is incorrect.
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If you were to disable the checkbox 'Allow More Than One Value in the Compacted Area' then only the first
entry would be displayed (i.e., 8J6S4). But, if the checkbox is selected, (i.e., it is OK to allow more than one
product or value in a cell), then the system will place a Return code between each entry in the cell.

Do Not Localize Cell Settings: Enable if you want the pivot table to build without localized cell-specific formatting,
providing a 'blank canvas' to apply cell settings after the transformation.

When disabled, the behavior of the Pivot Transformation is to rebuild tables cell by cell, applying localized cell
properties in the process. Applying another row or column type transformation after a Pivot Transformation
(such as 'Assign Row/Column Types to Rows/Columns') does not override all local cell settings, which can
make it more challenging to change or remove the formatting that is being inherited from the table rows /
columns setup.
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Pivot Transformation - Finish

Finishing the Transformation
When you have made all your selections, click the Finish button to return to the Table Preview. You could check
what the Table Preview would show before you exit the transformation, using the option 'Show Preview', and
updating that preview each time you make a change. However, the preview within the transformation will take all
transformations that are applied within the table, even if one or more of them were temporarily disabled by
deselecting the check box for that transformation. To view the Table Preview with just the transformations that you
have selected, exit the Pivot Transformation and view the preview.

Adding Subsequent Transformations
The Pivot Transformation is reasonably tolerant of working together with subsequent transformations, such as
creating table subheads from a column, or applying alternate tints on rows, etc. However, because the table has
essentially been rebuilt you will not be able to refer to a column by its attribute. The only practical way to refer to a
column, for example, is to refer to it either by its subtype or by its column number after the Pivot Transformation.
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Priority of Cell Formatting Setups
Throughout the various Steps of the Pivot Transformation Wizard you are presented with options to specify the
formatting of the table cells. However, formatting can also be applied via the rows or column subtypes specified in
the Table Definition tab, as well as individual cell settings being applied. It is possible to create a setup that would
cause a conflict in determining which formatting values to use. Thus the Pivot Transformation uses a strict order of
prioritization. This priority is not always easy to determine, so an example is presented as a guide to help with
troubleshooting any formatting conflicts.

Format Priority

Determining how a table cell's background color is selected when there are several conflicting setups in place

This example of Format Priority is valid for all the following setups:

Text Style

Background Color

Vertical Alignment

Rule Above

Rule Below

Rule Left

Rule Right

Cell Rotation

Process Flag

Cell Story Direction

Formatting Priority Synopsis
1. Global Override in the Transformation

2. Cell Setting override in the Table Definition

3. Row Setting override in the Table Definition

4. Row Setting default in the Table Definition

5. Column Setting override, but only if the column type in the Table Definition matches that which is applied in the
Transformation

6. Column Setting default, as applied in the Transformation
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It is not recommended practice to assign settings in such a way that it is difficult to determine which format setting
is actually used. It should be sufficient to make setups such that only one or two levels of priority are necessary.

To apply background colors to alternating rows, it is not advised to use BG colors in any of the row/column settings
that will affect 'body' rows (non-header rows). Instead, use the standard transformation to apply those BG colors.
That transformation may be applied after the Pivot Transformation.

If possible, try to avoid Text Style format setups that will cause a conflict in how the Table Preview can display the
text.

Example

In the Table Guide, consider the cells that hold the values for the attribute Length. That attribute resides in the Left
Common Values area of the table.

In the Table Definition, assume that there are several setups in effect, as follows:

1. Assume that the row type Normal Row has a default BG Color assigned to it (Cyan) and that the BG Color is
overridden in the Table Definition on that row with a color of Leaf Green. Refer to the following picture.
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The row type Normal Row has a BG Color of Cyan, but is overridden in the Table Definition with a BG Color of
Leaf Green.

2. Assume that the column type LH Compact Specifications has a BG Color assigned to it and that it also has an
override BG Color of Orange applied in the Table Definition on the column holding the attribute Length.

The column type LH Compact Specifications has a BG Color of Canary Yellow, but is overridden in the Table
Definition with a BG Color of Orange.

3. Assume that there is a BG Color override applied at the cell level.

Consider the Format setup within the Pivot Transformation, and the effect that it has on the output.
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First Priority

This setting takes the highest priority for cell formatting—the Global Override setup in the Pivot Transformation.
But be aware that this Global Override affects all cells in the Left Common Values area, not just the ones for the
cells with the attribute values for Length.

Second Priority

If there is no Global Override for the BG Color, then the next priority goes to the Cell Settings override, thus:

Note that this setup affects only the cells with the attribute value of Length.

Third Priority

If there is no Cell Settings override, then the next priority goes to any localized setting on the row type. So in this
case, if a Row Settings override was applied to the Normal Row, the result would be similar to the following:
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Notice that the row setting may well affect other cells in the table, not just the ones in the Left Common Values
area.

Fourth Priority

If there is no Row Settings override, then the next priority goes to the default setting on the row type. So in this
case, if a default setting was applied to the Normal Row, the result would be similar to the following:

Notice that the row setting may well affect other cells in the table, not just the ones in the Left Common Values
area.
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Fifth Priority

If there is no default setting on the row, the next priority goes to any Column Settings override, but only if the
column type in the Table Definition is the same as that applied in the Transformation, thus:

If the column type in the Table Definition does not match the column type that is applied in the Transformation,
then the Column Settings override in the Table Definition will be ignored.

Sixth Priority

If there is no Column Settings override, the last priority goes to the default setting in the column type that is
assigned in the Transformation, thus:
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Remove Attribute Rows/Columns in Group
The Remove Attribute Rows/Columns in Group transformation enables you to remove all attributes from the table that
belongs to an attribute group. This transformation is useful, for example, when you want to ensure that a specific set of
attributes do not appear in the table.

Prerequisites
The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example

Before

The below table contains five columns built from attributes that appear in the same attribute group (DataVisualization).
this is how the table looks before the transformation is applied.

After

This is how the table looks after the transformation is applied. The five columns are removed.
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Steps
1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Remove Attribute

Rows/Columns in Group dialog displays.
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2. Search or browse for the relevant attribute group, then click OK.

3. When you have selected an attribute group, the transformation is applied to all attributes in the table that belong to
the Attribute Group.
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Remove Empty Rows/Columns
The Remove Empty Rows/Columns transformation removes empty rows or columns from a table. This is useful, for
example, if several product ranges use the same table definitions but some attribute columns only apply to a few of the
actual tables. Another example is if another transformation is applied to the table that ends up leaving an empty row or
column. Removing the row or column helps to de-clutter the table.

Prerequisites
The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example

Before

This is how the table appears before applying the Remove Empty Rows/Columns transformation. The Country of Origin
column is blank, though note that it still has a header.

After
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This is how the table looks after the transformation is applied. The column is removed even though there was a value for
the header. This is because 1 was entered in the Heading Rows field of the Remove Empty Rows/Columns dialog and
the Remove Columns box was checked. Refer to the below steps for more information.

Steps
1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Remove Empty

Rows/Columns dialog displays.
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2. In the Heading Rows field, enter the number of header and sub-header rows to be removed even if they contain
data. Enter 0 to ignore headers, enter 1 to ignore Header (1) rows, and enter 2 to ignore Sub-Header (2) rows.

3. In the Heading Columns field, enter the number of header and sub-header columns to be removed even if they
contain data. Enter 0 to ignore headers, enter 1 to ignore Header (1) columns, and enter 2 to ignore Sub-Header (2)
columns.

4. Select Remove Rows to remove empty rows. If this box is checked, rows will be removed if they are empty. If not
checked, then rows will be skipped even though they are empty.

5. Select Remove Columns to remove empty columns. If this box is checked, columns will be removed if they are
empty. If not checked, then columns will be skipped even though they are empty.

6. Click OK.
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Remove Rows/Columns
The Remove Rows/Columns transformation enables you to remove specified rows and/or columns from the table,
whether or not they are empty. For example, when you want to remove an unused row or column from the table,
then this transformation can be used.

Prerequisites
The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example

Before

Before the transformation is applied, the 'Country of Origin' column is present.

After

After applying the transformation, the 'Country of Origin' column is gone.
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Refer to the Sorting Transformation topic for a more complex example which incorporates both a sorting transformation
and a row removal transformation.

Steps
1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Remove Rows/Columns

dialog displays.
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2. Click the ellipsis button ( ) to launch the Select Row/Column dialog.

Select Attribute to apply the transformation to the row or column that contains the specified attribute. Click the
ellipsis button ( ) to search or browse for the relevant attribute.

Select Product/Classification/Assetto apply the transformation to the row or column that contains the specified
object. Click the ellipsis button ( ) to search or browse for the relevant object.

Select Heading to identify the row or column by typing the header text of the relevant row or column.

Select Type to choose a specific row or column type from the dropdown list.

Select Number to identify the row or column by entering the sequence number. For example, to apply the
transformation to the third column, type 3.

Select Group to apply the transformation to a group of rows / columns and/or a range of row / columns, then click
the Setup button.

Click Add in the Select Row/Columns to be grouped dialog to add rows or columns to the group
individually.

© Stibo Systems - Public - 2025.3 - September 2025 364



After clicking Add, either a Row or Column field displays, depending on whether you are selecting a
row or column. Click the ellipsis button ( ) to launch another Select Row/Column dialog. This is

identical to the previous 'Select Row/Column' dialog, except without the Group option. Click OK after
making your selection.

Click Add again on the 'Select Row/Columns to be grouped' dialog to repeat the previous steps and
add more columns to the group. Click OK when done.

To add a Range of columns to the group, click Add Range.
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Enter the starting and ending column numbers in the Column From and To fields, then click OK when
done. To enter a range that will contain the remainder of the table if rows or columns are added later,
enter a large number in the 'To' field such as 5999. Note that these fields can only contain integer
values.

3. Click OK.
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Row/Column Consolidation
The Row/Column Consolidation transformation consolidates consecutive rows or columns that are identical except for
the values in one designated row or column. The values in those cells corresponding to the designated row or column
are merged after the rows or columns are consolidated.

Prerequisites
The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example
In the following example, the table has five rows. In the first two rows and the last two rows, all values are identical
across every column except for the values in the 'Capacity' column.

Before

This is how the table appears before the transformation is applied. The rows with identical values are surrounded by a
red box, and the different values for Capacity within these rows are similarly highlighted.

After

This is how the table appears after the transformation is applied. The first two rows are consolidated and the last two
rows are consolidated. The different values for 'Capacity' are now merged into a single cell in the first row and a single
cell in the last row. More information is provided in the following section on how to configure the transformation to obtain
this result.
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Steps
1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Row/Column Consolidation

dialog displays. Select Rows to merge rows, or select Columns to merge columns.

2. If Rows is selected, the Column Type: label will display in the dialog, and the corresponding dropdown list will
contain the column types that are legal for your table.
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The example shown at the beginning of this topic uses the column type of 'Capacity.'

3. If Columns is selected, the Row Type: label will display in the dialog, and the corresponding dropdown list will
contain the row types that are legal for your table.

5. In the Separator field, enter the value that should appear between the merged values in the consolidated column or
row. In this example, a separator of ' & ' (an ampersand with a space on either side) is entered.

6. Click OK to finish.
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Error Handling
If the column type or row type that you choose appears more than once in the table, a warning will display in the
dialog to ensure that you are aware that only the first column or row of this type will be affected by the
transformation. To avoid confusion, it is advisable to use a dedicated column type or row type for consolidation
operations.
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Suppress Rows/Columns
The Suppress Rows/Columns transformation suppresses rows or columns based on specified matching criteria or
whether all values in a specified row or column are equal or non-equal. For example, rows or columns can be
suppressed if:

an exact text string is matched to a value

a string is detected that matches a specified regular expression

all values are equal

all values are different

all values are equal except for a specified text string or regular expression

In the case of equal values, this transformation may be useful for rendered tables that have retrieved values using the
'Attribute Group Attributes' content definition. In some cases, these values will be the same for all the rendered
products. This transformation enables these rows / columns to be suppressed if the values are equal.

Prerequisites
The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the 'Add a Transformation to a Table or Table Type' subsection of the Table Transformations topic.

Example – Suppression Using a Basic Text String
In the following example, any rows that contain the Color value of Kelly Green will be suppressed. A sample use case
could be that this color is only available for spring, but the summer catalog is about to publish. So, shirts of this color will
be suppressed in the table so they do not appear in the summer catalog. They can be unsuppressed later for next
spring's catalog.

Before

This is how the table appears before the suppression of the Kelly Green shirt rows.
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After

This is how the table appears after. The Kelly Green T-Shirts no longer appear.
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Example – Suppression Using a Regular Expression
The following example uses an extremely basic regular expression that suppresses rows by matching on a single
character. For more detailed information about regular expressions, refer to the Regular Expression section of the
Resource Materials online help documentation.

Before

Before applying the transformation, the table is very tall and contains what appear to be duplicate products, which have
an underscore and number at the end of their STEP Names, e.g., Christmas Party Hat_2, Christmas Party Hat_3, and
so forth.
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To suppress all rows that contain these products, the Column 'STEP Name' is chosen for Column; the 'is' radio button is
selected; an underscore character is entered into the text field; and 'regular expression' is checked.
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After

After applying the transformation, the table looks like this. All rows are removed where the STEP Name value contained
an underscore.
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Example – Suppressions Using Equal and Non-equal Values
The following example shows how two tables can be derived from the same product family, with one table holding only
the common values for the children and the second holding only the different values for the children. Both tables start
with an identical setup, loaded with the same data.

Before

The below screenshot shows how both tables look originally. All columns have different values for the children except
for the 'Bluetooth' and 'Country of Origin' columns, which have identical values for each child. All columns in the table
are a normal column type (Spec Column) except for the 'Product Name' column, which is a column header.

The desired result for 'Table 1' is to only show the child values that are different. So, the Suppress Rows/Columns
transformation is applied to remove all columns where the values in that column are the same (equal).
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After

Once applied, the 'Bluetooth' and 'Country of Origin' columns are removed.

The desired result for 'Table 2' is to only show the values that are the same for the children. So, the Suppress
Rows/Columns transformation is applied to remove all columns where the values in the column are different.

Once applied, only the 'Bluetooth' and 'Country of Origin' columns remain. (The 'Product Name' column remains
because it is a header column type, and the transformation has been configured to 'Ignore Headings.')
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Steps
1. After adding the transformation, under Parameters, click the ellipsis button ( ). The Suppress Rows/Columns

dialog displays.

2. Select Ignore Headings if you do not want to apply the transformation to headings.

3. In the 'Where' section, click the ellipsis button ( ) in the Column or Row field to display the Select Row/Column

dialog. Select Row to suppress rows and Column to select columns.

© Stibo Systems - Public - 2025.3 - September 2025 378



Select Attribute to apply the transformation to the row or column that contains the specified attribute. Click the
ellipsis button ( ) to search or browse for the relevant attribute.

Select Product/Classification/Assetto apply the transformation to the row or column that contains the specified
object. Click the ellipsis button ( ) to search or browse for the relevant object.

Select Heading to identify the row or column by typing the header text of the relevant row or column.

Select Type to choose a specific row or column type from the dropdown list.

Select Number to identify the row or column by entering the sequence number. For example, to apply the
transformation to the third column, type 3.

Select Group to apply the transformation to a group of rows / columns and/or a range of row / columns, then click
the Setup button.

Click Add in the Select Row/Columns to be grouped dialog to add rows or columns to the group
individually.
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After clicking Add, either a Row or Column field displays, depending on whether you are selecting a
row or column. Click the ellipsis button ( ) to launch another Select Row/Column dialog. This is

identical to the previous 'Select Row/Column' dialog, except without the Group option. Click OK after
making your selection.

Click Add again on the 'Select Row/Columns to be grouped' dialog to repeat the previous steps and
add more columns to the group. Click OK when done.

To add a Range of columns to the group, click Add Range.
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Enter the starting and ending column numbers in the Column From and To fields, then click OK when
done. To enter a range that will contain the remainder of the table if rows or columns are added later,
enter a large number in the 'To' field such as 5999. Note that these fields can only contain integer
values.

4. After making the selections from the Select Row/Column dialog, choose one of the following 'Where' options:

Select is or is not to suppress rows / columns that match a certain text string. To match on exact text, enter the
text value in the text field. To use a regular expression, check the regular expression box and enter a regular
expression in the text field.

Select all values are equal to suppress rows or columns in which all values are equal within the specified row or
column.

Select all values are equal but not to suppress rows or columns in which all values are equal except for a
specified text string or regular expression.

Select values are different to suppress rows or columns in which all values are different within the specified row
or column.

5. Click OK to finish configuring the transformation.
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Header Repeating Pagination Plugin
The Header Repeating Pagination Plugin is accessible on Table Type objects. The settings available in this 'plugin'
allow more control over the behavior of tables—specifically related to the behavior of repeated header and footer rows—
when lengthy tables split across columns or pages.

Though the settings contained within this 'plugin' are not transformations, they are designed to work along with
transformations, or in some cases, in place of them. For example, the Alternate Row Colors transformation may be
sufficient for simple, smaller tables, but for lengthy tables that split, more control is needed in how the alternate row
colors are calculated when headers split across pages. In this instance, the Header Repeating Pagination Plugin would
be used instead of the Alternate Row Colors transformation.

Note that all settings are not necessary for all tables. The specific combinations chosen are dependent on the unique
requirements for the table type being configured.

To configure the Header Repeating Pagination Plugin, follow these steps.

1. In System Setup, expand Table, then expand Table Types.

2. Expand the Table Type Group that contains the table type that you would like to configure, then select the relevant
table type.

3. On the Table Type tab, click in the Pagination Plugin field and select Header Repeating Pagination Plugin.
('None' will appear as the default selection.)

4. Click on Change Settings, which appears directly to the right of the dropdown list. The Header Repeating
Pagination Plugin displays.
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5. In the Row/Column counts area, make the following selections as needed:
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In Minimum Body Rows to Keep With Heading at Bottom of Column, select a number from the dropdown list.
Numbers range from 0 to 10.

For example, while doing pagination, if your table is placed at the bottom of the page and continues to the next
page or column, this checks for the minimum number of rows to be placed before splitting the table.

In Minimum Body rows to be Carried Over to Top of Next Column, select a number from the dropdown list.
Numbers range from 0 to 10.

For example, while doing pagination, if your table is placed at the bottom of the page and continues to the next
page or column, this checks for the minimum number of rows to be placed after splitting the table.

In Minimum Body Columns before a table width split, select a number from the dropdown list. Numbers range
from 0 to 10.

In Minimum Body Columns after a table width split, select a number from the dropdown list. Numbers range
from 0 to 10.

6. In the Always Repeated Row Headers area, click Add Row Type to choose the heading and/or subheading row
types that must always be repeated when a table is split. This will repeat the row header when the table is continued
from one page / column to another.

7. In the Always Repeated Column Headers area, click Add Column Type to choose the heading and/or subheading
column types that must always be repeated when a table is split.

8. In the Repeat Current Header Row (in order of priority) area, click Add Row Type, then select the heading and/or
subheading row types where only the last row of that type will be repeated when a table is split.

9. In the Repeat Current Header Column (in order of priority) area, click Add Column Type, then select the heading
and/or subheading column types where only the last column of that type will be repeated when a table is split.

10. In the Repeated Table Footers area, click Add Row Type to select the footer row types that must be repeated at
the bottom of a column or page when a table is split.

11. In the Alternating row colors settings area, make selections only if you are not already using the Alternate Row
Colors transformation.
Though the Alternate Row Colors transformation adds color shading to alternating table rows, the transformation
offers no additional control over the alignment of shaded rows when a table splits across a column or a page.
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Using alternate row color settings in the Header Repeating Pagination Plugin provides a more complex level of
control over the appearance of split tables with multiple repeated headers. The following screenshot shows neatly
aligned row colors in a table split across two columns, accomplished by applying alternate row coloring using the
Header Repeating Pagination Plugin.

First, check the Enable alternating row colors box to activate the rest of the options in this area.

Next, check the following boxes as needed to control where alternate row coloring should and/or should not
appear:

Restart row count at always repeated headers

Restart row count at repeat last headers

Ignore always repeated headers

Ignore repeat last headers

Ignore footers

Enter the number of Normal Colored Rows and Alternate Colored Rows in the text boxes

Select the Normal Color and Alternate Color from the dropdown lists. Selections are populated by colors created
in System Setup under Table > Colors

For more information on the Alternate Row Colors transformation, refer to Layout Transformations in the Tables
documentation.

12. In the Table Rulers and Width settings area, check the necessary boxes to determine which table rules must be
added to split tables and to fine-tune when tables split based on their width:
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Use table bottom ruler on splits as bottom ruler.

Use table top ruler on splits as top ruler.

Use table left ruler on splits as left ruler.

Use table right ruler on splits as right ruler.

Enable table split when wider than frame

Break before table width split

Error Handling - Missing Configurations
If any column types, row types, or colors have been removed from STEP since the last time the Header Repeating
Pagination Plugin was configured, a warning message will display when opening the plugin. The plugin will open after
clicking OK on the error message, but the missing configuration will display in a red highlighted cell. To correct the error,
either remove or re-add the missing configuration.
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Exporting and Importing Tables
Table exports and imports cover two sets of definitions: table types in System Setup, and table definitions that are
created on the Tables tab of product, classification, or product-override objects in the Tree. Table definitions are further
broken down into two areas—local table definitions, and definitions for resolved tables, i.e., tables that contain data and
can be previewed on the selected product, classification, or product-override object.

The topics in this section explain how to export and import STEP tables in the STEPWorkbench. Tables are exported
and imported in the STEPXML format and, depending on what options are chosen in the Export Manager, information
about table types, table definitions, and resolved tables can be included in table exports. To narrow down the amount of
information included in the export file, the Advanced STEPXML format can also be used.

This documentation section covers the following topics:

Exporting Table Types

Exporting Table Definitions

Exporting Resolved Tables

Importing Tables
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Exporting Table Types
This topic explains how to export table type objects from System Setup.

Table types are exported in the STEPXML format by selecting Include Table Types in the Export Manager when
configuring the export. The resulting file contains the following information, which allows for a complete table types
hierarchy to be built on a target system on import:

Table colors and table rules

Table type groups, column type groups, and row type groups

Table types, row types, and column types

Default table transformations

Table pagination plugins

Table type dimension dependencies

Heading / footer information and valid publication types for row and column types

Full details of the contents of the file are explained in the 'Contents of Table Types Export File' subsection below. For
recommended practices and considerations when importing table types, refer to the Importing Tables topic.

Exporting the Table Types STEPXML File
The overall steps to export table types in the STEPXML format using the Export Manager are the same as those used
when exporting any other type of data from STEP. The following steps provide a general overview in the context of
configuring a table type–specific export.

1. To initiate the export, follow the initial steps outlined in the Creating a Data Export topic in the Data Exchange
documentation.
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2. On the Select Format screen of the Export Manager, select Include Table Types from the outbound parameters
under the 'Configuration' section. Select 'All' if you would like to export all table objects from System Setup. If any
product and/or classification objects were included in the Select Objects screen, choose 'Minimum' to only include
the table type objects that are used on those objects.

Note: Note that Colors and Rules will always be included in the export, regardless of whether All or
Minimum is selected. Since colors / rules may be referenced by transformations, pagination plugins, and so
forth, there is no way to determine which plugins reference which colors / rules.

3. Click Finish to complete the configuration, as all options on the Advanced screen may be ignored.

4. Finish the export as you would any other data export by retrieving the file from the Background Processes tab.

Exporting Table Types Using Advanced STEPXML
Table types may also be exported using the Advanced STEPXML format. Using Advanced STEPXML allows for
the use of an XML file snippet instead of having to make selections from the STEPXML outbound parameter
dropdowns. Advanced STEPXML is also recommended if you want to export only the table type objects
associated with the tables defined on a particular product / classification and exclude the extraneous information
about the product / classification that would typically be included in a standard STEPXML export, such as attribute
links, product override links, asset references, classification references, product references, and metadata
attribute values.

To export table types in Advanced STEPXML, follow the same steps outlined in the previous section, but choose
Advanced STEPXML on the Select Format screen of the Export Manager instead of STEPXML.

All Table Type Definitions (SystemWide)

To export all table types from System Setup (and not just those associated with a selected product or
classification), replace the preexisting information in the Template field with the following code snippet:
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<?xml version='1.0'?>

<STEP-ProductInformation>

<TableColors ExportSize="All"/>

<TableRules ExportSize="All"/>

<TableTypeGroupList ExportSize="All"/>

<TableTypeDefinitions ExportSize="All"/>

</STEP-ProductInformation>

Specific Table Type Definitions From Products

To export specific table type objects associated with the locally defined (not inherited) tables on a selected product only,
use a template similar to the following.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Products ExportSize="Minimum"/>

<TableColors ExportSize="Minimum"/>

<TableRules ExportSize="Minimum"/>

<TableTypeGroupList ExportSize="Minimum"/>

<TableTypeDefinitions ExportSize="Minimum"/>

</STEP-ProductInformation>

Specified Table Type Definitions Only

To export specific table type objects associated with a specific table on a selected product, use a template similar to the
following.

Note: Table types are designated by STEP name, not ID, in the Advanced STEPXML format template.
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<?xml version='1.0'?>

<STEP-ProductInformation>

<Products ExportSize="Minimum">

<Product>

<Name/>

<Tables>

<Table IncludeTableTypes="Price Table"/>

</Tables>

</Product>

</Products>

<TableColors ExportSize="Minimum"/>

<TableRules ExportSize="Minimum"/>

<TableTypeGroupList ExportSize="Minimum"/>

<TableTypeDefinitions ExportSize="Minimum"/>

</STEP-ProductInformation>

Specific Table Type Definitions From Classifications

To export specific table type objects associated with the tables defined on a selected classification only, use a template
similar to the following.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Classifications ExportSize="Minimum">

© Stibo Systems - Public - 2025.3 - September 2025 391



<Classification IncludeParent='false'>

<Name/>

</Classification>

</Classifications>

<TableColors ExportSize="Minimum"/>

<TableRules ExportSize="Minimum"/>

<TableTypeGroupList ExportSize="Minimum"/>

<TableTypeDefinitions ExportSize="Minimum"/>

</STEP-ProductInformation>

Contents of the Table Types Export File
The following subsections show samples from a STEPXML Table Types export file, followed by a listing of the tags and
their descriptions.
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Colors and Rules

Tag Description

<TableColors> Parent tag for <TableColor>

<TableColor> Returns the following information:

Name: The STEP name of the color

Color: The RGB definition of the color in integer
form

<TableRules> Parent tag for <TableRule>

<TableRule> Returns the following information:

Name: The STEP name of the rule

Width: The width of the rule, in points

Color: The STEP name of the color used for the
rule
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Group Types

Tag Description

<TableTypeGroupList> Parent tag for table type groups tag (<RowColumnTableGroup>)

<ColumnTypeGroupList> Parent tag for column type groups tag (<RowColumnTableGroup>)

<RowTypeGroupList> Parent tag for row type groups tag (<RowColumnTableGroup>)

<RowColumnTableGroup> Tag used to return the STEP ID of the table type group, column type group, or row
type group, depending on which of the above three tags it is nested in

<Name> Nested within <RowColumnTableGroup>; returns the STEP name of the table type
group, column type group, or row type group
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Table Types

Tag Description

<TableTypes> Parent tag for <TableType>

<TableType> Returns the following information:

ID: The STEP ID of the table type

ParentID: The ID of the table type group to which the table type belongs

If default settings have been applied to the table type, the following XML elements are
also included, if applicable:

TextStyle: The default text style

BackgroundColor: The default background color

VerticalAlignment: The default vertical alignment of text. Valid values are:

No tag: Top (default alignment)

1: Center
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Tag Description

2: Bottom

3: Justify

0: Not defined

RuleAbove: The default rule for the top of the table

RuleBelow: The default rule for the bottom of the table

RuleLeft: The default rule for the left side of the table

RuleRight: The default rule for the right side of the table

CellRotation: The default orientation of cell contents

CellVerticalStoryDirection: The default direction of cell contents (horizontal or
vertical)

CellImageScale: The default size of images linked into the cell

Width: The width of the table

WidthUnit: Unit used for the table width. Valid units are:

in = unece.unit.INH

mm = unece.unit.MMT

pica = unece.unit.R1

pt = unece.unit.N3

proportional = std.proportional

Table Orientation: The orientation of the table. Valid values are Horizontal and
Vertical. This XML element will not be present for table types with an orientation
setting of Automatic.

For more information on table type defaults, refer to the Configuring Settings for
Table Types and Tables topic.

<Name> STEP name of the table type

<UserTypeLink> Object types for which the table type is resolvable

<ColumnType> Default column type for the table. For more information on column types, refer to the
'Column Types' subsection below.
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Tag Description

<RowType> Default row type for the table. For more information on row types, refer to the 'Row
Types' subsection below.

<DimensionLink> Returns the DimensionID (dimension dependency) of the table type. Possible values
are 'Language' or 'Country.'

<TableTransformation> Returns the STEP ID of the default table transformation(s) applied to the table.

<Configuration> Nested within the <TableTransformation> tag; contains the configuration of the
transformation in an encoded internal format.

<TablePaginationPlugin> Returns the STEP ID of the pagination plugin used for the table, which will always be
HeaderRepeatingPaginationPlugin, unless a custom plugin is in use.

Column Types
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Tag Description

<ColumnTypes> Parent tag for <ColumnType>

<ColumnType> Returns the following information:

ID: The STEP ID of the column type

ParentID: The ID of the column type group to which the column type belongs

HeadingLevel: The heading level of the column. Possible values are:

0: Normal

1: Heading

2: Subhead

-1: Footer

Also included are any default settings applied to the column type, if applicable. The
attributes are the same as those used for table types (TextStyle, Background Color,
etc.). For more information on column type defaults, refer to the Configuring
Settings for Column Types and Columns topic.

<Name> STEP name of the column type

<TableTypeLink> TableTypeID: Returns the STEP ID(s) of the table type(s) for which the column type
is valid

<PublicationTypeValidity> IsInNewPublicationTypes: Returns a value of 'true' or 'false' depending on whether
the column type will be included in publication types created after the column type
was created

<IncludedPublicationType> PublicationTypeID: Returns the publication types for which the row type is valid
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Row Types

Tag Description

<RowTypes> Parent tag of <RowType>

<RowType> Returns the following information:

ID: The STEP ID of the row type

ParentID: The ID of the row type group to which the row type belongs

HeadingLevel: The heading level of the row. Possible values are the same as
those listed above for column type.

KeepWithNext: Whether the row should always remain with the next row on a
mounted InDesign page. Value is either 'true' or 'false.'

Also included are any default settings applied to the row type, if applicable. The
attributes are the same as those used for table types (TextStyle, Background Color,
etc.). For more information on row type defaults, refer to the Configuring Settings
for Row Types and Rows topic.
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Tag Description

<Name> STEP name of the row type

<TableTypeLink> TableTypeID: Returns the STEP ID(s) of the table type(s) for which the row type is
valid

<PublicationTypeValidity> IsInNewPublicationTypes: Returns a value of 'true' or 'false' depending on whether
the row type will be included in publication types created after the row type was
created

<IncludedPublicationType> PublicationTypeID: Returns the publication types for which the row type is valid
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Exporting Table Definitions
This topic explains how to export local and inherited table definitions from tables defined on product, classification, or
product-override objects in the Tree.

Table definitions are exported in the STEPXML format by selecting Include Table Definitions in the Export Manager
when configuring the export. The resulting file contains all of the required information to transfer table definitions from
one STEP instance to another. Additionally, this option allows for table definitions to be exported from a product or
classification object on which a table has been defined but is not necessarily resolved. This is useful because table
definitions are often built at a higher level of a hierarchy for inheritance purposes and resolved on lower levels.

Exporting the Table Definitions STEPXML File
The overall steps to export table definitions in the STEPXML format using the Export Manager are the same as those
used when exporting any other type of data from STEP. The following steps provide a general overview in the context of
configuring a table-type–specific export.

1. To initiate the export, follow the initial steps outlined in the Creating a Data Export topic in the Data Exchange
documentation.

2. On the Select Objects screen, add the product and/or classification object(s) from which you would like to export the
table definitions. The steps are outlined in the Export Manager - Select Objects topic in the Data Exchange
documentation. You can also initiate the export by right-clicking on the relevant product or classification object and
selecting 'Export Data Below.'

3. On the Select Format screen of the Export Manager, select Include Table Definitions from the outbound
parameters under the 'Data Objects' section, then choose 'Yes.'

To include inherited table definitions, also choose 'Yes' for Include Inherited Data.
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To export table definitions from products where the table definition is inherited from the classification structure,
then Include Classifications should also be selected (in addition to Include Products) and set to 'Minimum.'

Note: If there are two (or more) classifications with different table definitions, but the same product is linked
into both classifications, the table definition exported with the product is chosen at random. When this file is
imported into the target system, the table definition will be local on the product. I.e., all objects that have a
table definition in the STEPXML file will become a local table on the import system.
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4. Click Finish to complete the configuration, as all options on the Advanced screen may be ignored.

5. Finish the export as you would any other data export by retrieving the file from the Background Processes tab.

Exporting Table Definitions Using Advanced STEPXML
Table definitions may also be exported using the Advanced STEPXML format. Using Advanced STEPXML
ensures that the file does not contain extra information that is unrelated to the table definition. Advanced
STEPXML also allows for specific table types to be exported, whereas all locally defined tables on a product or
classification are exported when using standard STEPXML.

With standard STEPXML, even when all outbound parameters are set to 'No' or 'None' on the Select Format screen in
the Export Manager, the export still contains information about the product and/or classification such as attribute links,
product override links, asset references, classification references, product references, and metadata attribute values. If
this information is not removed from the XML file before it is used to import table definitions onto another system,
unwanted changes could occur on the target system. For example, a product could be inadvertently linked to a
classification, or a metadata attribute value could be changed. Using an Advanced STEPXML template when
configuring the export ensures that this extra information does not appear in the file to start with.

To export table definitions in Advanced STEPXML, follow the same steps outlined in the previous section, but choose
Advanced STEPXML on the Select Format screen of the Export Manager instead of STEPXML.

Tables on Products

Locally Defined Table Definitions

In the Template field, replace the preexisting information with a code snippet similar to the following.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Products ExportSize="Minimum">

<Product>

<Name/>

</Product>

</Products>

<TableDefinitions/>

</STEP-ProductInformation>
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Local and Inherited Table Definitions

To include inherited table definitions, use a snippet similar to the following.

<STEP-ProductInformation>

<Products ExportSize="Minimum">

<Product>

<Name/>

</Product>

</Products>

<TableDefinitions IncludeInherited="true"/>

</STEP-ProductInformation>
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Definitions From Specified Table Types Only

To export definitions from a specified table type only, replace the preexisting information with a code snippet
similar to the following.

Note: Table types are designated by STEP name, not ID, in the Advanced STEPXML format template.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Products ExportSize="Minimum">

<Product>

<Name/>

<Tables>

<Table IncludeTableTypes="Price Table"/>

</Tables>

</Product>

</Products>

<TableDefinitions/>

</STEP-ProductInformation>

Tables on Classifications

Locally Defined Table Definitions

In the Template field, replace the preexisting information with a code snippet similar to the following.
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<?xml version='1.0'?>

<STEP-ProductInformation>

<Classifications ExportSize="Minimum">

<Classification IncludeParent='false'>

<Name/>

</Classification>

</Classifications>

<TableDefinitions/>

</STEP-ProductInformation>

Local and Inherited Table Definitions

To include inherited table definitions, use a snippet similar to the following.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Classifications ExportSize="Minimum">

<Classification IncludeParent='false'>

<Name/>

</Classification>

</Classifications>

<TableDefinitions IncludeInherited="true"/>

</STEP-ProductInformation>
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Definitions From Specified Table Types Only

To export definitions from a specified table type only, use a template similar to the following.

Note: Table types are designated by STEP name, not ID, in the Advanced STEPXML format template.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Classifications ExportSize="Minimum">

<Classification IncludeParent='false'>

<Name/>

<Tables>

<Table IncludeTableTypes="Price Table"/>

</Tables>

</Classification>

</Classifications>

<TableDefinitions/>

</STEP-ProductInformation>
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Contents of the Table Definitions Export File
The configuration of table definitions and table free text is an internal format, which prevents users from making
modifications to the definitions before importing the file into STEP. Thus, the file serves solely as a way to transfer table
definitions from one system to another.
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The following table lists the tags contained within the export file and their descriptions. Since the majority of the
information within the file is encoded, few tags appear.

Tag Description

<Product> Parent tag that contains information about the product object. Tables information is nested
within the <Product> tag. If table definitions have been pulled from a classification object, the
<Classification> tag will appear instead.

<Name> STEP name of the product or classification object

<Tables> Parent tag for <TableDefinition>

<TableDefinition> Parent tag for <TableXML>

<TableXML> Returns the ID of the table type(s) defined on the product or classification object

<Configuration> Contains all information about the table definitions within an encoded string

<TableFree
TextXML>

Returns the ID of the table type(s) defined on the product or classification object

<Configuration> Contains all information about the table free text within an encoded string
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Exporting Resolved Tables
This topic explains how to export resolved tables that are defined on product, classification, or product-override objects
in the Tree. Resolved tables are exported in the STEPXML format by selecting Include Tables in the Export Manager
when configuring the export.

Note: Files containing resolved tables cannot be imported into STEP. They can be used for downstream
purposes, such as translation of free text contained within table cells, but serve no purpose for STEP imports.
Importing a file containing table definitions (obtained by selecting Include Table Definitions in the Export
Manager) will dynamically create resolved tables in the target system.

Exporting the Resolved Tables STEPXML File
The overall steps to export resolved tables in the STEPXML format using the Export Manager are the same as those
used when exporting any other type of data from STEP. The following steps provide a general overview in the context of
configuring a table-type–specific export.

Important: If your table contains dimension-dependent content, such as attribute values or free text, make sure
that you have the correct context selected in STEP before initiating the export.

1. To initiate the export, follow the initial steps outlined in the Creating a Data Export topic in the Data Exchange
documentation.

2. On the Select Objects screen, add the product and/or classification object(s) from which you would like to export the
resolved tables. The steps are outlined in the Export Manager - Select Objects topic in the Data Exchange
documentation. You can also initiate the export by right-clicking on the desired product or classification object and
selecting 'Export Data Below.'

3. On the Select Format screen of the Export Manager, select Include Tables from the outbound parameters under the
'Data Objects' section. Choose 'Yes,' then click Next.
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4. If your table contains content relevant to a particular publication (such as column or row types that are only valid for
certain publication types) or a publication version (such as commercial data), you will need to select a publication
version on the Advanced screen. The following screenshot shows a sample resolved table where this feature might
be used, which contains a column with country-specific commercial data (prices in Euros, for France).

Click the ellipsis button ( ) next to the Select version used to resolve tables field, then browse to or search

for the relevant publication version in the 'Select Publication Version' dialog. Click Select to choose the version
and close the dialog.

For more information on publication versions, refer to the Publication Versions topic in the Publisher (Adobe
InDesign Integration) documentation.

5. Click Finish to complete the configuration.

6. Finish the export as you would any other data export by retrieving the file from the Background Processes tab.
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Exporting Resolved Tables Using Advanced STEPXML
Resolved tables may also be exported using the Advanced STEPXML format. Using Advanced STEPXML allows
for specific table types to be exported, whereas all resolved tables on a product or classification are exported
when using standard STEPXML.

Additionally, standard STEPXML exports may contain information about the product and/or classification such as
attribute links, product override links, asset references, classification references, product references, and metadata
attribute values, which may need to be removed before the file can be used for downstream purposes. Using an
Advanced STEPXML template when configuring the export ensures that this extra information does not appear in the
file to start with.

To export table definitions in Advanced STEPXML, follow the same steps outlined in the previous section, but choose
Advanced STEPXML on the Select Format screen of the Export Manager instead of STEPXML.

Resolved Tables on Products

All Resolved Tables

In the Template field, replace the preexisting information with a code snippet similar to the following.

Note: All resolved tables will be exported, whether they are defined locally or inherited from a higher node.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Products ExportSize="Minimum">

<Product>

<Name/>

<Tables Format="Resolved"/>

</Product>

</Products>

</STEP-ProductInformation>
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Resolved Tables of Specified Table Types Only

To export resolved tables from a specified table type only, replace the preexisting information with a code snippet
similar to the following.

Note: Table types are designated by STEP name, not ID, in the Advanced STEPXML format template.

<?xml version='1 .0'?>

<STEP-ProductInformation>

<Products ExportSize="Minimum">

<Product>

<Name/>

<Tables Format="Resolved">

<Table IncludeTableTypes="Price Table"/>

</Tables>

</Product>

</Products>

</STEP-ProductInformation>
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Resolved Tables on Classifications

All Resolved Tables

In the Template field, replace the preexisting information with a code snippet similar to the following.

Note: All resolved tables will be exported, whether they are defined locally or inherited from a higher node.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Classifications ExportSize="Minimum">

<Classification IncludeParent='false'>

<Name/>

<Tables Format="Resolved"/>

</Classification>

</Classifications>

</STEP-ProductInformation>
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Resolved Tables of Specified Table Types Only

To export resolved tables of a specified table type only, replace the preexisting information with a code snippet
similar to the following.

Note: Table types are designated by STEP name, not ID, in the Advanced STEPXML format template.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Classifications ExportSize="Minimum">

<Classification IncludeParent='false'>

<Name/>

<Tables Format="Resolved">

<Table IncludeTableTypes="Price Table"/>

</Tables>

</Classification>

</Classifications>

</STEP-ProductInformation>
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Contents of the Tables Export File
The first screenshot below shows a simple resolved table (Price Table) on a product object (Pet Hats) in the Tree. The
second screenshot shows a partially opened example of the STEPXML export file of the table, showing four columns
and four rows.
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The following subsections provide more details about the file pulled from the example table, along with a listing of the
STEPXML tags and their descriptions. All possible XML tags are not covered; for a full list of available tags, refer to the
XSD file available in the Technical Documentation, which is accessed from the Start Page.

Product and Table Information

Tag Description

<Product> Parent tag that contains information about the product object. Tables information is nested within the
<Product> tag. If table definitions have been pulled from a classification object, the <Classification>
tag will appear instead.

<Name> STEP name of the product or classification object

<Tables> Parent tag of <Table>

<Table> Returns the STEP ID of the table type (TableTypeID)
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Column Information

Tag Description

<Column> Returns the STEP ID of the column type (ColumnTypeID) and any settings applied to the column, if
applicable

The attributes for settings are the same as those used for column types (TextStyle, Background
Color, etc.). Refer to the 'Contents of the Table Types Export File' subsection of the Exporting Table
Types topic for more information.

<Origin> Returns the following information:

AttributeID: The STEP ID of the attribute, if the column / row definition is configured to pull
information from an attribute

Pull: If 'Attribute' is chosen for the column's content definition, the 'Pull' attribute returns the
aspect. Possible values include Name, ID, and ValueUnit. Refer to the Content Definitions topic
for more information.
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Row and Cell Information

Tag Description

<Row> Returns the STEP ID of the row type (RowTypeID) and any settings applied to the row, if
applicable

The attributes for settings are the same as those used for row types (TextStyle, Background
Color, etc.). Refer to the 'Contents of the Table Types Export File' subsection of the Exporting
Table Types topic for more information.

<ProductOrigin> ID: The STEP ID of the product from which values are pulled in the table row

<Cell> Returns the following information:
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Tag Description

Column: The number of the column in which the cell appears (0, 1, 2, 3, etc.)

attributeID: The attribute from which the information in the cell is pulled

Also included are any settings applied to the cell, if applicable. The attributes for settings are
the same as those used for row, column, and table types (TextStyle, Background Color, etc.).
Refer to the 'Contents of the Table Types Export File' subsection of the Exporting Table Types
topic for more information.

<Text> Returns the text content of the cell

<Image> If an image appears in the cell instead of text, the <Image> tag is nested in the <Text> tag and
the STEP ID of the asset is returned (AssetID).
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Importing Tables
Table type structures and table definitions can be created in STEP through STEPXML imports. However, table
import files are primarily intended to transfer tables from one STEP instance into another, not to build table objects
and tables anew. The recommended steps for using STEPXML files to import tables are as follows:

1. Manually create and configure table type objects and table definitions on a STEP test environment

2. Export these table types and table definitions in STEPXML. It is recommended to export the table types and table
definitions in separate files.

3. Import the table types file into the STEP production environment

4. Import the table definitions file into the STEP production environment

The export and import process itself is straightforward, but multiple considerations must be taken into account to ensure
that the import is successful. For example, since tables are defined on product / classification hierarchies, the same
product / classification object types and hierarchies that are present on the source system must also be present on the
target system. This also applies to attributes, assets, transformations, commercial terms, publication versions, contexts,
and so forth. As such, this topic does not address the actual import process, but provides information on the
prerequisites for a successful import and how to troubleshoot any errors that may occur with an import.

Importing the Files
Two types of files containing tables information can be imported into STEP: those containing System Setup table types,
which are exported by selecting Include Table Types in the Export Manager; and those containing table definitions
from product and classification objects in the Tree, which are exported by selecting Include Table Definitions in the
Export Manager.

Files that contain tables information are imported into STEP like any other STEPXML file, either through the Import
Manager or through an Inbound Integration Endpoint. For more information, refer to the Import Manager and Inbound
Integration Endpoints sections of the Data Exchange documentation.

Note: Files containing resolved tables, which are exported by selecting Include Tables in the Export Manager,
cannot be imported into STEP. They can be used for downstream purposes, such as translation of free text
contained within table cells, but serve no purpose for a STEP import, as importing table definitions dynamically
creates resolved tables.

Considerations and Limitations for Tables Imports
General

Both the target and source systems must be on the same version of STEP, and both systems must be on version STEP
8.3 or above.
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Duplicate Data Setups

The setup data should be identical across test, QA, and production STEP systems when tables are being exported from
one system and imported onto another. Considerations for mismatched setups are as follows:

Object types (product and/or classification): Table object types must be resolvable on at least one product or
classification object type. If these object types are missing in the target system, the table object types can still be
created, but they will not be resolvable on any product / classification objects until those objects are created in the
target system.

Product and/or classification object hierarchy: It is recommended to use a dedicated 'test' node (or nodes) to
define tables on the source system, then use an identical node on the target system, which uses the same STEP
IDs, to import the definitions into. Once the definitions are applied to the dedicated node on the target system, the
definitions can be copied from this node and pasted onto the table definition on another node in the same target
system.

Assets: Must have the same IDs and be linked to product objects using the same asset reference types on both
source and target system.
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Contexts / dimensions: Since table types can be dimension dependent, for the purpose of free text, if a context
does not exist on the target system, an error occurs on import. Table definitions themselves are context
independent, so this is not a concern for definitions only, but if a context is present in the import file that does not
exist in the target system, an error will still be thrown on import.

Table types, row types, and column types should have the same ID on the source and target systems. If these
types already exist on the target system, care must be taken before importing to ensure that the settings for these
table type objects are the same in the import file, as the settings on the target system will be overridden and could
potentially cause existing table layouts to be destroyed.

Attributes, attribute transformations, and lookup tables must exist on both systems and have the same IDs.

Table Transformations: The same table transformations should be present on both systems. A custom
transformation on a source system cannot be created on a target system through import. If the transformation does
not exist on the target system, an error will be raised in the background process execution report.

Table Type Imports

It is not recommend to change column and row type IDs manually in the exported XML file since there are
numerous places within the file where the ID must be changed.

A table types import file should not be edited to create new colors. However, if a color already exists in the target
system with the same name, the number associated with the color (the RGB definition of the color in integer form)
will overwrite the color's RGB definition on the target system.

Since rules do not use IDs, if there is a difference in width or color for a table rule with the same name on the source
and target system, the incoming rule definitions will overwrite those on the target system.

Table Definitions Imports

Table definitions files cannot be edited by users, since all table configurations in a tables definitions file are contained in
encoded strings.

Note: Table Type, Row Type, and Column Type definitions cannot be imported into STEP via Advanced
STEPXML.
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Error Handling
Even if some objects, attributes, transformations, and so forth are missing on a target system, an import of table types
and/or table definitions can be successful, but with errors. Some errors will display in the Execution Report of the
completed background process on the BGProcesses tab. In other instances, a table definition can import with no errors
appearing in the BGP execution report, but the errors will be visible when viewing the table definition and/or preview on
the product or classification object in the Tree.

This section shows a few common examples of errors that can occur with the import of table types and table definitions
and how to troubleshoot them, but it is not a comprehensive list of every potential error. It is recommended to always
run an import of table types and table definitions in test mode first to catch errors in the BGP Execution Report.

Errors Displayed in Background Processes

The following screenshot shows an example of errors thrown in a table types import that had table types that were
resolvable (valid) on object types that are not present in the target system. The table types were created in the target
system, but the errors inform users that these object types must be created in the target system before the
configurations of the table types will match that of the source system.
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Errors Displayed in Table Definitions and Previews

This example shows the display of an imported definition where a column type is not valid for the table type. the
column type has been applied, but it is in red since it is not valid for this table type. Either the column type must be
made valid for the table type, or another column type must be used.

The following screenshots show another set of errors, using before and after examples. The import was successful
overall, but a few items were missing on the target system that required troubleshooting to correct.

Source Definition

Target Definition

In the target system, the table definition has been mostly recreated by the import of the definitions, but an attribute that
was present in the source system (Product Name) is missing in the target system.

Source Preview
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Target Preview

When viewing the table preview in the target system, additional errors are noticeable. The numbers in the
screenshot correspond with the errors listed in the numbered list below the image.

1. The first column of the table is missing because of the missing 'Product Name' attribute. Since the column is empty,
the 'Remove Empty Rows/Columns' transformation has removed the column altogether, so now the first column in
the table is 'Part No.'.

2. 'Retail Price' is highlighted in red because the commercial terms list from the source table is missing on the target
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system.

3. Even though the IDs display in the Part No. column, the values do not match those in the source table due to a
missing attribute transformation that appends '-A' to the ID.
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